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BAB 0  IHWAL BUKU INI

uku ini dikembangkan untuk BlankOn X Tambora yang ditulis berdasarkan buku panduan

BlankOn 8 Rote yang sebelumnya ditulis oleh Tim Dokumentasi BlankOn: B
0.1. Tim Penyusun

0.1.1.  Penulis 
• Sokibi, Sahabat BlankOn Semarang, istanalinux@gmail.com (koordinator)

• Umul Sidikoh, umulsidikoh@gmail.com

• Faiq Aminuddin, dampuawang@gmail.com

• TS Faizal, trisfaizal@gmail.com

• Dicky Bagus, dicky.bagus@gmail.com

0.1.2.  Editor
• Sokibi, Sahabat BlankOn Semarang, istanalinux@gmail.com

0.1.3.  Sampul 
• Muhammad Irfan 

0.2. Lisensi
Buku ini menggunakan lisensi Creative Commons Attribution-ShareAlike 3.0 Unported License
(CC by SA). 

Singkatnya:  buku  ini  bebas  diperjualbelikan,  didistribusikan  ulang,  digandakan,  dan
dikembangkan dengan syarat: 

• Menyantumkan informasi tentang penyusun asli buku ini 

• Menggunakan  lisensi  yang  sama  dengan  buku  ini  juga  (CC-by-SA)  
© 2016, Tim Pengembang BlankOn

  Ihwal Buku Ini

mailto:istanalinux@gmail.com
mailto:istanalinux@gmail.com
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BAB 1  APA ITU LINUX DAN BLANKON LINUX?

ata  “Linux”  saat  ini  semakin  banyak  didengar  oleh  pecinta  Teknologi  Informasi  dan
Komunikasi (TIK) di seluruh dunia termasuk di Indonesia. Saat ini, Linux telah menjadi
salah satu sistem operasi yang banyak digunakan di berbagai kalangan, seperti kalangan

bisnis,  pendidikan,  dan pemerintahan.  Hal  ini  disebabkan karena Linux bersifat  terbuka dan
merdeka.  Siapapun  bisa  mengembangkannya  dan  menggunakannya  secara  bebas.  Linux
merupakan  kernel  atau  dasar  dari  Sistem  Operasi  yang  pertama  kali  ditulis  oleh  seorang
mahasiswa  Finlandia bernama  Linus  Benedict  Torvalds pada  tahun  1991.  Hasil  karyanya
dilisensikan  secara  bebas  dan  terbuka  (Free  Software)  sehingga  siapa  pun  boleh
mengembangkannya. 

K

Kemudian Richard Stallman, seorang aktivis perangkat lunak pendiri  Free Sofware Foundation
(FSF) berniat untuk menggabungkan Linux ke dalam proyek sistem operasinya yang bernama
GNU  (GNU  is  Not  Unix).  Karena  pada  saat  itu,  proyek  GNU  sama  sekali  belum  selesai
mengimplementasikan kernel sistem operasi. Akhirnya, dengan dirilisnya kernel Linux, terjadilah
perkawinan antara peralatan (tools) yang dibuat oleh proyek GNU dengan kernel Linux yang
dibuat oleh  Linus Torvalds, sehingga menghasilkan sistem operasi baru bernama  GNU/Linux,
sebuah  sistem  operasi  yang  mirip  dengan  UNIX.  Kesemua  komponen  dari  sistem  operasi
GNU/Linux dilisensikan berdasarkan lisensi yang disebut GNU General Public License (GPL) yang
ditulis sendiri oleh Richard Stallman. Lisensi ini memungkinkan setiap orang untuk secara bebas
mengembangkan  bahkan  menjual  Linux  dengan  syarat  semua  pengembangan  yang  telah
dilakukan harus juga dipublikasikan kepada umum. 

Pada  perkembangan  selanjutnya,  Linux  juga  dipaketkan  dengan  perangkat  lunak  lain  untuk
keperluan tertentu seperti  server, desktop, perkantoran,  internet,  multimedia,  dan lain-lain
sehingga  menjadikannya  apa yang  disebut  dengan distribusi  Linux  atau  yang sering  dikenal
dengan istilah  Distro Linux. Karena sifat Linux yang terbuka, siapapun bisa memaketkan Linux
dengan perangkat  lunak pilihannya dengan cara  pemaketan masing-masing untuk  membuat
distribusi Linux. 

Saat  ini,  banyak  sekali  terdapat  distro-distro  Linux  yang  memiliki  segmen  pasar,  fitur,
kelengkapan dan cita rasa yang berbeda. Anda bisa melihat semua distribusi Linux yang ada
melalui situs  http://www.distrowatch.com. Distro Linux juga bisa disebut sebagai sistem operasi
atau operating system (OS) karena sudah memiliki perangkat lunak untuk melakukan operasi
pada  komputer.  Linux  pada awalnya berkembang di  lingkungan  server,  karena  Linux  sangat
handal dalam hal  kestabilan sistem. Namun, dengan semakin pesatnya dunia perangkat lunak
terbuka, Linux kini juga merambah ke dunia Desktop. Perkembangan sangat pesat ini tidak lepas
dari  peran para sukarelawan yang berjasa dalam menyumbangkan ide dan tenaganya untuk
mengembangkan Linux. 

  Apa Itu Linux Dan Blankon Linux?
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1.1. Kelebihan Linux 
Sebagai suatu sistem operasi, Linux secara umum memiliki berbagai kelebihan dan kekurangan
daripada sistem operasi lainnya. Berikut adalah kelebihan dari Linux : 

• Linux  bisa  didapatkan  secara  bebas  tanpa  perlu  membayar  lisensi.  Anda  juga  bisa
mengunduh kode sumber Linux jika ingin melihatnya tanpa ada batasan apapun. 

• Linux memiliki koleksi perangkat lunak tersendiri yang sangat lengkap untuk keperluan
laptop, desktop dan server. Jika perangkat lunak yang tersedia terasa kurang, Anda dapat
menambahkannya dengan mudah melalui repository yang tersedia. 

• Linux  sangat  stabil  karena  jarang  sekali  crash  maupun  hang.  Anda  juga  tidak  perlu
bahkan tidak pernah melakukan restart jika melakukan konfigurasi sistem. 

• Linux lebih aman terhadap virus, karena selain jumlah virus di Linux sangat sedikit. Linux
juga sangat ketat dalam hal pengelolaan keamanan. 

• Perbaikan  kutu  (bug)  atau  cacat  yang  terdapat  di  Linux  sangat  cepat,  karena  Linux
dikembangkan  secara  komunitas  dan  setiap  komunitas  bisa  memberikan  masukan-
masukan  dan  perbaikan  untuk  kutu  atau  cacat  tersebut.   Apapun  yang  memiliki
kelebihan pasti memiliki kekurangan, karena pada hakikatnya apa yang diciptakan oleh
manusia tidak akan pernah sempurna. Berikut adalah berbagai kekurangan dari Linux : 

1. Linux  kurang  memiliki  dukungan  dari  produsen  perangkat  keras  dalam  hal
penyediaan perangkat lunak pengendali (driver). Hampir semua perangkat lunak
pengendali yang saat ini ada di Linux merupakan hasil jerih payah komunitas, dan
sebagian kecil murni dukungan dari produsen perangkat keras. 

2. Linux masih kurang didukung oleh beberapa pembuat  permainan.  Kebanyakan
permbuat  permainan  masih  menggunakan sistem operasi  Microsoft  Windows
sebagai platform mereka.

1.2. Apa itu BlankOn Linux? 
BlankOn Linux merupakan salah satu distro Linux yang berisikan perangkat lunak
(software)  yang  dapat  digunakan  untuk  keperluan  Desktop,  Laptop,  dan
Workstation.  Dengan  dipadukan  oleh  berbagai  pernak–pernik  khas  Indonesia,
distro ini sangat cocok digunakan untuk pengguna komputer di Indonesia. 

BlankOn  Linux  dikembangkan oleh  Yayasan  Penggerak  Linux  Indonesia  (YPLI) bersama  Tim
Pengembang BlankOn. Pengembangan BlankOn dilakukan secara terbuka dan gotong royong,
sehingga siapa saja bisa turut berkontribusi untuk mengembangkan BlankOn agar menjadi lebih
baik.  BlankOn  Linux  juga  bisa  didapatkan  oleh  siapa  saja  tanpa  perlu  membayar  untuk
mengunduhnya. Bahkan, Anda bisa mendistribusikannya dan membagi-baginya secara bebas
tanpa batas kepada siapa saja. 
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Pengembangan BlankOn bukan semata-mata ingin membuat distribusi Linux baru, namun lebih
dimotivasi  oleh  keinginan  untuk  meningkatkan  kualitas  dan  kuantitas  dalam  kemampuan
pengembangan perangkat  lunak  bebas/terbuka,  yang pada  hakikatnya  merupakan  salah  ciri
khas bangsa Indonesia yang memiliki semangat bergotong-royong. Tim pengembang BlankOn
percaya bahwa bangsa Indonesia mampu dan tidak kalah dengan bangsa-bangsa lain di dunia
dan oleh karena itu aktif mengundang siapa pun yang berminat dan memiliki semangat yang
sama untuk bergabung dalam pengembangan BlankOn. 

1.3. Asal nama BlankOn Linux 
Nama BlankOn berasal dari nama penutup kepala beberapa suku/budaya yang ada di Indonesia,
antara  lain  suku  Jawa,  suku  Sunda,  dan  daerah  lainnya.  Dari  asal  kata  tersebut,  BlankOn
diharapkan  menjadi  penutup  atau  pelindung  dari  ketergantungan  dengan  perangkat  lunak
tertutup. 

Selain itu, nama BlankOn juga bisa diartikan menjadi Blank (angka biner 0) dan On (angka biner
1). BlankOn diharapkan menjadikan orang yang  belum sadar menjadi  sadar bahwa Linux bisa
dimanfaatkan untuk meningkatkan keterampilan dalam bidang Teknologi Informasi. 

1.4. Sejarah BlankOn Linux 
BlankOn  Linux  pertama kali  dikembangkan  oleh YPLI  pada  tahun  2004  dengan  nama kode
"Bianglala". Pada saat itu, BlankOn merupakan turunan dari distro Fedora Core 3. Namun, rilis
BlankOn pada saat itu berakhir sampai versi 1.1 dan akhirnya mati suri. 

Beberapa  tahun  kemudian,  yaitu  pada  tahun  2007,  pengembangan  BlankOn  Linux  mulai
dibangkitkan kembali oleh YPLI. BlankOn Linux yang sebelumnya diturunkan dari  Fedora Core
kini diganti menjadi  Ubuntu.  Mulai  Versi 7.0 kode nama  Pattimura, Blankon di rillis 1 tahun
sekali . Setiap rilis BlankOn Linux akan diberi tema dan ciri khas yang berbeda sesuai dengan
budaya yang ada di Indonesia. 

Akhirnya, pada akhir tahun 2007, BlankOn Linux versi 2.0 dirilis dengan nama kode "Konde".
Versi ini diturunkan dari Ubuntu versi 7.10. Kemudian, pada pertengahan tahun 2008, BlankOn
Linux  versi  3.0  dirilis  dengan  nama  kode  Lontara.  Versi  yang  berbasis  Ubuntu  8.04  LTS  ini
menggunakan tema khas Sulawesi Selatan, terlihat dari pengunaan karya seni Kapal Pinisi pada
gambar  latar  belakangnya.  Anda juga dapat  menulis  aksara  Lontara yang merupakan aksara
khas suku Bugis. 

Pada bulan November 2008, BlankOn Linux 4.0 dirilis dengan nama kode  Meuligoe. Ciri khas
yang digunakan pada versi ini adalah Aceh, dengan warna dominan hijau. Pada rilis berikutnya
5.0  menggunakan  nama  Nanggar dengan  khas  Batak,  pada  rilis  ini   Logo  BlankOn  diganti
sehingga lebih modern. 

Rilis terakhir pada saat buku ini ditulis adalah BlankOn Linux 9.1 , dengan nama kode Suroboyo
yang merupakan turunan dari Debian. Sejak Versi 6.0 Ombilin tidak murni berbasis Ubuntu dan
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mulai  rilis  6.0 Ombilin BlankOn tidak lagi  mengikuti budaya mutlak Ubuntu,  sehingga sudah
banyak program yang diambil dari pembuatnya langsung. 

1.5. Fitur BlankOn X Tambora
BlankOn X Tambora berisikan berbagai  perangkat  lunak bebas  dan terbuka untuk keperluan
desktop,  laptop dan workstation.  Perangkat  lunak yang tersedia juga bisa ditambah dengan
perangkat lunak lainnya agar sesuai dengan keperluan. 

Secara umum, fitur-fitur dari BlankOn X Tambora adalah sebagai berikut : 

• BlankOn Desktop -  Gabungan dari  Manokwari  yang terus dikembangkan dan  Gnome
3.20 (http://manokwari.blankonlinux.or.id/)

• Menggunakan kernel Linux versi 4.7.8-1 yang sangat stabil dengan dukungan perangkat
keras yang sangat banyak, 

• Perangkat  lunak  untuk  keperluan  Anda berkomputer,  seperti  keperluan  perkantoran,
grafis, internet, multimedia, dan sebagainya. 

• Antarmuka menggunakan Bahasa Indonesia, sehingga bisa lebih dimengerti oleh orang
awam, 

• Sudah menyertakan dukungan format multimedia yang lengkap, seperti untuk memutar
mp3, DVD, dan format lainnya, 

• Dukungan aksara daerah di Indonesia yang semakin banyak 

• Menggunakan tema dan tampilan grafis khas Indonesia. 

• GNOME versi 3.20  sebagai lingkungan desktop atau desktop environment yang sangat
sederhana, kaya fitur, serta dukungan Manokwari yang mudah digunakan, 

• LibreOffice  5.1.4.2 untuk  keperluan  perkantoran  yang  sangat  mirip  dan  kompatibel
dengan Microsoft Office, 

• Peramban web Firefox untuk mengakses situs Internet, 

• Dan Lebih Banyak Lagi Kami menyertakan ratusan ribu aplikasi yang tersimpan dalam
lumbung aplikasi. 

1.6. Pengembangan BlankOn Linux 
Seperti  yang  dijelaskan  sebelumnya,  BlankOn  Linux  dikembangkan  oleh  Yayasan  Penggerak
Linux Indonesia (YPLI) bersama para komunitas pengembang Linux yang tergabung menjadi Tim
Pengembang BlankOn Linux. Proyek BlankOn Linux terbuka untuk siapa saja yang terlibat dan
berperan aktif dalam pengembangan BlankOn Linux ini. 

Dalam pengembangan proyek BlankOn Linux Tim Pengembang BlankOn dibagi menjadi dua tim:

  Apa Itu Linux Dan Blankon Linux?
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• Tim Rilis 

• Tim Proyek 

Di dalam kedua tim tersebut terdapat tim-tim kecil yang bekerja sesuai tugasnya. Halaman ini
menjelaskan tim apa saja yang ada dan tugas-tugasnya. 

1.6.1.  Tim Rilis BlankOn
Tim ini  bertanggung jawab dalam menerbitkan  sebuah rilis  BlankOn.  Tim ini  dipimpin  oleh
seorang Manajer Rilis. Tim kecil yang ada dipimpin oleh seorang Koordinator. 

Tim Pemaket 
Tim ini bertanggung jawab terhadap paket-paket yang dirilis ke sebuah rilis BlankOn. 

Tim Kesenian
Tim  ini  bertanggung  jawab  terhadap  semua  materi  karya  seni  yang  dirilis  ke  sebuah  rilis
BlankOn. 

Tim Jaminan Kualitas 
Tim ini bertanggung jawab terhadap kualitas sebuah rilis BlankOn. Tim ini sehari-hari mengurus
tiket yang masuk, menjaga kualitas isi tiket, memantau siklus tiket, dan menutup tiket. Tim ini
juga menyediakan tim untuk mengetes rilis BlankOn sehari-hari dan menyiapkan daftar tugas
untuk tim tersebut. 

Tim Dokumentasi 
Tim ini bertanggung jawab dalam mengumpulkan dokumentasi untuk pengguna pada sebuah
rilis BlankOn. Produk tim ini adalah buku panduan, presentasi, dan catatan rilis BlankOn. 

1.6.2.  Tim Proyek BlankOn 
Tim ini tidak terlibat secara langsung dalam sebuah rilis, namun lebih cenderung ke pelaksanaan
jalannya proyek BlankOn secara keseluruhan. Tim-tim ini tidak dipimpin oleh seseorang namun
lebih ke kepemimpinan mandiri. Tim kecil yang ada dalam Tim Proyek dipimpin oleh seorang
koordinator. 

Tim Riset dan Aplikasi 
Tim  ini  bertanggung  jawab  dalam  melakukan  riset  dan  menyediakan  solusi  dalam  suatu
permasalahan yang muncul. Tim ini juga bertanggung jawab mengimplementasikan fitur-fitur
yang diminta oleh komunitas. 

Tim Infrastruktur
Bertanggung  jawab  terhadap  tugas-tugas  operasional  infrastruktur  BlankOn,  yaitu  menjaga
ketersediaan  dan  kualitas  layanan  infrastruktur.  Artinya,  Tim  ini  harus  tanggap  terhadap
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masalah pada ketersediaan layanan (server tidak boleh mati, dsb), dan juga masalah kualitas
(kecepatan akses tidak boleh lambat, dst). 

Tim ini juga bertanggung jawab terhadap instalasi-instalasi layanan yang baru, baik fisik maupun
perangkat lunak. Tim ini dibagi berdasarkan jenis layanan yang disediakan, diantaranya: 

Umum: Tim ini menangani hal-hal administrasi umum, termasuk (namun tidak terbatas pada): 

• Akun SSH 

• Layanan web 

• bzr/git 

• GPG 

Lumbung paket
Tim ini menangani operasional lumbung paket, termasuk (namun tidak terbatas pada): 

• Membuka kunci lumbung 

• Membuat komponen baru 

• Sinkronisasi antara server 

• Menambah/hapus paket secara manual 

• DVDRepo 

Pabrik 
Tim  ini  menangani  operasional  pabrik-pabrik,  baik  pabrik  paket  maupun  pabrik  CD.  Tugas-
tugasnya termasuk (namun tidak terbatas pada): 

• Menjalankan/menghentikan pabrik 

• Menambah tugas pabrik secara manual 

• Membantu pemaket melakukan sidik gangguan saat ada kegagalan pengiriman paket 

• Melakukan sidik gangguan saat ada kegagalan pembuatan CD 

Tim Hubungan Masyarakat 
Tim  ini  bertanggung  jawab  dalam  mengumpulkan,  mempromosikan,  menghubungkan,  dan
menyebarluaskan semua informasi manfaat dan kebaikan BlankOn. 

Tim ini dibagi menjadi beberapa bagian: 

• Komunitas 
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Tim  ini  menjadi  penyambung  lidah  pengguna  BlankOn,  merawat  forum  dan  milis,
merawat wiki.  Tim ini  harus aktif  di  milis  dan forum serta mengumpulkan informasi-
informasi  penting yang ada di  milis/forum untuk diarsipkan dalam wiki.  Tim ini  juga
menjaga kualitas isi wiki. 

Tim  ini  menjadi  penghubung  dan  pendukung  komunitas  pengguna  BlankOn.  Tim  ini
perlu memiliki hak administrasi dalam pengaturan milis, forum, dan wiki. 

• Konferensi 

Tim ini bertanggung jawab dalam menyelenggarakan BlanKonf dan juga menyebarkan
informasi BlankOn dalam konferensi-konferensi yang relevan, baik di dalam maupun luar
negeri. 

Untuk konferensi, tim ini tidak perlu menjadi  orang yang berangkat dalam konferensi
yang diikuti, tapi lebih ke pemantauan adanya konferensi-konferensi dan menggerakkan
para pengembang untuk berangkat ke sana. 

• Media

Tim ini bertanggung jawab dalam menyediakan informasi baru, kliping tentang BlankOn
dan penyegaran terhadap situs www.blankonlinux.or.id. 

• Tim Bisnis 

Tim ini bertanggung jawab dalam kegiatan yang berhubungan dengan bisnis komersial.
Tim ini  dipandu oleh YPLI.  Jika  Anda berminat  untuk  menjadi  pengembang BlankOn
Linux,  silahkan  membuat  akun  baru  di  situs  pengembangan  BlankOn  Linux  yaitu
http://dev.blankonlinux.or.id  dan  bergabung  di  milis  pengembang  BlankOn  Linux  di
blankon-dev@…. Anda bisa memilih menjadi salah satu dari tim yang disebutkan di atas.
Kontribusi dari Anda sangat diperlukan agar BlankOn Linux bisa menjadi lebih baik. 

1.6.3.  Tautan dan Umpan Balik 
Berikut adalah berbagai tautan/link situs untuk informasi lebih lanjut mengenai distro BlankOn
Linux : 

• http://www.blankonlinux.or.id, situs resmi BlankOn Linux. 

• http://cdimage.blankonlinux.or.id,  halaman  web  untuk  mengunduh  distro  BlankOn
Linux. 

• http://dev.blankonlinux.or.id, situs WIKI untuk informasi pengembangan distro BlankOn
Linux.

  Apa Itu Linux Dan Blankon Linux?

http://dev.blankonlinux.or.id/
http://cdimage.blankonlinux.or.id/
http://www.blankonlinux.or.id/
http://dev.blankonlinux.or.id/
http://www.blankonlinux.or.id/
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BAB 2  MEMASANG BLANKON 

ab ini akan membahas bagaimana cara memasang BlankOn pada komputer. Pemasangan
BlankOn akan sangat mudah dilakukan apabila anda sudah memahami persiapan dan
langkah-langkah apa saja yang perlu dilakukan. B

2.1. Kebutuhan Sistem 
Sebelum melakukan pemasangan, maka perlu diperhatikan terlebih dahulu apakah komputer
Anda sudah memenuhi syarat spesifikasi  minimal  agar BlankOn bisa berjalan dengan lancar.
Berikut ini adalah spesifikasi minimal untuk BlankOn X Tambora: 

• Prosesor setara pentium IV dengan kecepatan minimal 2,8 Ghz (rekomendasi Dual Core) 

• Memori RAM 1 GB 

• kartu  video  atau  VGA  minimal  memiliki  memori  128  MB  atau  512  MB  untuk  efek
desktop. 

• Media Simpan dengan ukuran 12 GB atau lebih.

2.2. Cara Mendapatkan BlankOn 
Untuk mendapatkan DVD BlankOn, Anda bisa mengunduh image atau cetakan cd-nya dari situs
resmi BlankOn  http://cdimage.blankonlinux.or.id/. Berkas cetakan tersebut selanjutnya dibuat
bootable ke Flashdisk atau Harddisk External  dengan Unetbootin, cara lainya adalah dengan
dibakar ke DVD kosong menggunakan aplikasi pembakar DVD seperti Brasero, K3b, Nero, Roxio,
dsb. 

Tip: 
Jika mengunduh terasa lambat, anda bisa memanfaatkan situs cermin (mirror) sebagai sumber
mengunduh berikut ini: 

•  http://kambing.ui.ac.id/iso/blankon 

•  http://mirror.unej.ac.id/blankon-cd 

•  ftp://dl2.foss-id.web.id/iso/blankon 

•  http://buaya.klas.or.id/pub/blankon 

•  http://pandawa.ipb.ac.id/iso/blankon/ 

•  http://repo.ugm.ac.id/iso/blankon 

  Memasang Blankon 

http://repo.ugm.ac.id/iso/blankon
http://pandawa.ipb.ac.id/iso/blankon/
http://buaya.klas.or.id/pub/blankon
ftp://dl2.foss-id.web.id/iso/blankon
http://mirror.unej.ac.id/blankon-cd
http://kambing.ui.ac.id/iso/blankon
http://cdimage.blankonlinux.or.id/
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•  http://jaran.undip.ac.id/public/ISO/ 

•  http://mugos.ums.ac.id/iso/Blankon 

•  http://pinguin.ittelkom.ac.id/mirror/iso/blankon/ 

•  ftp://ftp.paudni.kemdiknas.go.id/blankon/ 

• ftp://singo.ub.ac.id/linux/blankon/ 

Bagi  anda yang memiliki  koneksi  terbatas  atau  bahkan tidak  memiliki  internet  sama sekali,
jangan khawatir. Anda bisa membeli DVD BlankOn melalui toko penjual DVD atau meminjamnya
dari teman yang telah memilikinya. Berikut adalah beberapa toko penjual CD/DVD Linux yang
ada di Indonesia: 

• Juragan Kambing ( http://juragan.kambing.ui.ac.id/) 

• Toko Baliwae ( http://toko.baliwae.com/) 

• Gudang Linux ( http://gudanglinux.com/) 

• Lapak Linux dan FOSS ( http://www.lapak-linux-dan-foss.com/) 

2.3. Persiapan Menjelang Pemasangan 
Sebelum melakukan pemasangan BlankOn, lakukan beberapa persiapan seperti berikut: 

1. Persiapkan  Flashdisk atau  DVD  BlankOn sebagai  bekal  proses  pemasangan,  baca
kembali  subbab  sebelumnya  untuk  mengetahui  cara  mendapatkan  DVD  BlankOn,
pastikan DVD dalam keadaan baik agar proses pemasangan lancar. 

2. Backup atau buat cadangan data penting yang Anda miliki ke media simpan cadangan
(misalnya; Flashdisk, Harddisk, CD/DVD) agar data Anda aman dan terhindar dari resiko
kehilangan data. 

3. Tentukan skema partisi harddisk yang Anda inginkan. Partisi merupakan bagian ruang-
ruang data yang terdapat  pada media simpan.  Jika Anda ingin melakukan  dual-boot
(terdapat dua sistem operasi dalam satu komputer), Anda harus membuat partisi baru
pada  media  simpan  di  komputer  yang  nantinya  akan  digunakan  sebagai  tempat
pemasangan  BlankOn.  Pembahasan  lebih  lanjut  akan  dijelaskan  pada  subbab
pemasangan. 

4. Pastikan  untuk  menjaga  kestabilan  tegangan  listrik.  Hal  ini  perlu  dilakukan  untuk
menghindari  listrik  yang  tiba-tiba  padam  pada  saat  pemasangan  dan  menyebabkan
terjadinya kerusakan fisik pada komputer (terutama media simpan). 

5. Lakukan pengaturan pada BIOS agar komputer membaca  Flashdisk atau  DVD terlebih
dahulu  untuk  proses  booting.  Silahkan  merujuk  ke  buku  manual  komputer  atau
motherboard anda mengenai cara melakukan pengaturan ini. 

  Memasang Blankon 

http://www.lapak-linux-dan-foss.com/
http://gudanglinux.com/
http://toko.baliwae.com/
http://juragan.kambing.ui.ac.id/
ftp://singo.ub.ac.id/linux/blankon/
ftp://ftp.paudni.kemdiknas.go.id/blankon/
http://pinguin.ittelkom.ac.id/mirror/iso/blankon/
http://mugos.ums.ac.id/iso/Blankon
http://jaran.undip.ac.id/public/ISO/
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2.4. Mengatur Bahasa dan Pilih Moda
Jendela yang tampil pertama ketika Anda menajalankan BlankOn X Tambora melalui DVD atau
Flashdisk  adalah  pilih  Bahasa  dan pilih  Moda.  Pilih  bahasa  digunakan untuk  mengatur  dan
memilih Bahasa Antarmuka BlankOn X Tambora ketika melakukan pemasangan dan hasil dari
pemasangan.  Sedangkan  pilih  Moda digunakan  untuk  memilih  moda,  apakah  Anda  ingin
menjalankan  BlankOn  X  Tambora tanpa  memasangnya  ke  komputer  atau  langsung
memasangnya.

2.4.1.  Mengatur Bahasa
Secara baku BlankOn X Tambora menyediakan dua bahasa ketika akan melakukan pemasang,
yaitu Bahasa Inggris dan Bahasa Indonesia, pilih bahasa yang sesuai, dalam buku Panduan ini
menggunakan Antarmuka Bahasa Indonesia, maka sebaiknya pilih Bahasa Indonesia. 

2.4.2.  Pilih Moda
Digunakan untuk memilih moda, apakah  Anda akan langsung menjalankan BlankOn X Tambora
melalui  Live DVD/USB tanpa memasangnya ke komputer atau langsung memasangnya pada
media simpan.

2.5. Memasang BlankOn
Subbab ini menjelaskan cara memasang BlankOn X Tambora pada media simpan yang masih
kosong, untuk melakukannya klik tombol Pasang BlankOn

  Memasang Blankon 

Gambar 1: Pengaturan BIOS
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2.5.1.  Pilih Zona waktu
Beberapa saat  setelah  Anda menekan  tombol  Pasang  BlankOn,  maka  tampil  jendela  untuk
memilih Zona Waktu sesuai tempat Anda berada, dalam contoh pilih Asia/Jakarta, klik tombol
Lanjut untuk menuju proses berikutnya

2.5.2.  Pilih Media
Langkah  ini  digunakan  untuk  memilih  media  simpan  di  komputer  Anda  sebagai  tempat
pemasangn BlankO X Tambora. Jika di komputer Anda terpasang lebih dari satu media simpan,
harap berhati-hati dalam memilih media simpan yang akan digunakan, sebab jika Anda salah
dalam memilih media simpan, resikonya Anda bisa kehilangan data tersebut, klik tombol Lanjut
untuk untuk menuju proses berikutnya

  Memasang Blankon 
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2.5.3.  Memilih Partisi
Langkah berikutnya adalah memilih partisi sebagai  tempat pemasangan BlankOn X Tambora,
karena dalam contoh media simpan (harddisk) yang akan digunakan masih kosong atau dengan
kata lain belum memilik partisi, maka perlu membuat partisi secara manual dengan klik Masuk
ke moda mahir.

  Memasang Blankon 
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2.5.3.1. Buat Partisi
Karena media simpan yang digunakan dalam keadaan kosong maka perlu dilakukan pembuatan
partisi, klik tombol Buat untuk mulai membuat partisi

2.5.3.2. Pilih Jenis Partis
Buat partisi baru pada media simpan, tentukan ukurannya dengan cara klik bagian partisi atau
mengeser tanda kotak kecil bagian atas, partisi yang akan dibuat berwarna biru, sedangkan yang
masih kosong berwarna abu-abu. Tentukan juga jenis Partisi yang akan digunakan, dalam contoh
pilih Primary, klik tombol Apply untuk melanjutkan ke langkah berikutnya.

  Memasang Blankon 
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Catatan Mengenai Partisi 
• Partisi Primary/Primer: Jenis partisi ini merupakan jenis partisi utama di media simpan

(harddisk)  untuk  sistem  operasi  pada  umumnya.  Partisi  primer  hanya  bisa  dibuat
maksimal 4 partisi, hal ini sangat berbeda dengan sistem DOS yang hanya mengijinkan
satu  jenis  partisi  primer  untuk  sistem.  Jika  kita  memakai  sistem operasi  Linux,  jenis
partisi ini akan terbaca sebagai partisi 1, 2, 3 dan 4. Misalnya terbaca sebagai sda1, sda2,
sda3 dan sda4, sedangkan jika kita menggunakan Sistem Operasi Windows akan terbaca
sebagai partisi C,D,E dan F. 

• Partisi Extended /Perluasan: Partisi Extended /Perluasan: Merupakan partisi perluasan
untuk  mengatasi  kekurangan  partisi  primer  dimana  hanya  dimungkinkan  adanya  4
partisi.  Jika  ingin  memiliki  partisi  lebih  dari  4  maka  partisi  extended/perluasan
dibutuhkan  yaitu  dengan  cara  mengorbankan  satu  jenis  partisi  primer  kemudian
digunakan oleh partisi extended/perluasan. Didalam partisi extended ini nantinya dibuat
partisi logical untuk mendapatkan partisi yang lebih banyak. Partisi extended tidak dapat
digunakan menyimpan data. Partisi jenis ini selalu menempati nomor partisi 4 (empat)
dari partisi primer. Misalnya ada 2 jenis partisi primer di harddisk sda maka posisi partisi
extended adalah sda4. 

• Partisi  Logical:  Jenis  partisi  logical  selalu  dibuat  didalam  partisi  extended/perluasan.
Partisi ini akan terbaca mulai angka 5 (lima). Misalnya kita membuat 5 jenis partisi logical
di dalam partisi extended maka masing-masing akan terbaca sebagai sda5, sda6, sda7,
dan seterusnya.

2.5.3.3. Memilih Mount Point
Pilih Mount Point atau titik kait untuk partisi yang akan dibuat, dalam contoh pilih /Home

Klik tombol Apply untuk menerapkan pembuatan partisi yang telah dilakukan.

  Memasang Blankon 
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2.5.3.4. Membuat Partisi Extended
Klik tombol  Buat  untuk membuat partisi baru pada media simpan yang masih kosong, pada
submenu jenis partisi pilih  Extended, tujuan dari langkah ini adalah agar kita dapat membuat
partisi  lebih  dari  empat  dalam media  simpan.  Jika  semua langkah  dirasa  sudah  benar,  klik
tombol Apply untuk menerapkan pembuatan partisi

2.5.3.5. Membuat Partisi Root
Klik tombol  Buat untuk membuat partisi baru dalam partisi  extended (partisi jenis ini disebut
partisi  logical),  tentukan ukuran  partisi  yang akan  dibuat  (dalam contoh  28,88  GB),  karena
dalam contoh ingin akan membuat partisi untuk sistem operasi maka pada submenu  Mount
Point pilih / (root), klik tombol Apply untuk menerapkan pembuatan partisi.

  Memasang Blankon 
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2.5.3.6. Membua Partisi Swap
Klik tombol  Buat  untuk membuat partisi baru sebagai partisi  Swap, gunakan ukuran dua kali
lipat dari ukuran RAM fisik yang terpasang di komputer. Karena dalam ini akan membuat partisi
Swap maka pada submenu Mount Point pilih use as Swap, klik tombol Apply untuk menerapkan
pembuatan partisi.

Catatan
• Jika ukuran RAM fisik yang terpasang sudah besar tidak perlu menggunakan acuan dua

kali lipat

  Memasang Blankon 



20

2.5.3.7. Membuat Partisi Bebas
Klik tombol  Buat untuk membuat partisi  baru pada ruang kosong di  media simpan sisa dari
partisi  yang telah dibuat  sebelumnya,  karena partisi  ini  tidak akan dikaitkan  sebagai  sistem
tertentu pada komputer (digunakan sebagai partisi bebas), maka pada submenu Mount point
pilih Without mount point, klik tombol Apply untuk menerapkan pembuatan partisi.

Sekarang pembuatan partisi sudah selesai, untuk melanjutkan proses pemasangan BlankOn X
Tambora, klik tombol Apply.

2.5.3.8. Personalisasi
Langkah selanjutnya  adalah  memasukkan  informasi  pribadi tentang  nama komputer,  nama
pengguna  serta  password  pengguna,  ketik  beberapa  informasi  tersebut  pada  kotak  yang
tersedia. Jika ketika Anda ingin masuk ke destop tanpa harus memasukkan kata sandi klik dan

  Memasang Blankon 
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beri  tanda  pada  kotak di  samping  kiri  Masuk  secara  otomatis.  Klik  tombol  Lanjut untuk
melanjutkan ke langkah berikutnya.

2.5.3.9. Ringkasan Pemasangan
Langkah berikutnya adalah  memeriksa ringkasan dari informasi yang telah dibuat sebelumnya.
Ringkasan Pemasangan berisi keterangan dari  Media simpan dan partisi target pemasangan,
Nama komputer, Nama pengguna, dan keterangan mode masuk ke destop. Klik tombol Pasang
BlankOn untuk melakukan pemasangan BlankOn sesungguhnya.

Catatan:
• Jika Anda masih ragu untuk melanjutkan ke proses berikutnya tekan tombol  Kembali

untuk mengedit informasi pada komputer yang akan dipasang BlankOn.

  Memasang Blankon 
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2.5.3.10. Proses Pemasangan
Kemudian  akan  muncul  tampilan  proses  Pemasangan  BlankOn  yang  sedang  berlangsung,
tunggu beberapa saat hingga selesai.

2.5.3.11. Pemasangan Selesai
Setelah proses pemasangan berhasil maka akan muncul jendela berisi dua pilihan yaitu Lanjut
menggunakan sistem dalam moda live atau  Mula Ulang,  klik  salah satu dari  kedua pilihan
tersebut sesuai selera Anda.

  Memasang Blankon 
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2.6. Pasang BlankOn Berdampingan dengan Sistem Operasi Lain
Pada subbab sebelumnya sudah dijelaskan cara memasang BlankOn X Tambora di media simpan
yang  masih  kosong  atau  dengan  kata  lain  memasang  BlankOn  pada  komputer  yang  belum
memiliki sistem operasi.

Yang jadi pertanyaan adalah: “Bagaimana cara memasang BlankOn X Tambora pada komputer
yang sudah memiliki sistem operasi  tanpa menghapus sistem operasi  tersebut, atau dengan
kata lain memasang BlankOn berdampingan dengan sistem operasi lain?”

Apakah bisa?

Jawabnya, tentu saja bisa,  yaitu dengan cara memasang BlankOn pada salah satu partisi yang
masih kosong.

Sekarang muncul pertanyaan baru yaitu  “Bagaimana cara memasang BlankOn berdampingan
dengan sistem operasi lain, sementara pada media simpan tidak memiliki partisi yang masih
kososng?, Apakah bisa?”  

Jawabnya,  bisa,   yaitu  dengan menyiapkan partisi  kosong terlebih dulu pada media simpan
dengan memotong salah satu partisi yang sudah ada. Di bawah ini adalah penjelasan singkat
cara menyiapkan partisi baru pada komputer yang belum memiliki partisi kosong

2.6.1.  Menyiapkan Partisi
Nyalakan komputer dan jalan BlankOn X Tambora melalui  live DVD atau  Flashdisk, kemudian
pilih opsi Lanjut menggunakan sistem dalam moda live.

  Memasang Blankon 
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Catatan:
• Jika media simpan di komputer yang akan dipasang BlankOn X Tambora sudah tersedia

partisi kosong langsung pilih Pasang BlankOn

Peringatan
• Sebelum mengikuti panduan pada subbab ini  lebih lanjut, sebaiknya pahami dulu lebih

dalam mengenai manajemen partisi pada komputer, atau buat data cadangan (backup)
data penting yang ada di dalam partisi yang akan disunting ke media simpan luar (misal:
hard disk external), karena resiko kehilangan data sangat besar.

2.6.1.1. Menjalankan GParted
Untuk mengatur partisi  di  media simpan pada BlankOn X Tambora dapat  dilakukan dengan
menggunakan aplikasi penyunting partisi bernama Gparted, berikut cara menggunakannya:

Buka aplikasi penyunting partisi melalui  Menu Utama  BlankOn => Administrasi => Gparted
Partition Editor

2.6.1.2. Memilih Media Simpan
Langkah pertama untuk menyunting partisi adalah  memilih media simpan yang terpasang di
komputer, hal ini wajib dilakukan jika pada komputer yang akan Anda pasang sistem operasi
baru  memiliki  lebih  dari  satu  media  simpan,  untuk  melakukannya  klik  tanda  segitiga kecil
menghadap ke bawah di sebelah kanan  Baris Alat (tool bar),  pilih salah satu media simpan
yang akan digunakann sebagai tempat pemasangan sistem operasi.

  Memasang Blankon 
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2.6.1.3. Mengubah Ukuran Partisi
Dalam contoh buku ini media simpan yang digunakan sudah tidak memiliki partisi kosong lagi
sebagai  tempat  pemasangan  sistem  operasi  baru,  satu-satunya  cara  agar  dapat  memasang
sistem operasi baru adalah mengubah ukuran partisi yang sudah ada dengan cara memperkecil
ukurannya, kemudian menambahkan partisi baru.

Berikut  caranya;  Letakkan  kursor  pada  Partisi  paling  akhir,  klik  kanan  =>  Ubah
Ukuran/Pindahkan

Seret tanda  segitiga kecil  sebelah kanan partisi  tersebut  ke arah kiri hingga kotak disebelah
kanan berubah menjadi abu-abu, tentukan ukuran partisi baru yang akan Anda buat, kemudian
klik tombol Ubah Ukuran/Pindahkan.

  Memasang Blankon 
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Jika penyuntingan partisi dirasa sudah benar, klik ikon Terapkan Semua Operasi pada Baris Alat
(tool bar).

Jiki  muncul  peringatan  untuk  melakukan  perubahan  klik  Terapkan  Semua  Operasi untuk
melanjutkan proses penggeseran partisi, jika masih ragu-ragu klik tombol Batal.

Maka  proses  penggeseran  partisi  segera  berlangsung,  tunggu  hingga  selesai,  kemudian  klik
tombol Tutup. Lama proses penggeseran partisi tergantung dari banyaknya data dan spesifikasi
komputer yang Anda gunakan.

  Memasang Blankon 
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Sekarang Anda sudah memiliki area yang masih kosong pada media simpan yang terpasang di
komputer Anda.  Area kosong tersebut dapat digunakan sebagai  tempat pemasangan sistem
operasi baru. Anda dapat langsung membuat partisi baru area yang masih kosong atau langsung
memasang sistem operasi baru pada area kosong tersebut. Dalam  buku ini menggunakan pilih
kedua,  yaitu  memasang  langsung  sistem  operasi  baru  pada  area  kosong  tersebut,  caranya
kurang lebih sama dengan memasang BlankOn yang sudah dijelaskan pada subbab sebelumnya.

  Memasang Blankon 
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BAB 3 PASANG, HAPUS, DAN RAWAT PERANGKAT LUNAK 

lankOn  Linux  sudah  menyertakan  berbagai  perangkat  lunak  untuk  keperluan  dasar
seperti aplikasi perkantoran, multimedia, internet, grafis, dan lain-lain. Namun, jika Anda
merasa kurang dengan perangkat  lunak yang sudah terpasang,  Anda bisa melakukan

pemasangan perangkat lunak yang Anda inginkan sesuai dengan keperluan. 
B
INGAT! 

• Pemasangan dan penghapusan perangkat lunak membutuhkan hak administratif karena
dapat mengubah sistem. Untuk itu, yang hanya bisa melakukan hal tersebut hanyalah
pengguna yang memiliki kewenangan administratif. 

3.1. Pengaturan Perangkat Lunak pada BlankOn Linux 
Cara  pemasangan  dan  penghapusan  perangkat  lunak  pada  BlankOn  Linux  sangat  berbeda
dengan cara yang ada di sistem operasi Microsoft Windows. Jika pemasangan perangkat lunak
di  Windows  menggunakan  sebuah  installer  atau  program  pemasang  dari  masing-masing
perangkat  lunak,  maka  pada  BlankOn  Linux  pemasangan  perangkat  lunak  dilakukan
menggunakan  sistem  manajemen  paket  perangkat  lunak  seperti  pada  Distro  Linux  lainnya.
Manajemen paket yang ada di BlankOn Linux bernama APT. 

Di BlankOn, hampir semua perangkat lunak berasal dari suatu tempat yang bernama lumbung
paket (package repository). APT adalah program yang berfungsi untuk mengunduh (download)
paket yang Anda pilih dari lumbung dan memasangnya di komputer. 

Dengan kata lain, Anda tidak perlu mengunduh sendiri paket perangkat lunak yang ingin Anda
pasang.  Anda hanya perlu  menentukan sumber  paket  atau  lumbung paket  perangkat  lunak
tersebut melalui APT, dan meminta perangkat lunak yang ingin dipasang atau dihapus. Maka
APT  akan  melakukan  apa  yang  Anda  inginkan  termasuk  mengunduh  paket,  memasang,
pemasangan  konfigurasi,  melakukan  konfigurasi  sistem,  pemutakhiran  (update)  serta
penghapusan. 

Lumbung paket bisa berada dari empat sumber, yaitu: 

• Server Web 

• Jaringan Lokal, misalnya dari server NFS, 

• CD/DVD-ROM, 

• Folder lokal. 

 Pasang, Hapus, Dan Rawat Perangkat Lunak 
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Komunitas  BlankOn  memiliki  lumbung  paket  resmi  yang  berada  di  situs
http://arsip.blankonlinux.or.id/blankon.  Lumbung  paket  BlankOn  sudah  berisikan  berbagai
koleksi perangkat lunak yang lengkap dan siap untuk digunakan. 

Selain lumbung paket resmi, juga terdapat lumbung paket-lumbung paket lainnya yang isinya
sama, namun hanya berbeda letak servernya.  Sebagian besar dari  lumbung paket yang ada
disediakan oleh penyedia  jasa  cermin (mirror)  dan beberapa perguruan tinggi  di  Indonesia.
Berikut adalah beberapa alamat lumbung paket yang ada di Indonesia: 

 http://dl2.foss-id.web.id/blankon  (FOSS-ID, Telkom Indonesia) 

 http://kambing.ui.ac.id/blankon/  (Universitas Indonesia) 

 http://pandawa.ipb.ac.id/blankon  (Institut Pertanian Bogor) 

3.2. Pengaturan Lumbung Paket 
Untuk melakukan pengaturan lumbung paket  APT,  Anda bisa klik Menu Utama  BlankOn =>
Sistem => Administrator => Manajer Paket Synaptic. Setelah Manajer Paket Synaptic terbuka,
Anda bisa klik  Pengaturan => Repositori. Berikut adalah cara-cara pengaturan lumbung paket
dari setiap jenis sumber. 

 Pasang, Hapus, Dan Rawat Perangkat Lunak 

Gambar 2: Pengaturan Lumbung Paket

http://pandawa.ipb.ac.id/blankon
http://kambing.ui.ac.id/blankon/
http://dl2.foss-id.web.id/blankon
http://arsip.blankonlinux.or.id/blankon
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3.2.1.  Lumbung Paket Resmi BlankOn (Internet) 
Jika Anda ingin melakukan pengaturan sumber perangkat lunak dari mirror resmi BlankOn linux,
Anda bisa melihat pada tab  Perangkat Lunak BlankOn.  Pilih semua cabang perangkat lunak
yang tersedia pada bagian  Paket dari  Internet.  Kemudian tentukan cermin yang akan Anda
gunakan pada bagian Unduh dari. 

3.2.2.  Lumbung Paket Jaringan Lokal (Intranet) 
Beberapa institusi pendidikan dan kantor menyediakan lumbung paket secara lokal yang bisa
Anda  manfaatkan  untuk  menekan  biaya  penggunaan  bandwidth  internet.  Untuk
memanfaatkannya, silahkan tanya kepada administrator jaringan Anda tentang baris APT dari
lumbung paket termasuk lumbung paket untuk pemutakhiran (jika ada). Lalu tambahkan baris
APT baru sesuai dengan cara yang dijelaskan diatas. 

Setelah semua pengaturan lumbung paket selesai dilakukan, klik tombol Tutup. Kemudian APT
akan meminta Anda untuk mengunduh informasi paket dari setiap lumbung paket, klik pada
tombol  Muat  Ulang.  Sekarang,  Anda  siap  melakukan  penambahan  perangkat  lunak  untuk
BlankOn Linux. 

 Pasang, Hapus, Dan Rawat Perangkat Lunak 

Gambar 3: Pengaturan Lumbung Paket Jaringan Lokal
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3.3. Memasang dan Menghapus Perangkat Lunak 
Terdapat  dua  cara  untuk  melakukan  pemasangan  dan  penghapusan  perangkat  lunak.  Yaitu
melalui fitur manajer paket Synaptic dan melalui antarmuka teks dengan perintah apt-get. 

3.3.1.  Manajer Paket Synaptic
Jika  Anda  ingin  memasang  atau  menghapus  perangkat  lunak  secara  detail,  Anda  bisa
menggunakan  aplikasi  Synaptic  yang  bisa  Anda  buka  melalui  Menu  Utama   BlankOn  =>
Administrasi => Manajer paket Synaptic

Ketikkan  nama  aplikasi  pada  kotak  pencarian  cepat.  Aplikasi  ini  menampilkan  daftar  paket
perangkat lunak secara detail. Selain itu,  Anda juga bisa menambah dan menghapus aplikasi,
Anda juga bisa melakukan hal yang sama untuk pustaka sistem yang tersedia. Untuk menandai
paket perangkat lunak yang ingin dipasang, klik kanan pada aplikasi yang hendak dipasang lalu
pilih menu Tandai untuk Pemasangan.

Sedangkan jika ingin menghapus paket perangkat lunak, klik kanan pada aplikasi lalu pilih menu
Tandai  untuk  dibuang.  Kadangkala,  suatu  paket  perangkat  lunak  akan  meminta  satu  atau
beberapa paket perangkat lunak untuk dipasang (ketergantungan).

 Pasang, Hapus, Dan Rawat Perangkat Lunak 

Gambar 4: Memasang Aplikasi lewat Synaptic
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Jika muncul jendela yang menanyakan hal tersebut, Anda harus setuju untuk menandai paket
perangkat lunak yang dibutuhkan agar Anda bisa memasang paket perangkat lunak yang Anda
inginkan.

Untuk  menerapkannya,  klik  tombol  Terapkan  pada toolbar,  kemudian  klik  tombol  Terapkan
pada jendela konfirmasi. Maka APT akan memasang/menghapus perangkat lunak yang Anda
minta. 

3.3.2.  Melalui Perintah apt-get 
Menggunakan  perintah  apt-get  sangat  sederhana  sekali.  Anda  cukup  ketikkan  nama  paket
perangkat  lunak  yang  ingin  dipasang/dihapus,  maka  APT  akan  melakukan  hal  yang  Anda
inginkan. 

Untuk menggunakan fitur ini, bukalah antarmuka teks misalnya melalui Terminal dengan klik
Menu Utama  BlankOn => Perkakas Sistem => Terminal. 

Pada terminal ketikkan perintah seperti contoh di bawah ini 

blankon@blankon:~$ sudo apt-get install namapaket  ↵

lalu tekan tombol  Enter  untuk memasang paket perangkat lunak  (Ubah “namapaket” sesuai
dengan nama paket perangkat lunak yang hendak Anda pasang). Kemudian isikan kata sandi
sesuai dengan yang Anda buat ketika melakukan pemasangan BlankOn.

Sedangkan untuk menghapus suatu perangkat lunak, ketik perintah seperti contoh di bawah ini 

blankon@blankon:~$ sudo apt-get remove namapaket  ↵

lalu tekan tombol  Enter  untuk menghapus paket perangkat lunak  (Ingat! Ubah “namapaket”
sesuai dengan perangkat lunak yang ingin Anda hapus”).

Jika APT meminta pemasangan/penghapusan perangkat lunak yang dibutuhkan oleh perangkat
lunak yang Anda akan pasang/hapus, Anda harus menyetujuinya dengan menekan tombol  Y,
lalu tekan tombol Enter. 

TIP:
• Untuk memasang/menghapus lebih dari satu paket perangkat lunak, Anda bisa sebutkan

lebih  dari  satu  nama  paket  pada  perintah  APT  yang  masing-masing  nama  paket
dipisahkan dengan spasi. Contohnya, jika ingin memasang perangkat lunak aplikasi Kino
dan Audacity sekaligus, Anda bisa ketik perintah berikut. 

blankon@blankon:~$ sudo apt-get install kino audacity  ↵

3.3.3.  Pemasangan melalui Berkas DEB 
Selain  melalui  lumbung  paket,  Anda  juga  bisa  memasang  suatu  perangkat  lunak  yang
didistribusikan dalam format berkas DEB.  Untuk melakukan instalasi  dari  berkas  paket  DEB,
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34

Anda bisa klik ganda pada berkas DEB tersebut melalui peramban berkas, maka akan muncul
jendela yang akan menuntun Anda dalam melakukan pemasangan. 

Pada jendela tersebut, Anda bisa klik tombol Install paket. Maka paket tersebut akan diinstal ke
komputer bersamaan dengan paket ketergantungannya. 

3.4. Merawat Sistem 
Secara berkala Tim Pengembang BlankOn dan komunitas menerbitkan paket-paket perangkat
lunak  dengan  versi  yang  lebih  baru  ke  dalam  lumbung.  Jika  komputer  Anda  terhubung  ke
Internet, maka keberadaan paket-paket baru tersebut akan diinformasikan kepada Anda. Jika
Anda mau menerima paket-paket  baru tersebut,  maka sistem akan dimutakhirkan oleh APT
dengan mengunduh dan memasang paket-paket itu. 

Dengan melakukan pemutakhiran berkala menjadikan sistem Anda terawat karena pada versi
baru,  biasanya  telah  dilakukan  pemeriksaan  dan  perbaikan  cacat  yang  telah  diketahui
sebelumnya.  Kadangkala  versi  baru  diterbitkan  untuk  menutup  celah-celah  keamanan  yang
ditemui pada suatu paket. 

Untuk  melakukan  pemutakhiran  sistem,  pastikan  Anda  sudah  mengaktifkan  informasi
pemutakhiran  dari  lumbung  paket  pada  APT  seperti  yang  sudah  dijelaskan  sebelumnya.
Kemudian,  klik Menu Utama  BlankOn => Sistem => Administrasi  => Manajer  Pemutakhiran
untuk melakukan pemutakhiran sistem. 

Klik  tombol  Periksa untuk  memeriksa  ketersediaan  pemutakhiran.  Jika  terdapat  paket-paket
perangkat lunak dengan versi baru, Anda bisa memberi centang paket perangkat lunak yang
hendak Anda perbarui. Untuk mengunduh dan memasang update, klik tombol  Instal Update.
Maka APT akan melakukan pemutakhiran pada paket perangkat lunak yang Anda pilih. 

Selain cara yang dibahas di atas, Anda bisa melakukan pemutakhiran sistem melalui terminal.
Untuk melakukan hal ini, buka terminal melalui Menu Utama  BlankOn => Perkakas Sistem =>
Terminal. Lakukan pemeriksaan ketersediaan pemutakhiran dengan mengetik perintah seperti
berikut, lalu tekan Enter: 

blankon@blankon:~$ sudo apt-get update  ↵

Kemudian, ketik perintah seperti berikut untuk melakukan pemutakhiran paket perangkat lunak,
lalu tekan tombol Enter: 

blankon@blankon:~$ sudo apt-get upgrade  ↵

INGAT! Pastikan Anda terhubung dengan lumbung paket update agar proses pemutakhiran bisa
berjalan dengan lancar. 
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BAB 4 DESTOP BLANKON 

lankOn  menyediakan  lingkungan  kerja  atau  destop  environment  yang  sangat  mudah
digunakan bernama Manokwari (http://manokwari.blankonlinux.or.id/). Destop ini juga
sangat sederhana, namun sangat lengkap dari sisi fitur. Pada bab ini, dijelaskan mengenai

pengenalan bagian dan pengaturan pada destop BlankOn untuk keperluan bekerja sehari-hari. 
B
Sesaat setelah komputer dinyalakan, maka akan tampil destop BlankOn bernama Manokwari.
Destop BlankOn terdiri dari dua bagian utama, yaitu Latar Belakang dan Menu Favorit. 

4.1. Mengenal Destop BlankOn
Area  kerja  merupakan  tempat  dimana  jendela-jendela  aplikasi  ditempatkan  serta  ikon-ikon
destop  ditampilkan.  Sedangkan  panel,  berisikan  ikon-ikon  dan  objek  yang  membantu  Anda
dalam bekerja. Panel bawaan di BlankOn menggunakan panel yang merupakan pengembangan
mandiri dari pengembang BlankOn yang diberi nama Manokwari. Berikut adalah bagian-bagian
dari Manokwari: 

 Destop BlankOn 

Gambar 5: Tampilan Destop BlankOn ketika pertama kali dijalanakan
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4.1.1.  Menu Utama  BlankOn
Menu  Utama   BlankOn  digunakan  untuk  membuka  suatu  aplikasi  atau  perintah
tertentu. Ketika Menu Utama  diklik maka secara otomatis muncul beberapa menu
berdasarkan kelompok aplikasi dan perintah penting tertentu. Menu Utama  BlankOn
berbentuk logo BlankOn dan berada di pojok kiri atas.

4.1.2.  Bilah Aplikasi
Bilah  Aplikasi  berisi  daftar  aplikasi  atau  perintah  tertentu
yang sedang dibuka, bilah ini berada di sebelah kanan Menu
Utama .

4.1.3.  Notifikasi
Notifkasi  menampilkan  informasi  dari  sistem  dan aplikasi
tertentu yang sedang aktif.  Ketika aplikasi  atau sistem ingin
memberikan suatu informasi, maka akan muncul notifikasi di
bagian  atas  layar.  Contoh,  jika  Anda  mendapatkan  pesan
obrolan atau surel baru, maka akan ada notifikasi di bagian atas layar yang menginformasikan
hal tersebut.

 Destop BlankOn 

Gambar 6: Antarmuka BlankOn dengan beberapa Keterangannya

Gambar 8: Tampilan Notifikasi

Gambar 7: Tampilan Bilah Menu
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4.1.3.1. Menyembunyikan Notifikasi
Jika Anda sedang bekerja dan tidak ingin diganggu oleh notifikasi, Anda dapat menyembunyikan
atau mematikan notifikasi, berikut caranya:

Klik  Menu  Utama    BlankOn =>  Pengaturan =>  Pribadi =>  Notfikasi,  kemudian  matikan
notifikasi dengan mengklik  tombol  di  samping  Notification Banner  sehingga  tanda centang
berubah menjadi tanda silang.

Jika notifikasi dimatikan, maka notifikasi tidak muncul pada bagian atas layar, akan tetapi tetap
terbuka jika Anda mengklik bagian Hari, Jam, Tanggal, Bulan, dan Tahun.

Mengatur Notifikasi Aplikasi
Anda juga dapat mengatur notifikasi aplikasi satu persatu dengan memilih aplikasi pada panel
notifikasi. Status notifikasi ditunjukkan disebelah kanan dengan tulisan Mati atau Nyala. 

4.1.4.  Tanggal dan Waktu
Berisi keterangan Hari, Jam, Tanggal, Bulan,  dan Tahun pada
komputer dan sistem operasi yang Anda gunakan.
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Gambar 9: Mengatur Notifikasi, Kiri; Notifikasi Nyala, Kanan; Notifikasi Mati

Gambar 10: Mengatur Notifikasi Aplikasi
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4.1.4.1. Mengatur Tanggal dan Waktu Secara Manual
Kadang kala Hari, Jam, Tanggal, Bulan, dan Tahun pada notifikasi tidak sesuai dengan keadaan
yang sebenarnya, tapi jangan kuatir, Anda dapat mengatur Tanggal dan Waktu secara manual.
Untuk melakukan  pengaturan Hari, Jam, Tanggal, Bulan,  dan Tahun, lakukan langkah berikut;
klik Menu Utama  BlankOn => Pengaturan => Sistem => Tanggal & Waktu, matikan pengaturan
Tanggal & Waktu Otomatis dengan melakukan klik pada tombol yang tersedia sehingga tanda
cetang berubah menjadi  tanda silang.  Klik  Tanggal & Waktu,  maka secara otomatis muncul
subjendela pengatur Hari, Jam, Tanggal, Bulan, dan Tahun secara manual, klik tanda tambah (+)
untuk  menambah (memajukan)  Jam,  Menit,  Hari,  Bulan,  dan  Tahun sedangkan  untuk
mengurangi (memundurkan) dapat dilakukan dengan klik  tanda minus (-).

4.1.5.  Penukar Area Kerja
BlankOn  menyediakan  empat  buah  area  kerja
yang bisa  Anda gunakan.  Jika  sebuah area  kerja
penuh, Anda bisa berpindah ke area kerja lainnya
dengan memanfaatkan penukar area kerja. Anda
dapat memindahkan suatu jendela dari suatu area
kerja ke area kerja lainnya dengan cara klik kanan
Aplikasi  yang akan dipindah => Pindah Ke Area
Kerja  Lain.  Untuk  melihat  aplikasi  yang  sedang
aktif pada  Area Kerja tertentu klik ikon  Penukar
Area Kerja di pojok kanan atas Destop, kemudian
pilih salah satu area kerja dimana aplikasi tersebut
berada. 
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Gambar 11: Cara Mengatur Jam dan Tanggal secara manual

Gambar 12: Cara Menukar Area kerja
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4.1.6.  Panel Menu Utama 
Panel Menu Utama  berisi menu berdasarkan kelompok aplikasi dan perintah penting tertentu.
Terdapat beberapa kelompok menu yaitu menu Aplikasi, Perkakas Sistem, dan Adminitrasi.

Menu Aplikasi untuk membuka aplikasi yang disediakan oleh BlankOn X Tambora, menu aplikasi
terdiri dari beberapa kelompok aplikasi dalam submenu.

Menu  Perkakas Sistem  dan  Adminitrasi digunakan untuk membuka beberapa peralatan yang
berhubungan dengan pengaturan sistem dan perangkat keras.

Di bawah menu kelompok aplikasi terdapat menu kelompok  Preferensi dan  Pengaturan yang
dapat digunakan untuk melakukan pengaturan destop sistem.

Menu  Lokasi  digunakan  untuk  membuka  isi  suatu  folder  dengan  peramban  berkas  atau
Nautilus. Ketika Menu Lokasi diklik maka muncul submenu lagi yaitu Lokasi dan Bookmark. 

Di bagian paling bawah  Panel Menu Utama  terdapat satu buah menu yaitu  Sessions. Menu
Sessions berisi bebrapa tombol dalam bentuk ikon yang fungsinya untuk Mengunci layar (lock
screen), keluar (logout), Nyalakan ulang (restart), dan Matikan (shutdown).

 Destop BlankOn 
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4.1.7.  Panel Kanan
Panel Kanan muncul bila kita mengarahkan kursor ke tepi kanan-atas destop beberapa saat.

Panel  Kanan terdriri  dari  4  (empat)  bagian,  yaitu;  Bookmarks,  Music  Player,  Weather,  dan
System Settings.

4.1.7.1. Bookmarks
Bookmarks berisi tautan untuk membuka laman;

• Laman BlankOn: blankonlinux.or.id

• Laman Panduan BlankOn: panduan.blankonlinux.or.id

• Grub BlankOn di Facebook: facebook.com/groups/blankonlinux

• Twitter BlankOn: twitter.com/BlankOnLinux/

4.1.7.2. Music Player
Music Player berisi tombol-tombol pemutar musik (Audacious). Ada 5 tombol;

• Stop/Quit : Mematikan aplikasi

• Previous  :  Memutar  kembali  musik  sebelumnya
(dalam daftar musik yang sedang diputar)

• Play/Pause : Memutar atau menjeda 

• Next : Memutar musik selanjutnya (dalam daftar musik yang sedang diputar).

• Repeat : mengulang pemutaran musik.

4.1.7.3. Weather
Weather  menyajikan  prakiraan  cuaca  setempat  yang  meliputi  suhu  dan  kecerahan  dalam
sepekan. Pada weather terdapat dua tombol;

• Ikon  roda  gerigi  untuk  membuka  panel  opsi
sehingga  kita  dapat  menentukan  lokasi,  satuan
suhu, mph atau kph atau m/s, dan memilih warna
latar.

• Ikon lingkaran berpanah untuk memuat ulang data
cuaca yang ditampilkan

 Destop BlankOn 



41

4.1.7.4. System Settings
System Settings menampilkan tautan-tautan untuk membuka panel pengaturan;

• Latar Belakang

• Pengguna

• Tanggal & Waktu

• Akun Daring

• Wilayah & Bahasa

• Tampilan

• Jaringan

• Papan Ketik

• Mouse dan Touchpad

• Sound

• Bluetooth

• Daya

• Rincian

• Pencetak

• Berbagi Pakai

4.1.7.5. Jam dan tanggal
• Jam  ditampilkan  dengan  format  HH:MM,  tanggal

ditampilkan dengan format DDD, DD MMMM YYYY
misalnya; 07:32 Sun, 25 December 2016. 

4.2. Bekerja dengan Aplikasi 
Untuk membuka suatu aplikasi pada BlankOn, Anda bisa memanfaatkan menu Aplikasi pada
bagian Menu Utama . Aplikasi yang berada di dalam menu tersebut dikelompokkan berdasarkan
jenisnya, yaitu :  Aksesoris,  Perkantoran, Internet, Suara & Video, dsb.  Jadi,  Anda bisa lebih
mudah mencari aplikasi yang akan dibuka. 

4.2.1.  Tombol Pintas 
Untuk mempermudah Anda bekerja menggunakan destop BlankOn dan memanipulasi jendela
aplikasi, Anda bisa menggunakan  tombol pintas  atau  keyboard shortcut tertentu yang setiap
perpaduannya memiliki fungsi khusus. Berikut adalah penjelasan masing-masing tombol pintas: 
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Tombol Pintas Fungsi 
PrtSc / SysRq Mengambil tangkapan layar pada destop 

Alt + Prt Sc Mengambil tangkapan layar dari jendela yang sedang aktif 

Alt + Tab Berpindah antar jendela yang sedang aktif 

Ctrl + Alt + Left/Right Cursor Berpindah antara area kerja. 

Alt+F4 Menutup jendela yang sedang aktif. 

Alt+F5 Mengembalikan ukuran jendela yang sedang aktif ke ukuran normal.

Alt+Space Menampilkan menu untuk memanipulasi jendela yang aktif 

Alt+F10 Memperbesar jendela yang sedang aktif. 

Alt+F8 Mengubah ukuran jendela yang sedang aktif 

Alt+F7 Memindahkan jendela yang sedang aktif 

Ctrl+Alt+L Mengunci layar 

4.2.1.1. Tambahkan Aplikasi ke Menu Favorit
Anda  dapat  menambah  atau  mengurangi  Aplikasi  yang  sering
digunakan pada  Menu Favorit di  destop sesuai  dengan keinginan.
Berikut caranya; klik  Menu Utama  BlankOn => Aplikasi => Nama
Aplikasi, kemudian klik  kanan aplikasi yang akan Anda masukan ke
dalam Menu Favorit, pilih opsi  tambahkan ke desktop atau  Add to
Desktop.

4.2.1.2. Hapus Aplikasi dari Menu Favorit
Untuk menghapus aplikasi dari Menu Favorit lakukan
langkah  berikut;  klik  tombol  kiri  tetikus,  tahan
aplikasi tersebut, kemudian seret ke tempat sampah
yang secara otomatis muncul   di  atas menu favori.
Sedangkan  untuk  mengubah  nama  aplikasi,  klik
Menu  Utama   BlankOn  =>  Lokasi  =>  Desktop,
kemudian klik kanan nama aplikasi pilih  ubah nama
atau rename, tulis nama sesuai yang di kehendaki. 

 Destop BlankOn 



43

4.2.2.  Mengganti Latar Belakang
Anda bisa mengatur tampilan latar belakang destop sesuai selera. Latar Belakang dapat Anda
ganti dengan gambar yang sudah disediakan secara baku oleh BlankOn atau dengan gambar
koleksi Pribadi.

4.2.2.1. Mengganti Latar Belakang dengan Gambar Baku
Untuk mengganti gambar Latar belakang dengan gambar tertentu yang sudah disediakan secara
baku oleh BlankOn lakukan cara berikut:

Klik Menu Utama  BlankOn => Pengaturan => Pribadi => Latar Belakang,  maka otomatis tampil
jendela untuk mengatur Latar Belakang yang terdiri dari  2 (dua) menu, yaitu;  Latar Belakang
(background) dan Kunci Layar (lockscreen). Latar Belakang digunakan untuk mengatur gambar
latar belakang pada  destop,  sedangkan  Kunci Layar digunakan untuk mengatur gambar latar
belakang ketika Anda mengunci komputer atau login.

Dalam contoh pada buku ini adalah mengganti latar belakang pada destop, maka dari itu klik
menu  Latar Belakang, sesaat setelah menu latar belakang diklik maka secara otomatis tampil
subjendela pengatur latar belakang yang terdiri dari 3 (tiga) tab, yaitu  Gambar latar, Gambar,
dan Warna. 
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Pilih salah satu tab (misal tab  Gambar latar), klik salah satu gambar yang akan dijadikan latar
belakang untuk destop, klik tombol Select, maka secara otomatis gambar latar belakang pada
destop berubah sesuai gambar yang tadi dipilih.

4.2.2.2. Mengganti Latar Belakang dengan Gambar Koleksi Pribadi
Anda dapat mengganti gambar latar belakang pada destop dengan gambar koleksi milik pribadi,
berikut caranya: cari gambar yang akan dijadikan latar belakang di direktori komputer Anda,
kemudian klik kanan gambar tersebut, pilih Jadikan gambar Latar.

 

4.3. Pengaturan Pengguna
Sistem operasi BlankOn merupakan sistem operasi multiuser atau banyak pengguna. Linux bisa
digunakan oleh banyak pengguna yang memiliki ruang dan lingkungan masing-masing. Setiap
pengguna juga memiliki  nama akun pengguna (userid) dan kata sandi.  Nama pengguna dan
sandi  ini  akan  diminta  pada  saat  pertama  kali  menjalankan  BlankOn.  Oleh  karena  itu,
pengetahuan tentang manajemen pengguna sangat dibutuhkan dalam mempelajari BlankOn.
Baik bagi mereka yang sekadar pengguna rumahan yang hanya memilik satu jenis pengguna di
sistem mereka, ataupun mereka yang bertindak sebagai sistem administrator. 

Untuk melakukan pengaturan informasi pribadi seperti nama, foto, kata sandi dan sebagainya
untuk disimpan oleh sistem,  Anda bisa  membuka pengaturannya dengan klik  Menu Utama
BlankOn => Pengaturan => Sistem => Pengguna.

Sebelum melakukan pengaturan Anda harus  Membuka Kunci dengan cara klik tombol  Buka
Kunci. Masukkan sandi Administrator untuk pembukaan kunci tersebut. 
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4.3.1.  Tambah Pengguna
Untuk menambahkan akun, klik  tombol + (tambah) di pojok kiri  bawah, maka segera tampil
jendela  Tambah Pengguna,  lakukan pengaturan pada kotak yang tersedia, contohnya seperti
berikut;

• Tipe Akun: Standar

• Nama Lengkap: user1

• Nama pengguna: user1
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Lakukan juga pengaturan sandi untuk pengguna yang akan ditambahkan, yaitu dengan klik set a
password now,  kemudian isikan/ketik sandi  Anda pada  kotak Sandi,  ketik ulang sandi  yang
sama pada kotak  Verifikasi, jika semua pengaturan sudah selesai, klik tombol  Tambah untuk
menerapkan proses penambahan pengguna baru.

Maka segera muncul jendela konfirmasi yang meminta sandi, ketik Sandi Adminstrator Anda,
kemudian tekan tombol Authenticate.

Sekarang, Anda bisa melihat pengguna baru pada daftar pengguna. Untuk menggunakan sistem
dengan pengguna yang baru ditambahkan tadi,  silakan  keluar (logout)  dari  destop BlankOn
melalui Menu Utama  BlankOn => Sessions => Keluar (logout), kemudian masuk menggunakan
akun yang sudah ditambahkan.

4.3.2.  Mengganti Gambar Pengguna
Untuk mengganti gambar akun, klik tombol  Buka kunci, ketik sandi  Administrator,  kemudian
tekan tombol  Authenticate. Langkah selanjutnya yaitu, klik gambar pengguna, kemudian pilih
gambar yang sesuai. 
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Jika  ingin  menggunakan  gambar  yang  tersimpan  di  komputer,  klik  Ramban  lebih  banyak
gambar...,  kemudian  lakukan pencarian  pada  folder  dimana  Anda meletakkan gambar  yang
ingin digunakan, klik gambar tersebut kemudian klik tombol buka di pojok kanan atas jendela,
atur besarnya tampilan gambar, kemudian klik Pilih.

4.3.3.  Hapus Pengguna 
Untuk  menghapus pengguna yang sudah ada,  klik  ikon  gembok atau  tulisan Buka kunci di
sebelah kanan atas. Anda akan ditanyakan kata sandi, ketikkan kata sandi Administrator Anda,
klik tombol Authenticate, kemudian klik pengguna yang akan dihapus, setelah itu klik tombol -
(minus) yang terletak di sebelah kiri bagian bawah pada menu pengaturan pengguna. 

4.3.4.  Privasi
Privasi dapat digunakan untuk mengontrol bagian dekstop yang dapat dilihat oleh pihak
lain.  Anda  juga  dapat  menggunakan  pengaturan  Privasi  untuk  membersihkan  riwayat
penggunaan komputer dan berkas-berkas/file yang tidak diperlukan.
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Untuk mengatur fitur privasi lakukan langkah berikut, klik  Menu Utama   BlankOn =>
Preferensi =>  Pengaturan  =>  Pribadi  =>  Privasi,  maka  segera  muncul  jendela
pengaturan Privasi yang tediri dari 4 (empat) komponen.

4.3.4.1. Kunci Layar (Mati atau Nyala)
Bila Kunci Layar nyala, maka layar akan dikunci ketika komputer tidak digunakan dalam waktu
tertentu  sehingga  privasi  Anda  akan  tetap  terlindungi  ketika  Anda  meninggalkan  komputer
dalam keadaan hidup.

Terdapat 3 (tiga) komponen dalam jendela pengaturan Kunci Layar yaitu;

Kunci Layar Otomatis
Anda dapat mengatur agar layar terkunci secara otomatis dengan melakukan klik pada tombol
yang  tersedia  sehingga  berubah  menjadi  tanda  centang,  jika  ingin  mematikannya  klik  lagi
tombol tersebut sehingga berubah menjadi tanda silang.   

Kunci layar setelah kosong selama
Komponen ini digunakan untuk mengunci layar secara otomatis ketika komputer sedang tidak
digunakan berdasarkan jeda waktu tertentu, Anda dapat mengatur jeda waktu pada menu yang
tersedia (setiap 30 detik, 1, 2, 3, 4, 5, 30 menit atau 1 jam)

Tampilkan Pemberitahuan
Anda dapat mengatur pemberitahuan agar tampil secara otomatis dengan melakukan klik pada
tombol yang tersedia sehingga berubah menjadi tanda centang, jika ingin mematikannya klik
lagi tombol tersebut sehingga berubah menjadi tanda silang.  

4.3.4.2. Location Services (Off atau On)
Layanan lokasi ini dapat aktif bila komputer terhubung dengan internet
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4.3.4.3. Pemakaian & Riwayat 
Dengan  menyalakan  Pemakaian  &  Riwayat,  komputer  akan  mencatat  riwayat  penggunaan
komputer seperti berkas apa saja yang telah dibuka.
Pencatatan riwayat ini dapat mempermudah Anda jika
akan  membuka  atau  menggunakan  kembali  berkas-
berkas  tersebut.  Anda  juga  dapat  mengatur  jangka
waktu penyimpanan riwayat (selama 1, 7, atau 30 hari
atau  bahkan  selamanya/tanpa  batasan).  Di bagian
bawah  kotak  dialog  Pemakaian  &  Riwayat,
terdapat tombol Bersihkan Riwayat Baru-baru Ini
yang fungsinya untuk menghapus riwayat.

4.3.4.4. Kosongkan Tong Sampah & Berkas Temporer
Berkas-berkas pada Tong Sampah dan Berkas Temporer dapat dihapus secara manual maupun
secara  otomatis.  Pada  tatanan  Privasi,  Anda  dapat  menyalakan  dan  mengatur  pembersihan
berkas-berkas pada tong sampah dan atau berkas-berkas temporer.

Anda  juga  dapat  mengatur  jangka  waktu
pembersihan  berkas  pada  tong  sampah  dan
atau berkas temporer secara otomatis (setiap 1
jam, 1 hari, 7 hari, 14 hari, atau 30 hari).

Pada  bagian  bawah  kotak  dialog  Kosongkan
Tong Sampah & Berkas Temporer terdapat dua
tombol pembersihan secara langsung;

• Kosongkan Tong Sampah

• Bersihkan Berkas Temporer
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4.3.5.  Mengunci Layar 
Jika Anda akan meninggalkan komputer dalam keadaan hidup dan Anda tidak ingin komputer
diutak-atik oleh orang lain, Anda bisa mengunci layar komputer tersebut. Sehingga, jika ingin
kembali bekerja dengan destop, Anda harus kembali memasukkan sandi terlebih dulu.

Untuk melakukan hal ini, Anda bisa mengaktifkan fitur kunci layar dengan klik  Menu Utama
BlankOn => Session => Kunci Layar (Lock Screen), atau dengan menekan tombol Ctrl+Alt+l pada
papan tik. 

Pada  kondisi  terkunci,  tampilan  monitor  komputer
akan  lansung  dalam  keadaan  blank.  Jika  ingin
mengaktifkan  destop,  geser  mouse  atau  tekan
sembarang  tombol  di  keyboard,  masukkan  sandi
Anda,  kemudian  klik  tombol  Buka  Kunci (Unlock)
kembali. 

4.3.6.  Mengakhiri Sesi 
Untuk mengakhiri sesi bekerja Anda di BlankOn tanpa mematikan komputer, caranya adalah klik
Menu Utama BlankOn => Session => Keluar (Logout) => Keluar Sekarang (Logout Now).

4.3.7.  Menghidupkan Ulang Komputer
Untuk  menghidupkan  ulang  komputer  saat  sedang  digunakan,  Menu  Utama   BlankOn  =>
Session => Nyalakan Ulang (Restart) => Nyalakan Ulang Sekarang (Restart Now).

4.3.8.  Mematikan Komputer 
Untuk mematikan komputer, caranya adalah klik Menu Utama  BlankOn => Session => Matikan
(Shutdown)  lalu  klik  tombol  Matikan  Sekarang (Shutdown  Now)  maka  komputer  secara
otomatis akan mati sendiri.
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BAB 5 MENGGUNAKAN PERAMBAN BERKAS

ntuk  melakukan manajemen berkas  di  komputer  yang menggunakan sistem operasi
BlankOn,  Anda dapat  menggunakan peramban berkas  yang bernama  Nautilus. Kata
Berkas merupakan terjemahan dari  kata  File yang sudah diterjemahkan dari  bahasa

Inggris ke bahasa Indonesia.  Bab ini menjelaskan secara ringkas mengenai cara menggunakan
Nautilus untuk keperluan manajemen berkas sekaligus mengenalkan konsep manajemen berkas
di BlankOn. 

U
5.1. Menggunakan Nautilus
Melakukan pengelolaan berkas menggunakan Nautilus sangatlah mudah. Bagi Anda yang sudah
terbiasa  menggunakan  Microsoft  Windows  tidak  akan  mengalami  kesulitan  karena  yang
berbeda hanyalah tampilannya saja (menu dan bahasa saja yang berbeda). Cara menyalin dan
menempel berkas ke direktori, menyeleksi direktori atau berkas, tidak berbeda antara BlankOn
dan Microsoft  Windows.  Demikian  pula  cara  membuat  folder,  mengganti nama folder  atau
berkas, menghapus folder atau berkas juga sama dengan Microsoft Windows. 

Membuka berkas atau folder dalam direktori yang ada di Nautilus pun sama dengan Windows
yaitu dengan klik dua kali.  Misalkan jika akan menghapus folder atau berkas dapat dilakuan
dengan menekan tombol  Delete.  Jika menggunakan tombol  Delete maka folder atau berkas
akan dipindah tempat Sampah (Recycle Bin jika di Microsoft Windows) tetapi jika menggunakan
tombol Shift+Delete, maka folder atau berkas akan dihapus secara permanen.

5.2. Menu Pada Nautilus
Secara  garis  besar  Nautilus  terdiri  dari  dua  bagian,  yaitu  Tajuk  dan  Direktori.  Dalam  Tajuk
terdapat  beberapa  menu  yang  diwakili  oleh  beberapa  tombol dan  ikon.  Sedangkan  dalam
Direktori terdapat berbagai folder yang berisi berkas pada komputer.

5.2.1.  Tajuk
Terdapat  6  menu  pada  tajuk,  yaitu;  Tombol  Navigasi,  Kotak  Direktori,  Tombol  Pencarian,
Notofikasi,  Bilah  Menu,  dan  Tombol  Jendela.  Dan  dalam  menu  terdapat  submenu  berisi
perintah tertentu.

1. Tombol Navigasi, digunakan untuk berpidah dari  direktori  satu ke direktori  lain yang
pernah  dibuka,  tombol  Kembali digunakan  untuk  kembali  ke  direktori  yang  dibuka
sebelumnya, sedangkan tombol  Berikutnya digunakan untuk maju kembali ke direktori
sebelumnya. Cara kerja tombol ini mirip fungsi  Undo-Redo ketika Anda menggunakan
Aplikasi tertentu.

2. Kotak  Direktori, berisi  keterangan  direktori  yang  sedang  dibuka,  keterangan  berupa
tulisan dari nama folder tertentu dalam direktori.
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3. Notifikasi: berisi notifikasi ketika menyalin atau memindah berkas pada suatu direktori
atau folder.

4. Tombol Pencarian, digunakan untuk mencari berkas tertentu dengan menekan tombol
yang tersedia, kemudian mengetik kata kunci tertentu sesuai berkas yang akan dicari.

5. Tombol  Menu,  berisi  berbagai  menu untuk  bekerja  pada direktori,  terdapat  2  (dua)
kelompok menu yang masing-masing meiliki submenu berbeda.

6. Tombol  Jendela, terdiri  dari  3  (tiga) tombol  yang  fungsinya  untuk
Meminimalkan/memaksimalkan, Memperkecil/memperbesar, dan Menutup Jendela.

 

5.2.2.  Membuka Direktori
Untuk  membuka  direktori  tertentu  di  BlankOn  dapat  dilakukan  dengan  klik  Menu  Utama
BlankOn => Lokasi => Nama Direktori. Direktori pada BlankOn secara garis besar dibagi menjadi
Tiga bagian yaitu, Beranda, Perangkat, dan Lokasi Lain, dalam tiga direktori tersebut terdapat
subdirektori berisi folder atau berkas lainnya.

5.2.2.1. Direktori Komputer
Berisi  berbagai  folder  yang  sudah  disesuaikan  dengan  jenis  berkas  sehingga  memudahkan
dalam mengelola berkas.
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Rumah atau Beranda
Merupakan direktori yang berisikan Folder berkas-berkas milik pengguna, Rumah dalam bahasa
Inggris disebut Home.

Desktop
Merupakan direktori  di  dalam direktori  Rumah yang berisikan berkas yang bisa dilihat pada
Desktop. 

Dokumen
Merupakan  direktori  di  dalam  direktori  Rumah  yang  diperuntukkan  untuk  menyimpan
dokumen, Dokumen dalam bahasa Inggris disebut Document.

Musik
Merupakan direktori di dalam direktori Rumah yang diperuntukkan untuk menyimpan musik,
Musik dalam bahasa Inggris disebut Music.

Gambar
Merupakan direktori di dalam direktori beranda yang diperuntukkan untuk menyimpan gambar
atau foto, Gambar dalam bahasa Inggris disebut Picture.

Video
Merupakan direktori di dalam direktori beranda yang diperuntukkan untuk menaruh video.

Unduhan
Merupakan direktori  di  dalam direktori  beranda yang diperuntukkan untuk  menaruh berkas
unduhan dari internet, Unduhan dalam bahasa Inggris disebut Download.

Tempat Sampah
Merupakan direktori untuk menampung berkas yang dihapus, berkas yang berada di  Tempat
Sampah dapat dikembalikan ke tempat semula atau dihapus secara permanen.

5.2.2.2. Direktori Perangkat
Berisi direktori dan nama dari media simpan yang ditancapkan atau dimasukkan pada komputer
misalnya keping CD/DVD, Flashdisk, Kartu Memori, dan lain-lain.

5.2.2.3. Lokasi Lain
Berisi Media Simpan dan Jaringan yang terpasang di dalam komputer.
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Media Simpan
Berisi  Partisi dari  media simpan yang terpasang dalam komputer, partisi  dapat berisi  Sistem
Operasi, Folder, dan berbagai data.

Jaringan
Berisi penelusuran jaringan untuk pengaturan dalam berbagi berkas antara komputer satu dan
lainnya, baik untuk sistem operasi yang sama maupun beda sistem operasi.

5.2.3.  Mengoperasikan Nautilus
Dengan  nautilus  Anda  dapat  mengelola  dan  melakukan  berbagai  pekerjaan  yang  berkaitan
dengan berkas, misalnya;  membuat folder, menyalin berkas, memindah berkas, menghapus
berkas, dan lain-lain.

5.2.3.1. Membuat Folder Baru
Letakkan kursor di area kosong dalam salah satudirektori, klik tombol kanan tetikus, pilih Folder
Baru, maka akan muncul jendela untuk membuat folder baru, beri nama folder tersebut dengan
cara mengetik nama folder yang diinginkan, misalnya beri nama Coba buat Folder, kemudian
klik tombol  Buat atau tekan tombol  Enter pada Papan Tik.  Untuk membuat folder baru juga
dapat dilakukan dengan menekan tombol Shift+Ctrl+N pada Papan Tik.
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5.2.3.2. Salin Folder/Berkas
Arahkan kursor ke salah satu Folder atau Berkas, kemudian
klik folder atau berkas tersebut, klik kanan, pilih Salin, Salin
dalam bahasa Inggris disebut Copy. Untuk menyalin berkas
juga dapat dilakukan dengan menekan tombol Ctrl+C pada
Papan Tik.

5.2.3.3. Tempel Berkas
Arahkan kursor pada salah satu folder di  dalam direktori
komputer Anda, klik dua kali folder tersebut, kemudian klik
tombol kanan tetikus pilih Tempel, kata Tempel merupakan
terjemahan  kata  Paste dari  bahasa  Inggris.  Untuk
menempelkan  berkas  juga  dapat  dilakukan  dengan
menekan tombol Ctrl+V pada Papan Tik.

5.2.3.4. Memindahkan Berkas
Untuk  memindahkan  obyek  atau  berkas  dari  direktori  satu  ke  direktori  lainya  dapat
menggunakan metode Potong, caranya hampir sama dengan mode salin, yaitu klik berkas yang
akan dipindah, klik kanan, pilih  Potong,  kemudian masuk ke direktori tujuan, klik kanan pada
direktori  tersebut,  pilih  Tempel,  maka  berkas  akan  pindah  ke  direktori  tujuan.  Untuk
memindahkan berkas juga dapat dilakukan dengan menekan tombol Ctrl+X pada Papan Tik.

5.2.3.5. Mengganti nama Berkas
Nama berkas atau obyek yang ada dalam komputer
dapat  diubah  sesuai  jenis  berkas  tersebut,  untuk
mengubah nama berkas, klik kanan berkas pilih Ubah
Nama, ketik nama pengganti, kemudian klik tombol
Ubah Nama atau  tekan  tombol  Enter pada Papan
Tik.
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5.2.3.6. Hapus Berkas
Klik  berkas  yang akan dihapus,  klik  kanan => Pindahkan ke  Tempat  Sampah,  maka berkas
tersebut  akan  masuk  ke  tempat  sampah,  kalimat  Pindah  ke  Tempat  Sampah merupakan
terjemahan Move to Trash dari bahasa Ingris.

5.2.3.7.  Mengembalikan Berkas
Arahkan kursor  ke  direktori  Tong Sampah,  kemudian klik  direktori  tersebut,  pilih salah satu
obyek atau berkas yang akan di kembalikan, kemudian klik menu Kembalikan, maka obyek atau
berkas tersebut akan kembali lagi ke direktori terakhir obyek tersebut saat dihapus.

5.2.3.8. Kosongkan Tong Sampah
Klik salah satu obyek atau berkas yang akan di hapus permanen, klik kanan, pilih Delete from
Trash,  maka akan tampil  peringatan  Yakin akan menghapus permanen Nama_berkas? pilih
Hapus, maka berkas tersebut akan terhapus secara permanen.

Jika ingin menghapus semua berkas yang ada di  Tong Sampah secara Permanen, klik menu
Empty,  maka akan tampil  peringatan untuk  mengosongkan tempat sampah,  klik  Kosongkan
Tempat  Sampah,  maka  semua  Obyek  atau  Berkas  yang  berada  di  Tempat  Sampah  akan
terhapus secara Permanen.

5.2.3.9. Tombol Pintas
Untuk memnyalin, memindah, dan menghapus berkas atau obyek dapat juga dilakukan dengan
menekan tombol tertentu Papan Tik secara bersamaan, berikut ini adalah beberapa contohnya;

• Salin, tekan tombol Ctrl+C

• Potong, tekan tombol Ctrl+X

• Tempel, tekan tombol Ctrl+V

• Hapus, tekan tombol Delete

• Hapus Permanen, menekan tombol Shift+Delete

• Ganti Nama, menekan tombol F2

5.2.4.  Tombol Menu
Tombol ini berisi berbagai menu untuk bekerja pada direktori, terdapat dua kelompok menu
dalam bilah menu, yaitu Menu Tampilan dan Menu Pilihan.
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5.2.4.1. Menu Tampilan
Menu ini terdiri dari  dua submenu yang fungsinya untuk mengatur tampilan direktori. Bagian
paling atas dari menu ini adalah untuk memilih submenu yang tersedia, yaitu submenu untuk
mengatur tampilan berkas dalam direktori berbentuk kotak dan baris (list). 

Menu  kedua  adalah  untuk  mengatur  besar-kecilnya  ukuran  tampilan  (zoom),  menu  ini
berbentuk  garis lurus yang di atasnya terdapat  lingkaran kecil sebagai slider, ketika lingkaran
kecil  tersebut  digeser  ke  kiri maka tampilan  berkas  dalam direktori  berubah kecil,  dan jika
lingkaran kecil digeser ke kanan maka yang terjadi sebaliknya.

Menu ketiga adalah  urutan (sort),  menu ini digunakan untuk
mengatur  urutan  tampilan  berkas  pada direktori,  terdapat  4
(empat) pilihan  yaitu  urutkan  berdasarkan  Nama,  Ukuran,
Tipe, dan  Terakhir  diubah.  Di  bawahnya  terdapat  satu  lagi
menu yang masih berkaitan dengan menu pada urutan, yaitu
menu  Urutan  Terbalik yang  fungsinya  untuk  mengatur
tampilan berkas agar urutannya terbalik.

Menu keempat adalah  Tampilkan Berkas Tersembunyi, menu
ini  digunakan  untuk  menampilkan  berkas  atau  folder  yang
tersembunyi, biasanya berkas yang tersembunyi pada nautilus
adalah berkas yang berkaitan dengan  sistem, berkas tersebut
diawali  dengan  tanda  titik_namaberkas  (contoh:  .cache,
.confiq,  .dbus,  dll).  Untuk  menampilkan  berkas  tersembunyi
dapat juga dilakukan dengan menekan tombol Ctrl+H.

Menu kelima adalah  Muat Ulang, menu ini digunakan untuk memuat ulang perubahan pada
suatu  sistem atau  aplikasi,  sebagai  contoh,  ketika  Anda  menambahkan  jenis  fonta  tertentu
namun salah satu aplikasi tidak dapat menampilkan fonta yang ditambahkan tersebut secara
otomatis, maka Anda dapat menggunakan menu ini untuk menerapkan perubahan agar aplikasi
dapat menjalankan fonta yang telah ditambahkan. 
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Catatan:
• Ketika  menggunakan  submenu tampilan  direktori  berbentuk  Baris  (list),  Anda  dapat

mengatur kolom yang terlihat dan disembunyikan dengan cara klik  Visible Columns....,
kemudian  beri  atau  hilangkan  tanda  centang  kotak tertentu  pada  jendela  Kolom
Terlihat.

5.2.4.2. Menu Pilihan
Menu  ini  berisi  beberapa  menu  untuk  bekerja  pada  direktori,  misalnya;
untuk membuat Folder Baru, membuat Tab baru, membatalkan pembuatan
folder,  memilih  semua  berkas,  mengetik  lokasi pada  kotak  direktori  di
Tajuk,  dan  Penanda  suatu  lokasi yang  sering  dibuka.  Secara  garis  besar
menu yang tampil ketika Anda menekan tombol  Menu Pilihan isinya sama
dengan ketika Anda melakukan klik kanan.

5.2.5.  Hirarki Partisi 
Di BlankOn, Anda tidak akan mengenal istilah drive seperti pada Microsoft
Windows. Direktori paling atas yang ada di sistem adalah direktori/atau root
yang merupakan isi partisi sistem. Anda bisa membuka direktori sistem komputer melalui Lokasi
Lain => Komputer.

Di dalam direktori/terdapat berbagai subdirektori yang memiliki fungsi masing-masing, yaitu: 
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/bin 
• Direktori ini menyimpan binari atau program yang sangat penting untuk sistem. 

/boot
• Direktori ini menyimpan data-data yang diperlukan untuk melakukan booting sistem .

/cdrom
• Direktori ini merupakan titik kait/mount point jika Anda memasukkan CD/DVD-ROM. 

/dev
• Direktori ini menyimpan informasi yang bertautan dengan piranti keras yang terpasang

ke sistem.  Biasanya diperlukan untuk  merujuk  suatu lokasi  piranti keras  yang ada di
sistem. 

 /etc
• Direktori ini menyimpan konfigurasi sistem berbentuk berkas teks. 

/home
• Direktori ini menyimpan data-data yang dimiliki oleh pengguna non-administratif. 

/lib
• Direktori ini menyimpan pustaka sistem yang sangat penting. 

/media
• Direktori ini tempat untuk mengaitkan perangkat penyimpanan eksternal. 

/opt
• Direktori  ini  tempat untuk menyimpan berkas-berkas piranti lunak pihak ketiga misal

xampp, adobe reader. 

/sbin
• Direktori ini menyimpan binari atau program yang penting untuk melakukan administrasi

sistem. 

/tmp
• Direktori  ini  menyimpan  berkas-berkas  yang  bersifat  sementara.  Bila  Anda  sedang

memutar video streaming (youtube, dan lain-lain), berkas video yang dilihat tersimpan
disini. Jadi jika film yang Anda lihat sudah selesai, tinggal salin berkas ke direktori pilihan
Anda.  Ini  merupakan  keuntungan  menggunakan  BlankOn  melihat  youtube  sekaligus
mengunduhnya tanpa bantuan piranti lunak lain. 
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/usr
• Direktori  ini  menyimpan  berkas-berkas  pendukung  piranti  lunak  yang  terpasang  di

sistem.  Gambar  latar  (Wallpaper),  ikon,  atau  berkas  suara  yang  digunakan  sistem
tersimpan disini. 

/var
• Direktori  ini  menyimpan  berkas-berkas  yang  selalu  berubah  atau  variabel,  seperti

catatan sistem, surel pengguna, dan sebagainya. 

5.2.6.  Hak Akses Berkas dan Direktori 
Setiap berkas dan direktori  memiliki pemilik serta izin masing-masing. Tidak semua direktori
bisa diakses dan diubah oleh semua pengguna. Hal ini untuk menjaga kestabilan sistem dan
menghindari  pengguna  yang  ceroboh  atau  sengaja  untuk  merusak  sistem.  Pengguna  biasa
hanya bisa mengelola berkas di dalam direktori  /home/akunpengguna yang memang dimiliki
oleh pengguna bersangkutan. Anda bisa membukanya melalui Menu Utama  Blankon => Lokasi
=> Beranda. 

Selain direktori  tersebut,  pengguna harus mempunyai  izin khusus dari  administrator sistem.
Penamaan berkas  di  BlankOn juga sangat  berbeda dengan Microsoft Windows.  Di  BlankOn,
penamaan berkas memperhatikan huruf besar dan huruf kecil (case sensitive). Jadi, Anda bisa
membuat berbagai berkas dengan nama yang sama, tetapi dengan derajat huruf yang berbeda.
Contohnya,  Anda  bisa  membuat  berkas  Berkasku,  berkasKU,  berkasku,  berKASku,  dan
sebagainya dalam satu direktori tanpa ada konflik. 

Untuk membuka isi  partisi  selain partisi  sistem atau suatu media penyimpanan, partisi  yang
ingin Anda buka harus dikaitkan (mounting) ke suatu direktori (umumnya di bawah direktori
/media)  sehingga isi  dari  partisi  atau media penyimpanan tersebut  bisa dilihat  dan dikelola
hanya dengan membuka direktori tersebut.

Jika sedang menggunakan destop, Anda tidak perlu melakukan pengaitan secara manual setiap
ingin membuka isi media peyimpanan karena BlankOn sudah melakukannya untuk Anda. Anda
bisa melihat isi media penyimpanan melalui Menu Utama  BlankOn => Lokasi => Komputer. Hal
unik lainnya pada manajemen berkas di BlankOn adalah pengaturan hak aksesnya yang sangat
detail dan ketat.

Setiap berkas atau direktori yang ada di partisi BlankOn memiliki beberapa parameter mengenai
hak akses, yaitu: 

Pengguna pemilik berkas/direktori
Berisi identitas pengguna dari pemilik suatu berkas/direktori. 

Kelompok pemilik berkas/direktori
Berisi identitas kelompok yang memiliki suatu berkas/direktori. 
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Hak akses untuk pemilik
Berisikan hak apa saja yang boleh dilakukan oleh pengguna pemilik berkas/direktori terhadap
suatu berkas/direktori. 

Hak akses untuk kelompok
Berisikan hak apa saja yang boleh dilakukan oleh kelompok pemilik berkas/direktori terhadap
suatu berkas/direktori. 

Hak akses untuk yang lainnya, berisikan hak apa saja yang boleh dilakukan oleh pengguna selain
pemilik dan kelompok selain kelompok pemilik terhadap suatu berkas/direktori. Setiap objek
hak akses yang ada di atas memiliki tugas hak, yaitu:  Baca (Read), Tulis (Write),  dan Eksekusi
(eXecution). Setiap obyek hak akses juga bisa memiliki perpaduan hak yang berbeda, ada yang
bisa dibaca saja,  ada yang bisa dibaca dan dieksekusi  saja,  dan ada juga yang memiliki  hak
mutlak (baca, tulis dan eksekusi). 

Untuk mengatur hak akses dari berkas/direktori,  klik kanan pada berkas/direktori yang ingin
diubah hak aksesnya, lalu klik pada menu Properties. Pada jendela Properti, klik pada tab Hak
Akses. 

Berikut adalah penjelasan dari masing-masing pengaturan: 

Mengatur pemilik dari berkas/direktori
Yang hanya bisa mengatur pemilik dari suatu berkas/direktori adalah administrator. 
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Mengatur kelompok yang memiliki berkas/direktori
Yang bisa mengatur bagian ini adalah pemilik berkas/direktori tersebut. 

Mengatur hak apa saja yang bisa dilakukan oleh pemilik berkas. 

Mengatur hak apa saja yang bisa dilakukan oleh pengguna/kelompok pemilik berkas. 

Mengatur  hak  apa  saja  yang  bisa  dilakukan  oleh  pengguna  selain  pemilik  atau  anggota
kelompok. 

Jika Anda mengatur hak akses pada direktori beserta berkas yang terdapat di dalam direktori
tersebut, Anda dapat mengklik Terapkan Hak ke Berkas yang Disertakan. Bila sudah selesai, klik
tombol Tutup. 

5.2.7.  Mengakses Media Penyimpanan Lain 
Bila  Anda memasang flashdisk  atau harddisk  eksternal,  isi  flashdisk/harddisk  eksternal  akan
langsung terbuka. Demikian pula bila Anda memasukkan CD atau DVD yang berisi berkas non-
multimedia,  isi  CD atau DVD akan langsung terbuka.  Tetapi  jika BlankOn tidak membukanya
secara  otomatis,  Anda  dapat  membuka  media  penyimpanan  (flashdisk,  CD  atau  DVD  atau
eksternal harddisk) melalui direktori  Media Simpan lalu pilih media penyimpanan yang ingin
Anda buka isinya. Selain itu, Anda juga bisa memilih Direktori Komputer, kemudian  klik dua kali
pada media penyimpanan tersebut.

5.2.7.1. Mengeluarkan Media Simpan
Jika  Anda  telah  selesai  menggunakan  suatu  media  penyimpanan,  Anda  dapat  melepasnya
dengan mengklik  ikon di  sebelah kanan nama media penyimpanan di  bagian kiri  peramban
berkas, kemudian klik Keluarkan.
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5.2.8.  Kompres Berkas
Tujuan dari  mengompres Berkas adalah untuk mengelompokkan bebeberapa berkas/direktori
menjadi sebuah berkas untuk memudahkan proses pembuatan cadangan berkas. Tidak hanya
dikelompokkan, data juga akan diperkecil ukurannya sehingga sangat cocok untuk pertukaran
data. Untuk mengopres suatu berkas, pilih salah satu atau beberapa berkas/folder yang ingin
dikompres, lalu klik kanan dan pilih menu Kompres. 

Tentukan format, lokasi, dan format hasil kompres. Format hasil kompres yang didukung antara
lain:  7z, RAR, ZIP, TAR, TAR.GZ, dan lain-lain. Untuk melakukan pengaturan tambahan seperti
untuk menambahkan kata sandi, lakukan cara berikut; klik tanda segitiga kecil pada menu Opsi
Lain,  kemudian ketik  kata  sandi  Anda.  Setelah  semua pengaturan selesai,  klik  pada tombol
Buat. 

5.2.9.  Mencari berkas/direktori
Untuk mencari berkas/direktori yang tidak Anda ketahui tempatnya, Anda bisa menggunakan
fitur pencarian yang sudah terintegrasi dengan peramban berkas Nautilus. Berikut caranya; klik
Tombol  Cari pada  Tajuk.  Kemudian,  ketik  nama  berkas  yang  ingin  dicari  pada  kotak  yang
disediakan,  lalu  tekan  tombol  Enter.Untuk  mempermudah  pencarian  pada  berkas  tertentu,
Anda dapat menggunakan opsi tambahan yang tersedia dengan cara klik tanda  segitiga kecil
disebelah kanan kotak pencarian, pilih menu yang tersedia sesuai kebutuhan
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Jika menginginkan pencarian yang lebih detail, Anda bisa menggunakan fitur cari berkas melalui
Menu Utama  BlankOn => Aksesoris => Cari Berkas. Kemudian, ketik nama berkas yang ingin
dicari  pada kotak  Nama berisi,  dan lokasi  pencarian pada Cari  dalam folder => pilih folder
tertentu. Untuk lebih detail lagi, Anda bisa menambahkan opsi pencarian dengan memilih Pilih
pilihan lainnya dan  isi  opsi  yang disediakan.  Setelah  semua selesai,  klik  tombol  Cari untuk
melakukan pencarian.

5.3. Rincian 
Rincian  digunakan  untuk  melihat  berbagai  rincian  yang  ada  pada  komputer  Anda.  Seperti
menampilkan versi BlankOn,  spesifikasi perangkat komputer secara lengkap.

Untuk membuka Rincian dapat dilakukan dengan klik Menu Utama  BlankOn => Pengaturan =>
Sistem => Rincian. Terdapat beberapa menu pada jendela Rincian, yaitu;  Ringkasan, Aplikasi
Baku, dan Media Lepasan 

5.3.1.  Ringkasan
Menu ini berisi ringkasan versi BlankOn yang sedang terpasang dan spesifikasi komputer yang
sedang Anda gunakan saat  ini,  ringkasan terdiri  dari;  Nama perangkat,  Memori,  Processor,
Grafik, Sistem basis, dan Diska
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5.3.2.  Aplikasi Baku
Merupakan daftar aplikasi yang terpasang pada komputer untuk membuka suatu berkas secara
otomatis dengan cara klik dua kali. Misal Anda membuka suatu gambar bitmap, maka gambar
tersebut akan terbuka secara otomatis dengan  Penampil Citra. Anda dapat mengatur aplikasi
apa saja yang ingin Anda jadikan Aplikasi Baku dengan menu ini. Konsep dan cara kerja menu
ini sama dengan cara menangani jenis format tertentu dengan klik kanan berkas => Properti =>
pilih Aplikasi => Jadikan Bawaan.
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5.3.3.  Media Lepasan
Menu ini digunakan untuk  mengatur cara menangani suatu media. Menu Media Lepasan terdiri
dari: Audio CD, Video DVD, Pemutar Musik, Foto, dan Perangkat Lunak.

5.4. Akses Universal
Tujuan dari  Akses  Universal  adalah  untuk  menyediakan sekumpulan  pengaturan  sistem dan
aplikasi  pada  komputer  sebagai  alternatif  untuk  para  disabilitas atau  orang  yang  memiliki
keterbatasan  khusus  sehingga  mereka  tetap  dapat  menggunakan  komputer.  Berikut  cara
menggunakan Akses Universal:

Klik menu Menu Utama  BlankOn => Pengaturan => Sistem => Akses Universal. 

Menu Akses Universal terdiri dari 1 (satu) menu tunggal dan 4 (empat) kelompok menu, empat
kelompok menu terdiri dari: Penglihatan, Pendengaran, Mengetik, dan Menunjuk & Mengklik.
Pada setiap kelompok menu memiliki submenu lagi. 

5.4.1.  Menu Tunggal
Menu tunggal digunakan untuk mengktifkan Akses Universal secara otomatis ketika komputer
dinyalakan.
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5.4.2.  Penglihatan
Menu  pada  kelompok  ini  digunakan  untuk  mengatur  sistem  dan  aplikasi  pada  komputer
berdasarkan penglihatan.

5.4.2.1. Kontras Tinggi
Submenu ini  merupakan sebuah  pengaturan  pada  Akses  Universal  untuk  mengatur  kontras
pada layar komputer.  Ketika submenu ini  aktif  maka  Kontras warna dan pencahayaan pada
layar komputer menjadi paling maksimal.

5.4.2.2. Teks Besar
Submenu ini digunakan untuk mengatur  tampilan teks pada layar komputer.  Ketika submenu
ini aktif maka tampilan teks pada layar komputer menjadi besar.
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5.4.2.3. Zum
Submenu ini digunakan untuk mengatur besar-kecilnya  tampilan pada layar komputer. Anda
dapat mengatur besar-kecilnya tampilan dengan mengubah menu dan nilai yang tersedia pada
masing-masing Tab.

5.4.2.4. Pembaca Layar
Submenu ini digunakan untuk mengaktifkan atau mematikan fokus suara pembaca teks pada
layar.

5.4.2.5. Suara Tombol
Submenu ini  digunakan untuk mengaktifkan atau mematikan suara ketika tombol  Caps Lock
atau Num Lock ditekan 
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5.4.3.  Pedengaran
Menu  pada  kelompok  ini  digunakan  untuk  mengatur  sistem  dan  aplikasi  pada  komputer
berdasarkan pendengaran.

5.4.3.1. Peringatan Visual 
Pengaturan menu ini berfungsi sebagai suatu peringatan ketika sesuatu yang perlu diwaspadai.
Terdapat menu tombol pengujian flash di pojok kiri atas yang dapat digunakan untuk menguji
menu ini.  

Ketika menu ini diaktifkan, terdapat dua pilihan pada Peringatan Visual, yaitu Kedipkan judul
jendela dan Kedipkan seluruh layar.

Ketika  menggunakan  opsi  Kedipkan  judul,  maka  peringatan  hanya  dikedipkan  pada  judul
jendela.  Sedangkan  ketika  menggunakan  opsi  Kedipkan  seluruh  layar,  maka  peringatan
dikedipkan pada seluruh layar

5.4.4.  Mengetik
Menu pada kelompok ini digunakan untuk  mengatur efek dari tombol papan tik pada sistem
dan aplikasi ketika Anda mengetik.

5.4.4.1. Papan Tik Layar
Digunakan untuk menyalakan dan mematikan fitur aksesibilitas ketika menggunakan papan tik.
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5.4.4.2. Repeat Keys
Digunakan untuk mengatur jeda dan kecepatan ketika Anda menekan tombol secara berulang-
ulang.

5.4.4.3. Cursor Blinking
Cursor blikinng digunakan untuk mengatur tingkat kecepatan kursor pada komputer.

5.4.4.4. Bantuan Pengetikan
Digunakan untuk mengatur efek ketika menekan tombol pada papan tik dan menggeser kursor
menggunakan papan tik , submenu ini juga dilengkapi dengan panduan singkat cara mengatur
penggunaan menu Mengetik.

5.4.5.  Menunjuk dan Mengklik
Menu pada kelompok ini digunakan untuk mengatur efek penggunaan tetikus (mouse) ketika
menggerakkan kursor atau menekan tombol tertentu pada tetikus.
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5.4.5.1. Tombol Tetikus
Digunakan untuk  menyalakan dan mematikan fitur  aksesibilitas  ketika menggunakan Tetikus
(mouse)

5.4.5.2. Bantuan Klik
Digunakan untuk mengatur efek ketika menggerakkan kursor atau menekan tombol tertentu
pada tetikus, submenu ini juga dilengkapi dengan panduan singkat cara mengatur penggunaan
menu Menunjuk dan Mengklik.

5.4.5.3. Double-Click Delay
Submenu  ini  digunakan  untuk  mengatur  jeda  ketika  melakukan  klik  dua  kali  pada  tombol
mouse.
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BAB 6 APLIKASI INTERNET

eperti yang kita  ketahui  bahwa internet  telah menciptakan revolusi  yang sangat  tidak
terduga  dalam  dunia  teknologi,  informasi  maupun  komunikasi.  Kini,  Internet  menjadi
kebutuhan  yang  sangat  penting  bagi  setiap  orang  untuk  mengakses  informasi  atau

berkomunikasi dengan orang lain di seluruh penjuru dunia. Pengertian internet (interconnection
networking)  sendiri  adalah  jaringan  komunikasi  global  yang  terbuka  dan  menghubungkan
jutaan,  bahkan  milyaran  jaringan  komputer  dengan  berbagai  tipe  dan  jenis,  dengan
menggunakan tipe komunikasi seperti telepon, satelit dan lain sebagainya.

S
Pada masa kini biaya untuk jaringan Internet sudah tidak semahal seperti pada saat pertama
kali  diperkenalkan.  Bahkan,  beberapa  tempat  umum  menyediakan  jaringan  hotspot  yang
sebagian  besar  bersifat  gratis  agar  Anda  bisa  mengakses  internet  melalui  notebook  atau
perangkat  lain  yang  memiliki  fitur  Wi-Fi.  Untuk  memanfaatkan  jaringan  Internet,  BlankOn
menyediakan  berbagai  aplikasi  yang  siap  digunakan  untuk  kebutuhan  sehari-hari,  misalnya
sudah tersedia peramban web, klien e-mail atau surat elektronik dan pesan instan. 

6.1. Koneksi ke Jaringan Internet 
Ada berbagaimacam tipe koneksi ke internet, baik yang mengunakan kabel (wire) maupun yang
tanpa kabel (wireless).  Sebelum berselancar di dunia maya menggunakan BlankOn, tentunya
Anda  harus  menyambungkan  komputer  ke  jaringan  Internet  melalui  LAN,  Wi-Fi,  Modem
3G/HSDPA, atau Modem ADSL. 

6.1.1.  Melalui kabel LAN 
Pada  umumnya,  tempat-tempat  kerja  menyediakan  jaringan  Internet  melalui  jaringan  kabel
(wired). Untuk melakukan koneksi internet melalui kabel, cukup sambungkan kabel RJ-45 dari
jaringan LAN Anda ke LANCard atau NIC yang ada di komputer atau laptop Anda. Jika muncul
pesan bahwa sambungan sudah terjalin  pada area notifikasi,  berarti komputer  telah sukses
bergabung dengan jaringan tanpa masalah. 

isi kotak teks DNS Servers dengan nomor IP dari DNS Server di Internet, apabila ada lebih dari
satu DNS Server bisa menmbahkannya dengan dipisah tanda koma (“,”). Anda bisa menanyakan
bagaimana pengaturan jaringan di tempat Anda kepada administrator jaringan di tempat Anda. 

Beri tanda centang pada Tersedia untuk semua pengguna jika Anda menghendaki pengguna lain
dapat menyambung dengan jaringan ini. Anda akan ditanyakan password root. Masukkan saja
password root lalu klik Otentikasikan. Setelah semua pengaturan selesai, klik tombol Terapkan. 

Untuk melakukan koneksi melalui jaringan kabel degnan pengaturan jaringan yang baru dibuat,
klik pada ikon koneksi jaringan pada notifikasi destop. Pada bagian Jaringan Kabel, pilih nama
pengaturan jaringan Anda. Maka tidak lama kemudian akan muncul pesan bahwa jaringan telah
berhasil terjalin. 
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6.1.2.  Melalui hotspot atau Wireless LAN 
Saat  ini,  banyak  sekali  terdapat  tempat-tempat  umum  atau  perkantoran  yang  menerapkan
jaringan melalui teknologi wireless LAN atau yang sering dikenal dengan istilah hotspot. Dengan
jaringan seperti ini, tidak perlu lagi direpotkan dengan penggunaan kabel karena jaringan ini
menggunakan  gelombang  microwave seperti  jaringan  GSM  Handphone.  Untuk  melakukan
koneksi Internet melalui hotspot, sangat mudah sekali. Jika kartu jaringan tanpa kabel sudah
terdeteksi  dengan baik oleh BlankOn, cukup klik pada  ikon koneksi jaringan pada notifikasi,
kemudian pada bagian Jaringan Nirkabel, pilih nama jaringan hotspot yang akan dikoneksikan.
Tidak beberapa lama kemudian, koneksi akan langsung terjalin. 

Jika  ternyata  koneksi  tidak  terjalin,  mungkin  Anda  perlu  melakukan  penyetelan  konfigurasi
jaringan secara manual. Untuk melakukan hal ini, klik kanan pada ikon koneksi jaringan pada
area notifikasi, lalu klik menu Sunting sambungan. Buka Nirkabel, pada tab ini, klik pada nama
jaringan yang ingin  Anda atur  yang diawali  dengan teks  Auto,  lalu  klik  pada tombol  Ubah.
Selanjutnya buka tab Pengaturan IPv4. Pada tab ini, pilih opsi Atur Sendiri pada bagian method.
Kemudian,  klik  tombol  Tambah dan  isikan  Address,  Netmask,  dan  Gateway sesuai  dengan
pengaturan jaringan hotspot tersebut. Setelah semua pengaturan selesai, klik tombol Terapkan.
Sekarang, Anda bisa mengulangi melakukan koneksi kejaringan hotspot yang sudah Anda atur.
Maka tidak akan lama, koneksi akan terjalin. 
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6.1.3.  Melalui modem ADSL 
Saat  ini,  modem ADSL banyak digunakan untuk  keperluan Internet  melalui  jaringan telepon
PSTN. Penggunaan modem ADSL tidak serepot menggunakan ISP berbasis radio yang menjamur
saat ini, karena tidak perlu membangun tower yang tinggi. Cukup mengandalkan jaringan telpon
PSTN  yang  sudah  terpasang.  Biasanya,  modem  ADSL  yang  ada  saat  ini  sekaligus  berfungsi
sebagai router untuk jaringan. Anda cukup menyambungkan kabel LAN RJ-45 dari modem ADSL
ke  LAN  Card  pada  komputer,  maka  komputer  akan  langsung  melakukan  koneksi  terhadap
modem tersebut. Tidak akan lama, koneksi akan terjalin dan Anda bisa mulai ber-internet ria. 

6.1.4.  Melalui Mobile Broadband
Masukkan modem ke salah satu port di Komputer Anda, setelah modem dikenali oleh BlankOn
X Tambora, selanjutnya lakukan setting parameter kartu sesuai provider yang Anda gunakan.

Pertama-tama,  klik  ikon  koneksi  jaringan pada  notifikasi,  kemudian  centang  New  Mobile
Broadband conection. Atau dengan cara lain, yaitu klik Menu Utama  BlankOn => Preferensi =>
Pengaturan => Jaringan => Tambah sambungan baru,  pengaturan tersebut seperti tampilan
dibawah ini :

Langkah selanjutnya adalah, klik ikon Tambah sambungan baru maka akan tampil Sambungan
Data Seluler Baru (pada contoh pada buku ini menggunakan Modem Huawei), klik Next. 
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Pada jendela pengaturan  Daftar Negara atau  Pilih Wilayah,  pilih negara yang sesuai, karena
Anda berada di Indonesia maka pilih Indonesia, untuk memudahkan dan memepercepat proses
pencarian nama negara Indonesia tekan huruf  I  pada  papan tik, klik tombol Lanjut (Next)  di
pojok kanan atas untuk melanjutkan ke proses berikutnya.

Sekarang masuk ke bagian pemilihan nama  Operator selular yang Anda gunakan, pilih sesuai
dengan kartu yang terpasang pada modem (pada contoh dalam buku ini menggunakan kartu
Telkomsel), jika nama operator seluler tidak tersedia dalam pilihan,  klik I can’t find my provider
and i wish to enter it manualiy, tulis nama operator seluler yang Anda gunakan dengan cara
manual, klik Next. 
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Selanjutnya memilih planing paket data yang akan Anda gunakan, jika tidak tersedia pada daftar
planing khusus maka pilih Default, dan klik Next. 

Selanjutnya konfirmasi pengaturan jaringan Anda, jika masih ada kesalahan pada pengaturan
yang telah Anda lakukan, klik tombol  Back, namun jika pengaturan sudah benar, silakan klik
Apply. Setelah  itu akan muncul jendela permintaan Password untuk melakukan Dial-Up, ketik
password sesuai dengan kata sandi Anda.
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Jika koneksi jaringan anda berhasil, akan tampil notifikasi bahwa koneksi anda berhasil terjalin
dengan stabil, atau anda dapat juga melakukan pengecekan dengan mengklik ikon jaringan pada
notifikasi di destop. Selanjutnya anda dapat melakukan aktifitas internet, baik berselancar web
maupun aktifitas internet lain dengan satu syarat bahwa sinyal jaringan internet Anda berada
dalam kondisi baik.
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6.2. Peramban web Firefox
Tentunya dalam memanfaatkan jaringan internet untuk melakukan browsing atau meramban
halaman web ketika mencari  suatu  informasi  atau  keperluan lainnya membutuhkan sebuah
Peramban. Secara baku, pada BlankOn X Tambora sudah tersedia sebuah peramban web, yaitu
Mozilla Firefox (saat buku ini ditulis menggunakan versi 47.0.1). 

Mozilla Firefox adalah sebuah proyek browser open-source yang bertujuan untuk membangun
browser agar pengalaman berselancar bagi pengguna Internet lebih aman, lebih cepat dan lebih
stabil. 

Untuk membuka aplikasi  ini,  klik menu  Menu Utama  BlankOn => Internet => Firefox Web
Browser atau bisa Anda klik ikon Firefox pada menu favorit. 

Secara  baku,  Firefox  menggunakan  mensin  pencari  Google  Search.  Anda  dapat  mengubah
mesin pencari dengan mudah karena secara default sudah terpasang beberapa mesin pencari
lainya, seperti DuckDuckGo, Bing dan Yahoo.

Untuk  membuka  suatu  situs,  ketik  alamat  situs  yang  akan  Anda  buka  pada  Bar  Alamat.
Misalnya, untuk membuka situs resmi BlankOn, ketik  www.blankonlinux.or.id. Setelah alamat
selesai  diketik,  tekan  tombol  Enter untuk  memulai  membukanya.  Tunggu  sebentar  hingga
halaman situs terbuka. 

Firefox juga  dapat  Anda gunakan untuk  membuka berbagai  macam situs  dalam satu  waktu
secara  bersamaan.  Untuk  melakukan  hal  ini,  Anda  bisa  menambahkan  tab  baru dengan
melakukan klik tanda  + (tambah).  Semakin banyak tab yang Anda buka, maka akan semakin
banyak RAM komputer yang akan terpakai. Jika komputer terasa agak lambat, sebaiknya kurangi
tab yang sudah Anda buka.
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Untuk mencatat situs favorit, Anda bisa memanfaatkan fitur
Bookmark.  Jika  Anda  mengunjungi  beberapa  laman  web
secara rutin Anda dapat membuat bookmark untuk laman itu,
yaitu melalui tombol pada bilah bookmark yang memberikan
akses sekali klik ke laman yang diinginkan. 

Secara  default  Bookmark  belum  di  tampilkan  oleh  Firefox,
untuk  menampilkan  Bookmark  berikut  caranya,  klik  kanan
pada  Menu  Firefox,  kemudian  beri  tanda centang  pada
Bookmarks toolbar.

Cara  termudah untuk membuat  bookmark  laman adalah  dengan mengeklik  ikon  bintang di
samping  bilah alamat.  Balon yang mengonfirmasi  penambahan bookmark akan ditampilkan.
Berikut penjelasan singkat cara melakukan Bookmark: 

• Ubah nama bookmark pada bidang Nama. 

• Jika  tidak  diubah,  bookmark  disimpan  dalam
folder  bookmark  yang  terakhir  digunakan.
Gunakan  menu  Folder untuk  memilih  lokasi
penyimpanan bookmark. Jika tidak diubah, lima
folder  bookmark  yang terakhir  digunakan akan
muncul dalam menu. Jika folder yang diinginkan
tidak tercantum, gunakan Pilih folder lain untuk
membuka  kotak  dialog  Edit  Bookmark.
Bookmark akan ditempatkan dalam folder yang
terakhir  digunakan  secara  bawaan,  kecuali  jika
Anda memilih folder lain dalam menu. 
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• Klik Cancel untuk mengurungkan penambahan bookmark. 

6.3. Perpesanan Instan (IM) dengan Pidgin 
Untuk keperluan komunikasi  berbasis teks secara langsung atau chatting menggunakan fitur
perpesanan  instan  (Instant  Messanging),  BlankOn  menyediakan  aplikasi  bernama  Pidgin.
Aplikasi ini mendukung  IM dari berbagai protokol, antara lain  Yahoo! Messenger, AIM, Gtalk,
ICQ, IRC, MSN, Facebook, MySpace, dan berbagai protokol lainnya. 

Untuk membuka aplikasi ini, klik Menu Utama  Blankon => Internet => Pesan Internet Pidgin.
Maka jendela aplikasi Pidgin akan muncul beserta sebuah ikon yang berada di area notifikasi.
Untuk login menggunakan Pidgin, Anda harus terlebih dahulu mendaftarkan identitas akun IM
Anda pada Pidgin. Berikut caranya:

Klik tombol Akun, maka segera tampil jendela untuk mengatur akun yang akan Anda gunakan,
pada kotak  Protokol,  pilih  jenis Protokol yang akan digunakan (dalam contoh menggunakan
Google  Talk),  tulis  nama  akun  Anda pada  kotak  Namapengguna,  jangan  lupa  isikan  nama
domain  yang  Anda  gunakan  pada  kotak  Domain yang  tersedia,  selain  itu  Anda  juga  harus
mengisi kata sandi yang Anda miliki pada kotak Kata sandi, sedangkan pada kotak lainnya boleh
Anda kosongkan, setelah semua pengaturan selesai klik tombol Tambah.

Anda  bisa  mendaftarkan  banyak  akun  IM pada  Pidgin  serta  melakukan  login  pada
beberapa/semua akun tersebut secara bersamaan. Untuk login pada suatu akun,  beri  tanda
centang pada akun IM yang ingin Anda login. Kemudian, daftar nama teman akan muncul pada
jendela Daftar Teman. Sekarang, klik dua kali pada akun teman yang ingin Anda ajak ngobrol,
kemudian lakukanlah chatting dengan teman Anda tersebut.
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Untuk  mengatur  status  akun  IM,  Anda  bisa  memanfaatkan  pilihan  yang  terletak  di  bagian
bawah jendela  Daftar  Teman.  Status  ini  akan  muncul  pada daftar  teman dari  teman Anda.
Untuk menambahkan teman, klik menu  Teman => Tambah Teman. Lalu atur akun yang ingin
ditambahkan sebagai sebuah teman (jika login lebih dari satu akun), jangan lupa berikan nama
id akun Anda beserta deskripsinya. Kemudian, klik tombol Tambah Teman. 

Anda juga bisa melakukan percakapan tanpa perlu menambahkannya ke daftar teman dengan
klik menu Teman-teman => Kirim Pesan Baru, lalu ketik nama id akun teman yang ingin diajak
ngobrol.  Anda dapat  menyembunyikan  jendela  daftar  teman tanpa perlu  melakukan logout
dengan cara menutupnya. Daftar teman pada Pidgin bisa Anda buka kembali dengan klik ikon
Pidgin pada notifikasi di destop. Untuk benar-benar keluar dari Pidgin pada semua akun, klik
menu Teman => Keluar atau tekan tombol Ctrl+Q pada Papan Tik.

6.4. Surat Geary
Surat Geary adalah email client open source, Secara
default  Geary  yang  sudah  terpasang  di  BlankOn  X
Tambora adalah versi 0.11.1. Aplikasi ini dapat Anda
gunakan  untuk  melakukan  pengiriman  dan
penerimaan  surel.  Dengan  antarmuka  modern  dan
pengaturan akun surel yang mudah dan cepat, serta
kompatibel  dengan  surel  Gmail,  Yahoo!,  Mail,
Outlook.com,  dan  IMAP  server lainya.  Untuk
membuka aplikasi ini, klik Menu Utama  BlankOn =>
Internet => Surat Geary.

Setelah jendela Surat Geary terbuka isikan  email  Anda (pada contoh buku ini  menggunakan
akun  Gmail)  isikan  semua  keperluan  surel  Anda  yaitu:  Nama,  Alamat  surel,  dan  Sandi.
Selanjutnya klik tombol Tambah.
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Maka  selanjutnya  jendela  Geary terbuka  dan  Anda  sudah  dapat  melakukan  aktifitas  email
dengan Surat Geary. Jika Anda akan membuat email baru, dapat memulainya dengan klik ikon
membuat email di bilah sebelah kiri atas, maka akan muncul bilah membuat email baru di bilah
kanan. Dan jika akan melihat folder lain seperti  Pesan Terkirim atau yang lain ada pada bilah
sebelah kiri, sedangkan bilah tengah adalah daftar email.

6.5. Corebird
Twitter  adalah  layanan  jejaring  sosial dan
mikroblog daring yang  memungkinkan  Anda
untuk  mengirim  dan  membaca  pesan  berbasis
teks  hingga  140  karakter,  yang  dikenal  dengan
sebutan  kicauan  (tweet).  Twitter  mengalami
pertumbuhan  yang  pesat  dan  dengan  cepat
meraih popularitas di seluruh dunia. 

Secara  default  di  BlankOn  X  Tambora  sudah
terinstall  Twitter  client yaitu  Corebird. Menu
yang  tersedia  pada  Corebird adalah  Home,
Mentions,  Favorites,  Direct  Messages,  Lists,
Filters,  dan  Search.  Corbird  juga  mendukung
multi akun.

Untuk membuka aplikasi ini, klik  Menu Utama  BlankOn => Internet => Corebird. Maka akan
membuka jendela Corebird, dan jika Anda belum pernah melakukan login, maka Corebird akan
meminta PIN. 
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Untuk mendapatkan PIN,   klik tombol  Permintaan PIN, maka secara otomatis akan membuka
jendela baru di  peramban web. Isikan username dan  password Twitter akun Anda kemudian
klik Izinkan Aplikasi. Setelah itu akan muncul PIN yang diberikan oleh aplikasi tersebut. Langkah
selanjutnya ketikan PIN tersebut pada aplikasi Corebird dan klik  Konfirmasi. Maka selanjutnya
Anda akan di bawa ke jendela Corebird.

6.6. Akun Daring
Akun Daring digunakan untuk mengelola akun pribadi yang Anda miliki dalam menggunakan
internet, misalnya; akun Google, ownCloud, Facebook,Pocket,Foursquare, Facebook, dan lain-
lain.  Anda dapat menambah dan menghapus akun daring yang berhubungan dengan profile
pengguna secara mudah menggunakan fitur ini.

Untuk  mengatur  Akun  Daring  dapat  dilakuan  dengan  cara  klik  Menu  Utama   BlankOn  =>
Preferensi  =>  Pengaturan  =>  Pribadi  =>  Akun  Daring,  maka  segera  tampil  jendela  untuk
mengatur Akun Daring
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6.6.1.  Menambah Akun
Klik tombol Tambah akun daring. Pastikan, Anda terhubung dengan internet.

Pilih salah satu akun, Google, ownCloud, Facebook, Flickr, Akun Microsoft, Pocket, Foursquare,
Microsoft Exchange, atau akun daring lainnya.

Misalnya Anda pilih Facebook, maka secara otomatis akan tampil jendela untuk masuk ke akun
Facebook Anda. Masukkan data login Anda pada Facebook, kemudian klik tombol Masuk.

Pada jendela yang tampil klik tombol Lanjutkan sebagai ....

Langkah selanjutnya adalah, memasukkan  sandi ring kunci,  bila berhasil,  pada jendela  Akun
Daring akan muncul daftar akun daring yang sudah Anda masukkan. Anda dapat mengatur ijin
penggunaan akun daring tersebut untuk beberapa aplikasi dan layanan daring.

Untuk menambahkan akun daring, Anda juga dapat mengklik ikon tanda  tambah pada  pojok
kiri bawah jendela Akun Daring.
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6.6.2.  Menghapus Akun
Untuk menghaapus akun, lakukan langkah berikut; pilih akun daring yang akan dihapus, klik ikon
tanda  minus (-) di  pojok kiri bawah sehingga muncul kotak dialog konfirmasi, kemudian klik
tombol Hapus.

6.6.2.1. Mengapa Perlu Akun Daring Destop?
Dengan Akun Daring Anda dapat membawa layanan pilihan seperti kalender, obrolan, dan surel
ke destop sehingga dapat dengan mudah tetap terhubung dengan layanan-layanan dari akun
yang berbeda pada waktu yang bersamaan.

Anda cukup mengatur akun daring sekali saja, dan setiap kali Anda menghidupkan komputer,
semua akun tersebut siap digunakan.

6.6.2.2. Daftar Layanan dan Aplikasi Daring
Berikut beberapa layanan yang tersedia pada Akun Daring

Kalender
Dengan aplikasi  kalender Anda dapat mencatat dan mengelolal  acara/agenda pada kalender
daring.  Aplikasi  kalender  yang  terpasang  sejak  awal  pada  BlankOn  Linux  Tambora  adalah
California.

Obrolan/Chat
Dengan  aplikasi  obrolan  Anda  dapat  ngobrol/chating  dengan  kontak-kontak  Anda.  Aplikasi
obrolan yang terpasang pada BlankOn Linux Tambora sejak awal adalah Pidgin.

Kontak
Dengan aplikasi kontak, seperti  Contacts dan Evolution Anda dapat mempublikasikan rincian
kontak. 

 Aplikasi Internet



87

Dokumen
Dengan layanan dokumen daring Anda dapat melilhat dokumen daring Anda seperti Google
docs.

Berkas
Dengan layanan berkas daring Anda dapat menambahkan lokasi berkas jauh.

Surel
Dengan aplikasi surel Anda dapat mengirim dan menerima surel. Aplikasi surel yang terpasang
pada BlankOn Linux Tambora sejak awal adalah Geary.

Foto
Dengan layanan foto Anda dapat melihat foto daring Anda, misalnyanya foto yang telah Anda
unggah pada Facebook.

Pencetak/printer
Dengan layanan pencetak Anda dapat mengirim salinan PDF pada provider dari kotak dialog
mencetak.  Provider  mungkin  menyediakan  layanan  cetak  atau  hanya  melayani  sebagai
penyimpan PDF yang dapat Anda unduh dan cetak pada lain waktu.

Baca Nanti/Read Later
Dengan layanan Baca Nanti Anda dapat menyimpan halaman web pada layanan luar sehingga
Anda dapat membacanya pada lain waktu dan pada perangkat yang lain. Saat ini belum ada
aplikasi yang menggunakan layanan ini.
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BAB 7 APLIKASI PERKANTORAN

ntuk kebutuhan perkantoran, BlankOn menyediakan sebuah paket aplikasi perkantoran
yang  bernama LibreOffice.  LibreOffice  merupakan  aplikasi  perkantoran  open  source
yang dapat digunakan dengan bebas dan didapatkan secara gratis. Penggunaan aplikasi

ini sangat mirip dengan Microsoft Office 2003, sehingga ramah terhadap pengguna yang sudah
terbiasa menggunakan aplikasi tersebut. Pada bab ini, dijelaskan mengenai penggunaan paket
aplikasi  perkantoran  LibreOffice  untuk  keperluan  pengolahan  kata,  pengolahan  sheet  dan
presentasi. Diharapkan dengan membaca bab ini, Anda mampu menggunakan aplikasi-aplikasi
tersebut  untuk  berproduktivitas.  Satu  kelebihan  BlankOn:  LibreOffice  sudah  berbahasa
Indonesia. 

U

7.1. Pengolah kata LibreOffice Writer 
LibreOffice Writer merupakan aplikasi pengolah kata yang merupakan bagian dari paket aplikasi
perkantoran  LibreOffice.  Fitur  dan  penggunaan  aplikasi  ini  sangat  mirip  dan  setara  dengan
Microsoft Word.  Dalam subbab ini,  dijelaskan mengenai  pengenalan  dan sedikit  penjelasan
mengenai LibreOffice Writer. 

Untuk membuka aplikasi ini, klik Menu Utama  BlankOn => Perkantoran => LibreOffice Writer.
Pada  saat  pertama  kali  dibuka,  Anda  akan  melihat  sebuah  kertas  kosong  yang  siap  Anda
gunakan untuk keperluan pengolahan kata.

Jika Anda ingin membuka dokumen yang telah tersimpan, Anda bisa klik menu Berkas => Buka
atau tekan  Ctrl+O pada  Papan Tik, kemudian  lakukan pencarian di direktori komputer Anda,
setelah itu klik Buka.

 Aplikasi Perkantoran

Gambar 14: Tampilan LibreOffice ketika sedang dijalankan



90

Berikut adalah format dokumen yang didukung oleh LibreOffice Writer: 

• Open Document Text (Format default yang telah menjadi standar ISO) 

• OpenOffice.org 1.x 

• Microsoft Word 97/2000/XP/2003 

• Microsoft Word 2007 

• Rich Text Format 

• HTML Document 

• Docbook XML 
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7.1.1.  Pengenalan Antarmuka 
Seperti yang dijelaskan sebelumnya, antarmuka dari LibreOffice Writer mirip dengan aplikasi
Microsoft Word 2003. Berikut adalah penjelasan dari masing-masing bagian di dalam aplikasi
ini: 

Nama Berkas:   merupakan nama dan jenis halaman yang sedang aktif, pada saat pertama kali
LibreOffice Writer dijalankan bertuliskan  Tidak Berjudul 1 - LibreOffice Writer,  Nama Berkas
kadang disebut Title Bar.

Baris Menu: menampilkan daftar perintah yang bisa digunakan berupa menu. 

Baris alat standar: menampilkan ikon-ikon yang merupakan perintah utama dan esensial dalam
bekerja di LibreOffice Writer, seperti perintah membuat dokumen baru, membuka dokumen,
menyimpan, mencetak, membatalkan perintah terakhir, menyalin, dsb. 

Baris  Alat  Pemformatan: menampilkan ikon-ikon serta pengaturan untuk melakukan format
dokumen, seperti pengaturan fonta, jenis huruf, perataan teks, penomoran, dsb. 

Penggaris  atau Ruler:  merupakan alat  bantu untuk mengukur panjang kertas,  margin,  serta
jarak tabulasi. 

Baris status, menampilkan status yang sedang dikerjakan pada Halman Libre Office Writer.
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Penggulung  Layar  atau  Scrollbar:  digunakan  untuk  menggulung  tampilan  turun  atau  naik
(vertikal) dan ke kiri atau ke kanan (horisontal). 

Selain baris alat yang ada, Anda juga bisa menambahkan beberapa baris alat lainnya melalui
menu  Tampilan => Baris alat > Baris alat  yang ingin ditambahkan. Setiap baris alat memiliki
fungsi  masing-masing  dan sangat  membantu  mempercepat  Anda  dalam  bekerja.  Walaupun
fiturnya setara dan antarmukanya mirip dengan Microsoft Word. Namun ada beberapa perintah
di LibreOffice yang letaknya berbeda. Berikut adalah perbedaan letak menu antara Word 2003
dengan Writer: 

Microsoft Word LibreOffice Writer 

File => Page Setup Format => Halaman 

Format Font Format => Karakter 

Format => Border and Shading Format => Halaman => Garis tepi 

Format => Tabs Format => Paragraf => Tab 

Format => Drop Cap Format => Paragraf => Alur Teks 
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Perlu  sedikit  pembiasaan diri  dan  kesabaran  untuk  melatih diri  agar  terbiasa  menggunakan
LibreOffice jika Anda belum terbiasa, lakukan dengan mencoba-coba mengerjakan suatu naskah
menggunakan LibreOffice jika tidak dalam keadaan sangat penting. 

7.1.2.  Mengubah Inch menjadi Centimeter 
Biasanya  pada  komputer  yang  memakai  Antarmuka  berbahasa  Inggris,  ukuran  Penggaris,
halaman (kertas),  kotak  pada table,  dan lain-lain,  menggunakan ukuran  Inchi,  maka dengan
tetap mepertahankan penggunakan ukuran Inchi akan mempersulit penyutingan dokumen yang
dibuat, karena Anda sudah terbiasa menggunakan ukuran Sentimeter, untuk mengubah ukuran
Inchi ke  Sentimeter lakukan langkah berikut: klik  Perkakas => Opsi, karena dalam contoh ini
aplikasi perkantoran yang sedang digunakan adalah LibreOffice Writer, maka arahkan kursor ke
menu  LibreOffice  Writer klik  tombol  panah  yang  mengarah  ke  bawah untuk  membuka
submenu yang disediakan, klik  Umum => Pengaturan => Unit Pengukuran, ubah ukuran  Inch
menjadi Sentimeter kemudian klik Ok. 

7.1.3.  Bekerja dengan Writer 
Sebelum mengetik isi dokumen, Anda perlu mengatur terlebih dahulu halaman pada dokumen,
pengaturan meliputi  ukuran kertas dan  margin.  Berikut  cara  mengatur  halaman,  klik  menu
Format => Halaman. 
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7.1.3.1. Mengatur Halaman 
Kemudian, klik tab Halaman dan aturlah ukuran kertas serta orientasi dokumen yang diinginkan
pada pengaturan  Format, sedangkan untuk pengaturan margin (jarak batas pinggir halaman),
aturlah pada pengaturan Margin. Setelah pengaturan selesai, klik tombol Oke.

Sekarang, Anda bisa mengetik dan mengedit isi dokumen Anda. Untuk mempercepat waktu,
Anda bisa gunakan Tombol Pintas pada Papan Tik berikut ini untuk melakukan penyuntingan.
Penggunaan Tombol Pintas akan meminimalisasi penggunaan Tetikus. 

Fungsi Tombol Pintas

Memblok (memilih) teks Shift+tanda panah 
kiri/kanan 

Copy (menyalin) Ctrl+C 

Cut (memotong) Ctrl+X 

Paste (menempel apa yang disalin/dipotong) Ctrl+V 

Blok semua Ctrl+A 

Undo (batalkan) Ctrl+Z 

Redo (kembalikan apa yang dibatalkan dengan perintah Undo) Ctrl+Y 
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Agar dokumen Anda buat lebih menarik, tentunya perlu dilakukan pemformatan pada dokumen
tersebut  sehingga lebih cantik,  elegan dan profesional.  Untuk melakukan hal  ini,  Anda bisa
memblok  teks  yang  ingin  diformat  lalu  memanfaatkan  alat  pemformatan  yang  terdapat  di
bagian atas penggaris. Selain itu, Anda juga bisa memanfaatkan berbagai Tombol Pintas, berikut
ini beberapa tombol pintas yang dapat digunakan: 

Fungsi Tombol Pintas 

Bold (menebalkan) Ctrl+B 

Italic (miring) Ctrl+I 

Underline (bergaris bawah) Ctrl+U 

Double underline (garis bawah ganda) Ctrl+D 

Hilangkan format Ctrl+0 

Heading 1-5 Ctrl+1-5 

Rata kiri Ctrl+L 

Rata kanan Ctrl+R 

Rata kiri-kanan Ctrl+J 

Subscript Ctrl+Shift+B 

Superscript Ctrl+Shift+P 

7.1.4.  Gaya Dan Pemformatan 
Untuk  mengelola  berbagai  jenis  gaya  pemformatan,  Anda
bisa memanfaatkan fitur  Gaya dan Pemformatan  yang bisa
Anda akses melalui menu  Gaya. Melalui fitur ini, Anda bisa
mengatur berbagai pemformatan untuk Gaya Paragraf, Gaya
Karakter,  Gaya Bingkai,  Gaya Halaman, dan Gaya Senarai.
Anda  dapat  menggunakan  berbagai  menu  pada  Gaya  dan
Pemformatan  untuk  mengelola  dokumen yang dibuat,  dari
yang  sederhana  hingga  yang  rumit  sekalipun.  Untuk
mengaktifkan Gaya dan Pemformatan dapat  juga dilakukan
dengan menekan tombol F11 pada papan tik.
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7.1.5.  Baris Alat Menggambar 
Jika Anda ingin menggambar bentuk atau objek lainnya, Anda bisa memanfaatkan  Baris Alat
Menggambar, untuk menampilkannya dapat dilakukan dengan klik Tampilan => Bilah Alat =>
Menggambar. Sama seperti toolbar drawing di Microsoft Word, di sini Anda bisa menggambar
suatu bentuk, menyisipkan gambar, mengatur bayangan dan 3D pada objek. 

Untuk menyimpan hasil  pekerjaan anda,  klik menu  Berkas => Simpan.  Lalu, tentukan lokasi
penyimpanan berkas serta format berkas yang diinginkan. Kemudian, klik tombol Simpan. Anda
juga bisa menyimpan hasil pekerjaan Anda dengan menekan tombol Ctrl+S pada Papan Tik. 

7.1.6.  Membuat tabel 
Untuk  membuat  tabel,  lakukan  cara  berikut;  klik
menu  Tabel  =>  Sisip  Tabel atau  tekan  tombol
Ctrl+F12 pada Papan Tik. Kemudian, tentukan jumlah
baris pada pengaturan Baris dan jumlah kolom pada
pengaturan  Kolom. Jika ingin membuat judul kolom
berulang  saat  berganti  halaman,  Anda  bisa  beri
centang pada Tajuk dan Ulangi tajuk, setelah itu, klik
tombol Oke.

7.1.6.1. Menambah Baris atau Kolom 
Jika  ingin  menambah  baris  atau  kolom  baru  pada
tabel,  Anda bisa  klik  kanan pada baris/kolom yang
ingin  disisipi,  lalu  klik  menu Baris  atau  Kolom  =>
Sisip. Kemudian,  tentukan jumlah baris/kolom yang
ingin  ditambahkan  serta  posisi  disisipinya
baris/kolom baru tersebut.

Selain klik kanan, Anda bisa menambahkannya lewat
menu  Tabel  =>  Sisip  =>  Baris/Kolom.  Kemudian,
tentukan jumlah baris/kolom yang ingin ditambahkan serta posisi disisipinya baris/kolom baru
tersebut . Setelah itu, klik tombol Oke. 

Mungkin Anda perlu menggabungkan beberapa bagian sel  pada tabel,  untuk melakukannya,
blok pada sel yang ingin digabung lalu  klik kanan dan pilih menu Sel => Gabung. Atau dapat
menggunakan menu Tabel => Gabung sel. Sedangkan untuk memecah sel, klik kanan pada sel
yang ingin dipecah lalu pilih menu Sel => Pisah. Kemudian, tentukan jumlah baris/kolom hasil
pisahan sel tersebut, dan terakhir klik tombol  Oke. Atau dapat menggunakan menu  Tabel =>
Bagi sel. Kemudian, tentukan jumlah baris/kolom hasil pisahan sel tersebut, dan terakhir klik
tombol Oke.
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7.2. Pengolah lembar kerja LibreOffice Calc 
Untuk membuat suatu lembar kerja, Anda bisa menggunakan aplikasi LibreOffice Calc. Aplikasi
ini sangat mirip dan memiliki fitur yang setara dengan padanannya, Microsoft Excel. Aplikasi ini
juga sangat kompatibel dengan berkas yang dibuat dengan Microsoft Excel. 

7.2.1.  Memulai bekerja 
Untuk  membuka  LibreOffice  Calc,  klik  menu  Menu  Utama   BlankOn  =>  Perkantoran  =>
LibreOffice Calc. Beberapa detik kemudian, Anda akan melihat jendela aplikasi LibreOffice Calc
yang sangat mirip dengan aplikasi Microsoft Excel 2003. Untuk membuka suatu lembar kerja,
klik menu Berkas => Buka. Berikut adalah format file yang didukung oleh LibreOffice Calc: 

• Open Document Spreadsheet (format Default yang telah menjadi standar ISO) 

• Microsoft Excel 97/2000/XP, 

• Microsoft Excel 2007 

Antarmuka LibreOffice memiliki beberapa bagian, yaitu (dari atas ke bawah): 

1. Baris Nama, Merupakan Nama dan jenis Berkas yang sedang Aktif. 

2. Baris Menu, menampilkan daftar perintah untuk bekerja

3. Baris alat standar, berisikan ikon-ikon perintah utama untuk LibreOffice Calc. 
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4. Baris  alat  pemformatan,  berisikan  ikon-ikon  serta  pengaturan  untuk  melakukan
formatting pada lembar kerja. 

5. Baris formula, berfungsi untuk mengatur formula/rumus pada setiap sel. 

6. Bagian utama, disinilah Anda bekerja untuk membuat lembaran kerja/worksheet. 

7. Navigasi lembar kerja, berfungsi untuk berpindah dari suatu sheet ke sheet yang lainnya
dalam satu buku kerja. 

8. Baris Status,berisi kolom-kolom yang menampilkan berbagai status dari area kerja

Selain  baris  alat  tersebut,  Anda  juga  bisa  menambahkan  baris  alat  lainnya  melalui  menu
Tampilan => Baris alat => Baris alat yang ingin ditambahkan. Setiap baris alat memiliki fungsi
masing-masing dan berguna sekali untuk mempercepat pengerjaan lembar kerja. 

7.2.2.  Bekerja dengan Calc 
Pertama kali dalam membuat lembar kerja, Anda harus membuat terlebih dahulu judul kolom
data pada baris pertama. Jika dibutuhkan, Anda bisa menggabungkan beberapa sel dengan cara
membloknya, lalu memilih menu Format => Gabung Sel => Gabung Sel.

Agar  judul  kolom/baris  selalu  muncul  pada  setiap  halaman  yang  akan  dicetak,  Anda  bisa
mengatur area pencetakan melalui menu Format => Jangkauan Cetak => Sunting. Kemudian, isi
jangkauan  dari  judul  kolom/baris  pada  bagian  Kolom/Baris untuk  diulang.  Anda  bisa  klik
tombol di sebelah kanan kotak teks untuk membantu memilih jangkauan yang diinginkan. 
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7.2.3.  Penggunaan Rumus
Setelah pembuatan judul kolom selesai, Anda bisa mengisi setiap kolom dengan data yang ingin
Anda buat. Anda bisa tekan tombol CTRL+ F2 untuk mengisi sel yang dipilih. 

Untuk  membuat  suatu  data  lebih
dinamis,  Anda  bisa  memanfaatkan
rumus-rumus  atau  formula  yang
tersedia sangat banyak di Calc. Jika
Anda  belum  terbiasa  mengetikkan
rumus  secara  langsung,  Anda  bisa
klik ikon Kategori pada baris Fungsi
dan  mengikuti  arahan  yang
diberikan.  Rumus-rumus  yang
dapat  Anda  gunakan  antara  lain
rumus  perhitungan,  statistika,
finansial,  tanggal  dan  waktu,
logika,  matematika,  dan  masih
banyak lagi.

Untuk  memformat  sel  agar  lebih
menarik,  Anda  bisa  blok  sel  yang  ingin  diformat,  lalu  manfaatkan  berbagai  perintah
pemformatan yang terdapat di baris alat pemformatan (di atas baris formula). Selain itu, Anda
bisa memanfaatkan pengaturan sel yang bisa Anda akses melalui menu Format => Sel.
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Tombol Pintas pada  Papan Tik untuk pemformatan yang dijelaskan pada penjelasan tentang
LibreOffice Writer juga bisa Anda manfaatkan. 

Jika Anda ingin menyisipkan suatu baris/kolom di antara baris/kolom yang sudah diisi, Anda bisa
klik  kanan pada  nomor  baris/kolom,  lalu  klik  menu  Sisip  Baris/Kolom.  Anda  bisa
memanfaatkan seluas-luasnya jumlah sel yang sangat banyak untuk keperluan pembuatan data. 

Untuk memisahkan setiap lembar kerja, Anda bisa memanfaatkan fitur Lembar Kerja pada Calc.
Secara baku, terdapat Satu Lembar Kerja yang bisa Anda gunakan untuk membuat buku kerja,
namun  Anda dapat  menambahkan lembar kerja baru dengan cara menekan  tanda + pada
Navigasi lembar kerja.

Cara lain untuk menambah lembar baru, dapat dilakukan dengan cara klik kanan lembar kerja
yang sudah ada, lalu memilih menu Sisip Lembar Kerja..., tentukan letak lembar kerja yang akan
ditambahkan, apkah sebelaum atau sesudah lembar kerja yang sudah ada, selanjutnya klik  Oke.
Sebaliknya, jika Anda ingin menghapus suatu lembar, klik pada lembar yang ingin Anda hapus,
lalu klik menu Hapus. 

Selain  itu,  Anda  juga  dapat  mengubah  nama  ,  memindah,  menyalin,  memberi  warna,
menyembunyikan, melindungi lemabr kerja, dan lain-lain.

Salah satu fitur menarik yang terdapat di Calc untuk membantu pengolahan data adalah fitur
pengurutan. Dengan fitur ini, Anda bisa mengurutkan data  sehingga lebih runtun dan berurut.
Untuk menggunakan fitur ini, blok pada data yang ingin diurut dan klik menu Data => Urutkan.
Lalu atur skema pengurutan sesuai dengan keinginan Anda. 
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Untuk menyimpan buku kerja yang Anda buat, klik menu  Berkas => Simpan.  Lalu, tentukan
lokasi penyimpanan berkas serta format berkas yang diinginkan. Kemudian, klik tombol Simpan.
Anda juga bisa menyimpan hasil pekerjaan Anda dengan menekan tombol  Ctrl+S pada Papan
Tik. 

7.2.4.  Membuat Bagan
Bagan adalah, gambaran untuk memperlihatkan atau menerangkan sesuatu data atau informasi
yang disampaikan  melalui  sebuah gambar. Bagan mempunyai bentuk yang beragam, antara
lain: diagram lingkaran, garis,  pohon, dan batang,  dan lain-lain. Bagan dalam Bahasa Inggris
disebut Diagram atau Chart.

Di  LibreOffice  Calc  juga  sudah  tersdia  fitur  untuk  membuat  bagan  sehingga  Anda  dapat
membuat bagan lebih mudah. 

7.2.4.1. Membuat Data
Sebelum membuat bagan, Anda harus menyiapkan data tertentu untuk diberi baga, misalnya
seperti data di bawah ini. 

Sorot dan blok isi C3:E5,  arahkan kursor ke Baris menu, klik Sisip => Bagan, atau klik ikon Bagan
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7.2.4.2. Memilih Jenis Bagan
Pilihlah jenis bagan pada bagian kiri serta kanan, Centang penampilan 3D jika tampilan bagan
ingin dibuat 3 dimensi, kemudian klik tombol Lanjut. 

7.2.4.3. Jangakauan Data
Pada kotak teks Jangkauan Data, tentukan sel data yang akan dijadikan sumber data, klik ikon di
sebelah  kanan  kotak  teks,  lalu  blok  sel  yang  diinginkan  kemudian  tekan  Enter,  kemudian
tentukan urutan data dengan memilih opsi  Seri data pada baris jika data ada di setiap baris
(memanjang ke kanan), atau Seri data pada kolom, jika data ada di setiap kolom (memanjang ke
bawah) Setelah selesai, klik tombol Lanjut. 
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7.2.4.4. Rangkaian Data
Langkah ketiga, mengatur  Rangkaian Data, pada menu ini Anda dapat melakukan pengaturan
bagan secara manual, namun jika tidak mau membuat pengaturan secara manual, langsung klik
tombol Lanjut.

7.2.4.5. Membuat Judul Bagan
Langkah terakhir, tentukan judul Bagan beserta pengaturan lainnya, misalnya judul bagan, sub
judul, dan keterangan lainnya, jika semuanya dirasa sudah cukup klik Selesai

Sekarang bagan sudah selesai dibuat, namun hasilnya masih kurang bagus, lakukan pengaturan
secara manual pada bagan, misalnya diperkecil  ukurannya, ditambahkan latar belakang, atau
diberi keterangan lain, contohnya seperti gambar di bawah ini
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7.3. Presentasi dengan LibreOffice Impress 
Untuk  keperluan  membuat  presentasi  professional,  BlankOn  menyediakan  aplikasi  bernama
LibreOffice  Impress.  Aplikasi  ini  memiliki  fitur  yang  lengkap  untuk  keperluan  membuat
presentasi  dan tampilannya pun mirip dengan  Microsoft PowerPoint 2003.  Pada subbab ini,
dijelaskan mengenai pengenalan aplikasi presentasi LibreOffice Impress serta penjelasan singkat
mengenai aplikasi ini. 

7.3.1.  Mulai bekerja 
Untuk membuka LibreOffice Impress, klik Menu Utama  BlankOn => Perkantoran => LibreOffice
Impress. Anda bisa langsung bekerja dengan Impress mulai dari nol, sedangkan jika Anda ingin
membuka berkas presentasi yang sudah ada, klik pada Berkas => Buka,  kemudain pilih berkas
presentasi yang ingin dibuka. 

LibreOffice Impress mendukung berbagai format, antara lain: 

• Open Document Presentation (format default) 

• Microsoft PowerPoint? 97/2000/XP/2003 

• Microsoft PowerPoint? 2007 

• LibreOffice Impress 1.0 
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7.3.2.  Pengenalan antarmuka 
Bagi  yang  sudah  pernah  membuat  presentasi,  antarmuka  Impress  tidak  akan  sangat  asing.
Berikut adalah bagian-bagian dari antarmuka LibreOffice Impress: 

1. Baris Nama, Merupakan Nama dan jenis Berkas yang sedang Aktif. 

2. Baris Menu, menampilkan daftar perintah Impress berupa menu. 

3. Baris Alat Standar, menampilkan ikon-ikon perintah esensial untuk dokumen Anda. 

4. Baris  Alat  Pemformatan,  menampilkan  ikon-ikon  atau  pengaturan  untuk  melakukan
pemformatan objek yang Anda pilih dalam presentasi. 

5. Daftar Slide, menampilkan slide yang terdapat dalam presentasi yang Anda buat. 

6. Bagian Utama, menampilkan dan mengedit isi suatu slide. 

7. Panel Tugas, berisi berbagai macam pengaturan yang membantu Anda dalam mengatur
presentasi. Seperti pengaturan tata letak (layout ), palet (template), animasi, dsb.  

8. Baris Status, berisi kolom-kolom yang menampilkan berbagai status dari area kerja. 
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Anda bisa menambahkan berbagai baris alat tambahan sesuai keperluan dengan cara klik Menu
Bar => Tampilan => Bilah sisi => bilah sisi yang ingin ditambahkan. 

7.3.3.  Bekerja dengan Impress 
Membuat suatu slide presentasi dengan LibreOffice Impress bisa dilakukan langkah per langkah,
sehingga Anda bisa sangat mudah membuat suatu presentasi. Sebelum mengerjakan isi slide,
Anda terlebih dahulu dapat memilih tema dari slide Anda melalui pengaturan Halaman Induk
(master page) pada bagian panel tugas. Jika palet terasa kurang, Anda bisa memasang berbagai
palet tambahan melalui add-ons yang tersedia di situs  http://www.LibreOffice.
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Tata letak atau layout pada suatu slide bisa Anda buat sendiri dengan memanfaatkan Baris Alat
Menggambar, atau dengan menggunakan layout yang sudah ada melalui pengaturan Tata Letak
pada panel tugas. Tentukan tata letak sesuai keinginan, dan isilah slide Anda.

Untuk membuat presentasi lebih menarik, Anda bisa menambahkan animasi pada setiap objek
melalui  pengaturan  Animasi Ubahan pada  Panel Tugas.  Selain itu,  Anda juga bisa memberi
animasi pada saat transisi antar slidemelalui pengaturan Transisi Slide pada panel tugas.   

Setelah sebuah slide selesai dibuat, Anda bisa membuat slide baru melalui menu Sisip => Slide.
Kemudian, Anda bisa mengerjakan slide baru Anda. Untuk berpindah dari suatu slide ke slide
lain, klik pada slide yang diinginkan pada daftar slide yang terlihat di bagian kiri jendela aplikasi. 

Untuk menampilkan presentasi, klik menu  Pertunjukan Salindia => Pilih  Pertunjukan Salindia
yang ingin ditampilkan, atau tekan tombol F5 pada Papan Tik.

Jika ingin menyimpan hasil pekerjaan anda, klik menu Berkas => Simpan. Lalu, tentukan lokasi
penyimpanan berkas serta format berkas yang diinginkan. Kemudian, klik tombol Simpan. Anda
juga bisa menyimpan hasil pekerjaan Anda dengan menekan tombol Ctrl+S pada Papan Tik.

7.4. California
California adalah aplikasi kalender modern untuk dekstop GNOME.

7.4.1.  Membuka California
1. Klik Menu Utama  Blankon => Perkantoran => California
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7.4.1.1. Menambah Acara
Terdapat  3  (tiga) cara  untuk  menambahkan  acara  atau  agenda  pada  california,  berikut  ini
penjelasan singkatnya 

• Klik ikon Tambah Acara Kilat (tanda tambah) pada baris alat California

• Masukkan keterangan pada kotak Apa,  kemudian  klik  ikon  tanda tambah.  Jika  ingin
menambahkan keterangan lain lebih rinci, klik ikon gambar pensil.
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• Letakkan kursor di atas tanggal tertentu, kemudian klik dua kali pada tanggal tersebut,
masukkan keterangan pada kotak Apa. Pilih kalender. Klik ikon tanda tambah. Bila ingin
menambahkan keterangan yang lebih rinci, klik ikon gambar pensil.

• Cara ketika dapat menggunakan tombol pintas pada papan tik, yaitu denngan menekan
tombol Ctrl+N.

Masukkan rincian acara
Rincian acara meliputi Ringkasan, dan Waktu

Secara  default,  acara  dicatat  sebagai  acara  seharian.  Untuk  mengubahnya,  Anda  perlu
menghilangkan tanda centangnya sehingga dapat mengubah waktu acara.

Pengulangan dan Tamu

Tambahkan alamat email penyelenggara dan para tamu.

Lokasi, Deskripsi, dan Kalender

Secara default, California menggunakan kalender pribadi. Anda dapat menambahkan kalender-
kalender lain seperti Kalender Google, Kalender web, dan CalDAV.

Klik tombol Buat di pojok kanan bawah.

Catatan:
• Bila  kalender  pribadi  tidak  muncul,  mungkin  Anda  perlu  memasang  evolution-data-

server. Buka menu BlankOn => Perkakas Sistem => Terminal dan ketik sudo apt install
evolution-data-server.
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7.4.1.2. Shortcut/Tombol Pintasan
Kembali menyorot ini Ctrl+T

Tampilan mingguan Ctrl+W

Tampilan bulanan Ctrl+M

Menampilkan hari/mingugu/bulan selanjutnya Alt+Right Arrow

Menampilkan hari/mingugu/bulan Alt+Left Arrow

Membuka jendela Tambah Acara Kilat/Quick-add window Ctrl+N

Membuka daftar kalender Ctrl+L

Memperbesar ukuran tulisan/font +

Memperkecil ukuran tulisan/font -

Mengembalikan ukuran tulisan/font ke ukuran normal *

Menutup aplikasi Ctrl+Q

Catatan
• Saat ini tombol pintas +, - dan * tidak berfungsi  pada BlankOn X Tambora
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BAB 8 APLIKASI GRAFIS

ntuk  menunjang  kebutuhan  Grafis,  BlankOn  telah  menyertakan  aplikasi  grafis
diantaranya; Penampil gambar, Penampil berkas E-Book, Pengelola fotografi Shotwell
Foto Manager, Inkscape, GIMP, dan Libre Office Draw. Semua aplikasi grafis yang ada

berfungsi  untuk menggantikan aplikasi grafis komersial  yang ada di sistem operasi  Microsoft
Windows Dengan aplikasi Legal. Walaupun ada kemiripan, ada beberapa perbedaan yang harus
Anda  ketahui  dan  dikuasai.  Namun  dengan  pembiasaan  diri,  tidak  akan  sulit  untuk
menggunakan aplikasi grafis yang ada di BlankOn untuk berproduktivitas dan berkreatifias. 

U

8.1. Penampil Gambar
BlankOn  mendukung  berbagai  format  gambar/fotografi  yang  bisa  Anda  buka  menggunakan
aplikasi bernama Eye of GNOME (Eog). Untuk membuka suatu gambar/foto, klik dua kali berkas
gambar/foto  yang  ingin  dibuka  pada  peramban  berkas  Nautilus,  aplikasi  ini  juga  dapat
digunakan untuk  memutar atau  membalikkan foto.  Pada BlankOn X Tambora aplikasi Eye of
Gnome (EoG) yang digunakan adalah versi 3.20.5. 

8.2. gThumb Penampil Gambar
 Selain Eye of GNOME, di BlankOn X Tambora juga menyedikan aplikasi untuk membuka dan
mengelola gambar, yaitu gThumb Penampil Gambar. Selain dapat digunakan untuk membuka
gambar, aplikasi ini juga dapat digunakan untuk membuat album dari koleksi foto Anda.
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8.3. Pembaca Buku Elektronik 
Buku elektronik  atau e-book merupakan format distribusi  buku yang sangat  umum saat  ini.
Buku-buku  atau  majalah  luar  negeri  banyak  mendistribusikan  buku  jenis  ini  selain  juga
mengedarkan edisi cetaknya. Harga dari buku elektronik jelas lebih murah daripada buku cetak
karena tidak memerlukan kertas. 

Hampir  semua buku  elektronik  di  distribusikan  dalam  bentuk  format  PDF  yang  merupakan
format dari perusahaan Adobe, inc. Untuk membuka format ini di distro BlankOn, Anda bisa
menggunakan aplikasi  bernama  Evince Document Reader.  Klik ganda pada berkas PDF yang
ingin  Anda buka pada peramban berkas,  maka aplikasi  Evince  akan membukakannya untuk
Anda. 

Untuk mempermudah navigasi antarhalaman, Anda bisa memanfaatkan side pane yang tersedia
di sebelah kiri  jendela Evince. Anda juga bisa memanfaatkan tombol arah atau tombol Page
Up/Down. 

Untuk memperbesar  ukuran halaman dengan memanfaatkan fitur  zooming dengan memilih
ukuran zoom yang diinginkan pada opsi yang terdapat di bagian kanan toolbar. Agar lebih enak
dibaca, Anda bisa membuka halaman dengan layar penuh melalui menu Lihat => Layar Penuh
atau  Anda  bisa  tekan  tombol  F11 pada  papan  ketik,  sebagai  tambahan  anda  juga  dapat
menampilkan halaman buku elektronik  dengan gaya presentasi  yaitu melalui  menu  Lihat  =>
Presentasi atau tekan tombol F5 pada papan ketik. 
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8.4. Penyunting Bitmap/Raster GIMP
Untuk  keperluan  editing  gambar/foto  yang  berbasis  bitmap,  BlankOn  menyediakan  aplikasi
bernama GIMP (www.gimp.org). Aplikasi ini merupakan salah satu bagian dari paket aplikasi
perkantoran GNOME Office.

Aplikasi  ini  merupakan  aplikasi  padanan  dari  penyunting  foto  terkenal  di  sistem  operasi
Microsoft  Windows,  yaitu  Adobe  Photoshop.  Jika  Anda  sudah  ahli  menggunakan  Adobe
Photoshop, menggunakan GIMP tidaklah hal yang sulit yang penting adalah Andamembiasakan
menggunakan aplikasi ini. 

8.4.1.  Memulai aplikasi GIMP 
Untuk membuka GIMP, klik menu Aplikasi Grafik => GNU Program Manipulasi Gambar. Tunggu
sebentar hingga jendela utama aplikasi GIMP muncul. 
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8.4.2.  Main Windows
Saat ini Antarmuka GIMP tersedia dua mode, yaitu;  multi-window dan  single window.  Pada
saat  pertama kali  GIMP dijalankan maka secara  default  akan  tampil  sebagai  multi-window.
Untuk  mengubah  mode  multi-window menjadi  single-window lakukan  langkah  berikut;
arahkan kursor pada menu bar => klik  Windows =>  Single-Window Mode, maka setelah jeda
sejenak antarmuka GIMP berubah menjadi Single-Window Mode.

Jika menggunakan mode  Multi-window maka akan terdapat  dua panel (kiri dan kanan), dan
image window pada bagian tengah, jika terdapat dua gambar atau lebih maka hanya yang aktif
saja yang terlihat, gambar lainya akan tersembunyi di balik gambar yang aktif.

Seacara default panel kiri berisi kumpulan Toolbox dan Tool Options, sedangkan panel sebelah
kanan  berisi  layer,  channels,  paths,  dan  undo  history,  dibawahnya  terdapat  ikon  brushes,
patterns,  dan  gradients,  ketika  salah  satu  ikon  diklik,  maka  tampilan  di  dalam  jendela  di
bawahnya berubah.

1. Kotak Alat:  Berisi satu set tombol ikon alat utama yang digunakan untuk menggambar
atau manipulasi gambar. Secara baku bagian bawah Kotak Alat hanya berisi Latar Depan
dan  Latar belakang Warna, Anda dapat menambahkan ikon brush, pola, gradasi, dan
ikon lainnya dengan cara klik Sunting => Preferensi => Kotak alat, kemudian beri tanda
centang disamping kiri ikon hingga berubah menjadi gambar mata.

2. Opsi Alat berada dibawah Kotak Alat, berisi jendela  Opsi Alat yang menunjukkan alat
yang sedang digunakan.

3. Jendela Gambar: setiap Gambar yang terbuka pada GIMP ditampilkan pada jendela yang
terpisah. Anda dapat membuka banyak gambar dalam waktu yang sama, namun hal ini
kadang bermasalah jika komputer yang digunakan memiliki spesifikasi yang pas-pasan.
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Untuk  dapat  bekerja  dengan  GIMP  Anda  harus  memiliki  minimal  satu  jendela  yang
terbuka.
Sebuah gambar kadang ukurannya lebih besar dari jendea yang aktif, jika hal ini terjadi
maka GIMP akan menampilkan gambar tersebut dengan  tingkat zum yang lebih kecil
sehingga semua bagian gambar dapat terlihat walau dengan resiko kurang detail. Jika
Anda mengubah tingkat zum ke 100% (ukuran normal) gunakan penggulung layar untuk
melihat bagian tertentu yang tidak terlihat dengan menggeser ke kanan-kiri atau atas-
bawah.

4. Lapisan,  Kanal,  Paths,  Undo  History   merupakan  fitur  penting  pada  GIMP  untuk
memudahkan  pekerjaan  pada  saat  manipulasi  gambar,  fitur  ini  berisi  semua lapisan
gambar  yang sedang aktif,  sebenarnya tanpa menggunakan fitur  ini  kita  tetap dapat
melakukan pengolahan gambar dengan mudah pada jendela utama GIMP atau  Image
window,  namun pengguna GIMP sebagian besar lebih suka menggunakan jendela ini
karena lebih mudah dalam manipulasi gambar yang rumit.

5. Brushes/Poola/Gradasi:  ketika menggunakan GIMP standar  fitur  ini  menempel  pada
kotak pengaturan kelompok Lapisan, fitur ini digunakan untuk mengatur brushes, pola,
dan gradasi.
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8.4.3.  Jendela Gambar
Saat  ini  Antarmuka  GIMP tersedia  dalam  dua  mode  yaitu  mode  multi-window dan  single-
window, namun saat pertama kali GIMP dijalankan maka tampilannya secara otomatis sebagai
multi-window.

Untuk mengubah antarmuka GIMP dari mode  multi-window menjadi  single-window lakukan
langkah berikut; arahkan kursor pada Image Menu => klik Windows => Single-Window Mode.
Jika saat Anda menutup GIMP terakhir kali  menggunakan mode single-window, maka secara
otomatis saat menggunakannya kembali akan tampil sebagai mode single-window, begitupun
sebaliknya.

Pada saat menggunakan mode single-window, maka tidak ada jendela baru yang ditambahkan
jika membuka gambar baru, namun secara otomatis tab di atas image display bertambah.

Dibawah ini penjelasan singkat beberapa komponen penting mengenai  Jendela gambar pada
mode Single-window.

8.4.3.1. Nama Gambar
Berisi nama dan jenis jendela gambar yang sedang aktif, ketika pertama kali membuat jendela
gambar baru yang masih kosong (tanpa gambar) maka secara otomatis Nama Berkas bernama
Tanpa Judul-x.x, pada aplikasi lain Nama Gambar kadang disebut Nama Berkas. Nama Gambar
disediakan oleh sistem operasi, bukan oleh GIMP, sehingga tampilannya berbeda-beda sesuai
tema sistem operasi  yang digunakan.  Nama Gambar  secara baku tersedia juga pada semua
Jendela pengaturan yang sedang aktif.

8.4.3.2. Menu Bar
Berisi daftar perintah yang bisa digunakan berupa menu, jika salah satu menu diklik maka akan
muncul submenu lainnya, submenu meliputi hampir semua operasi yang dapat dilakukan pada
GIMP. Image menu berada tepat di bawah Nama Gambar, Menu Bar juga sering disebut Menu
Gambar. Menu Bar juga dapat ditampilkan dengan melakukan klik kanan pada Jendela gambar,
cara lainnya dapat dilakukan dengan klik Tombol Menu.

Berbagai perintah dengan menggunakan tombol pintas Papan Tik juga ditunjukkan pada Menu
Bar. Anda juga dapat menentukan tombol pintas sendiri dengan melakukan pengaturan melalui
Sunting => Preferensi => Antarmuka => Antarmuka Pengguna => Atur Pintasan Papan Tik.

8.4.3.3. Tombol Menu
Digunakan untuk menampilkan Menu Bar dengan cara melakukan klik pada tanda segitiga, hal
ini  sangat  berguna jika Anda menggunakan modus  layar penuh.  Fitur  ini  juga dapat  dijalan
menggunakan tombol pintas pada papan tik dengan menekan tombol Shift+F10.
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8.4.3.4. Penggaris
Penggaris atau Ruler merupakan alat bantu untuk mengukur panjang/lebar Tampilan Gambar
dan koordinat gambar. Pada GIMP terdapat dua penggaris yaitu mendatar dan tegak, penggaris
mendatar berada  di sisi atas Tampilan gambar, sedangkan penggaris tegak berada  di sisi kiri
tampilan gambar.  Ukuran penggaris pada GIMP secara baku adalah  pixel, ukuran penggaris
dapat diubah melalui Menu Ukuran. Untuk mempermudah dalam mengolah gambar, penggaris
dapat dikombinasikan dengan garis panduan atau Guides.

8.4.3.5. QuickMask Toggle 
Berupa  tombol  kecil  di  pojok  kiri  bawah  Tampilan  gambar yang  digunakan  untuk  beralih
tampilan Tampilan gambar. Saat  QuickMask aktif maka tampilan Tampilan Gambar pada suat
gambar yang tidak terseleksi berubah menjadi merah.

8.4.3.6. Koordinat Pointer
Berisi keterangan posisi dan letak dari pointer atau kursor pada Tampilan Jendela.
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8.4.3.7. Menu Ukuran
Digunakan untuk mengubah ukuran pada penggaris dan beberapa komponen lainnya. ukuran
standar adalah pixel, namun dapat diubah ke ukuran lainnya melalui menu ini, misalnya diubah
menjadi inci, centimeter, feet, dan lain-lain. 

8.4.3.8. Tombol Zum
Berisi  keterangan  besar  dan  kecilnya  tampilan  gambar  pada  Tampilan.  Anda  dapat
menggunakan tampilan gambar sesuai keinginan dengan cara cepat yaitu mengubah nilai pada
kotak zum yang sudah ada.

8.4.3.9. Lokasi Status
Letaknya di  bawah Tampilan gambar.  Lokasi  Status secara baku menampilkan nama asli  dari
gambar yang aktif dan jumlah memori sistem yang digunakan oleh gambar.

8.4.3.10. Tombol Batal
Digunakan untuk membatalkan suatu operasi yang memakan waktu lama, fitur ini hanya tampil
pada saat melakukan manipulasi gambar rumit, misal saat menggunakan salah satu filter untuk
manipulasi gambar. Klik tombol berwarna merah yang muncul untuk membatalkan operasi yang
dilakukan.

8.4.3.11. Navigasi
Tombol berbentuk tanda seperti salib kecil berada disudut kanan bawah tampilan gambar. Klik
dan tahan tombol kiri mouse pada navigasi untuk menampilkan tampilan navigasi dari gambar
yang aktif.  Ketika menggunakan  Navigasi maka muncul  tampilan miniatur  dari  gambar yang
sedang  aktif  pada  tampilan  gambar.  Gunakan  tombol  navigasi  untuk  menggeser  tampilan
gambar ke kiri-kanan atau atas-bawah dengan tetap menahan tombol kiri mouse. Penggunaan
Navigasi paling nyaman digunakan untuk melihat bagian tertentu pada gambar dengan ukuran
besar melebihi ukuran tampilan gambar.

8.4.3.12. Tampilan Gambar
Bagian utama dan paling penting pada GIMP, bagian ini berisi tampian gambar pada canvas.
Letak dari  Tampilan gambar berada di  tengah-tengah jendela GIMP ditandai  garis  berwarna
kuning  putus-putus  sebagai  batas  halaman  atau  gambar,  sedangkan  bagian  luar  halaman
berwarna abu-abu.

Catatan:
• Beberapa komponen pada  Tampilan Gambar dapat disembunyikan dengan melakukan

klik  View => nama komponen.

Untuk membuat halaman baru, klik menu Berkas => Baru. Kemudian, tentukan ukuran halaman
serta pengaturan lainnya. Sedangkan untuk membuka suatu gambar, klik menu Berkas => Buka
dan pilih berkas gambar yang ingin dibuka. Format gambar baku yang digunakan oleh GIMP

 Aplikasi Grafis



119

adalah XCF. Untuk format lainnya, GIMP mendukung format: GIF, JPEG, PNG, PSD,EPS, BMP, dan
ada puluhan format lainnya yang didukung.

8.4.3.13. Bekerja dengan GIMP
Seperti  yang dijelaskan sebelumnya,  jika  Anda sudah terbiasa  menggunakan aplikasi  Adobe
Photoshop,  Anda hanya memerlukan sedikit  pembiasaan untuk  menggunakan GIMP karena
penampilannya memang di desain semirip mungkin dengan Adobe Photoshop.

8.4.4.  Manipulasi foto dengan GIMP 
GIMP menyediakan berbagai Alat pada kotak alat yang berfungsi untuk melakukan pemotongan,
pemindahan  dan  menggambar.  Sebelum  membahas  fungsi  setiap  alat,  sebaiknya  anda
memahami dulu konsep Image (gambar) dan Lapisan (layer). Untuk lebih jelas akan dijelaskan
dengan singkat seperti ini: 

8.4.4.1. Image
Image atau gambar merupakan pokok utama atau inti dalam penggunaan GIMP, secara garis
besar  sebuah gambar terdiri  dari  1  (satu)  berkas tunggal  pada gambar dengan format  TIFF,
JPEG, PNG, dan lain-lain. Gambar di GIMP jika dijelaskan secara detail akan sangat rumit, untuk
menyederhanakannya kita anggap saja sebagai selembar kertas yang berisi gambar di atasnya. 

Pada dasarnya gambar di halaman GIMP terdiri dari  beberapa tumpukan Lapisan. Selain itu,
gambar  di  GIMP dapat  juga  berisi  Lapisan Masker,  satu  set Kanal,  dan Garis  Jalur  (Path).
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Bahkan GIMP juga menyediakan mekanisme untuk melampirkan potongan data pada gambar
secara acak yang disebut Parasites.

Dengan GIMP kita dapat membuka gambar dalam jumlah yang banyak secara bersamaan pada
Main Window (tab jendela) yang berbeda. Walaupun dengan resiko penggunaan memori pada
komputer juga semakin besar sehingga dapat memperlambat kinerja komputer, namun jangan
khawatir, para pengembang GIMP sudah merancang sistem manajemen memori berbasis  tile
yang canggih sehingga penanganan gambar pada GIMP tetap baik. Namun jika  RAM Memori
pada komputer Anda masih masih terlalu kecil, sebaiknya tambahkan RAM Memori yang lebih
besar lagi agar kinerja komputer lebih maksimal

8.4.4.2. Layer
Jika Anda membayangkan gambar adalah sebuah kue lapis,  layer
adalah  tiap  lapisannya  sehingga  jika  layer  diatasnya  berlubang,
maka  akan  kelihatan  layer  di  belakangnya.  gambar  juga  dapat
dijadikan layer dengan memindahkannya ke gambar lain. 

Jika pada adobe photoshop sebuah gambar dapat ditarik kemudian
dilepaskan ke gambar lain untuk dijadikan layer, di GIMP haruslah
di salin terlebih dahulu. Inilah perbedaan mendasar yang seringkali
membingungkan pengguna adobe photoshop. Beberapa alat yang
sering  digunakan  para  desainer  akan  ditampilkan  pada  tabel  di
bawah ini : 

8.4.4.3. Kotak Alat dan Tombol Pintas
Seperti yang sudah dijelaskan sebelumnya, bahwa untuk mempermudah mengakses kotak alat,
Anda bisa menggunakan tombol pintas pada papan tik yang tampil saat ikon di sorot seperti
pada gambar.
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Pada gambar tampak, untuk mengaktifkan Alat Seleksi (selection tool) dapat dilakukan dengan
menekan tombol  R pada  Papan Tik.  Dengan seringnya menggunakan tombol pintas tertentu
pada papan tik, maka secara otomatis  Anda akan hapal dengan sendirinya. Pengaturan dari
tiap-tiap palat ada kotak alat  dapat dilakukan melalui  Alat  Opsi yang secara baku berada di
bawah Kotak Alat. 

Fungsi Tombol Pintas

Rectangle selection tool R 

Elipse selection tool E 

Free/Glasso? select tool F 

Fuzzy/Magic? select tool U 

Select by color Shift+O 

Scissors select tool I 

Foreground select tool <tidak ada> 

Paths tool B 

Color picker O 

Zoom tool Z 

Measurement tool Shift+M 

Move tool M 

Allignment tool Q 

Crop tool Shift+C 

Rotate tool Shift+R 

Scale tool Shift+T 

Shear tool Shift+S 

Perspective tool Shift+T 
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Fungsi Tombol Pintas

Flip tool Shift+F 

Text tool T 

Bucket fill tool Shift+B 

Blend/Gradient? tool L 

Pencil tool N 

Paintbrush tool P 

Erase tool Shift+E 

Airbrush Tool A 

Ink tool K 

Clone tool C 

Healing tool H 

Perspective clone tool <tidak ada> 

Burn/Sharpen? Tool Shift+U 

Smudge tool S 

Dodge/Burn? tool Shift+D 

Terdapat 33 jenis alat dalam kotak alat utama ini. Cukup banyak untuk penggunaan sehari-hari.
Setiap alat akan diikuti dengan beberapa opsi yang otomatis muncul di bagian Opsi Alat. 

Untuk menampilkan jendela layer/lapisan lainnya, klik menu Windows => Dockable Dialog =>
pilih  alat  sesuai  keinginan Anda.  Silahkan  anda  menempatkan  dan  mengaturnya  senyaman
mungkin. 

Untuk mempermudah editing, Anda bisa memanfaatkan fitur lapisan yang akan memisahkan
setiap obyek yang ada di halaman Anda. Pengaturan lapisan bisa Anda lakukan melalui jendela
pengaturan disebelah kanan halaman. Dengan membedakan lapisan dari  setiap obyek, Anda
bisa lebih mudah memanipulasi suatu obyek tanpa perlu menganggu obyek lainnya.
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Berbagai menu untuk keperluan manipulasi gambar secara keseluruhan dapat ditemukan pada
menu Citra (Image). Sedangkan untuk memanipulasi suatu lapisan atau objek yang dipilih, Anda
bisa  manfaatkan  menu  Lapisan.  Bagi  yang  ingin  bermain-main  dengan  warna,  silahkan
manfaatkan menu Warna untuk melakukan manipulasi warna pada obyek. 

GIMP menyediakan berbagai efek-efek yang bisa Anda buka melalui menu Penyaring (Filters).
Untuk memberi  efek pada bagian tertentu, Anda bisa memilih bagian yang ingin diberi efek
dengan menggunakan kotak  alat  untuk  memilih  (alat  seleksi  atau  menekan tombol  R  pada
papan tik), lalu pilih efek yang diinginkan pada menu Penyaring. Kemudian, atur pengaturan
efek agar sesuai dengan keinginan Anda. 

8.4.5.  Lebih lanjut dengan GIMP 
Untuk  mempelajari  lebih  lanjut  mengenai  GIMP,  Andabisa  membuka  layar  bantuan  melalui
menu Bantuan => Bantuan atau tekan tombol F1 pada papan tik. Jika ingin membaca bantuan
GIMP tanpa perlu koneksi internet, Anda bisa menginstal paket "gimp-help-en" (Bahasa Inggris)
melalui APT dengan kata kain melalui perintah di terminal dengan mengetikkan sudo apt-get
install  gimp-help-en.  Jika  Anda  baru  pertama  kali  mempelajari  editing  fotografi,  Anda  bisa
mempelajari dari banyak tutorial GIMP yang terdapat di internet. 

8.5. Penyunting Inkscape 
Inkscape merupakan aplikasi  penyunting grafis  vektor  yang secara default  sudah terinstal  di
BlankOn. Aplikasi ini adalah padanan dari aplikasi penyunting grafis vektor komersial Corel Draw
dan Adobe Illustrator yang ada di Microsoft Windows. 

8.5.1.  Menjalankan Inkscape 
Untuk menjalankan Inkscape pada BlankOn, arahkan kursor ke menu favorit, klik ikon Inkscape.
Cara lainnya klik Menu Utama  BlankOn => Grafik => Inkscape 

Tunggu beberapa saat hingga tampil jendela utama inkscape. Waktu yang dibutuhkan dalam
proses  membuka program ini  tergantung dengan kondisi  komputer  yang sedang digunakan,
semakin modern komputer yang digunakan maka akan semakin cepat juga prosesnya.

8.5.2.  Mengenal Menu-Menu Inkscape
Setelah aplikasi inkscape berhasil dijalankan, maka terlihat tampilan jendela utama inkscape.
Pada  jendela  utama  inilah  segala  kegiatan  menggambar  dapat  dilakukan  dengan  mudah.
Jendela utama inkscape terdiri dari beberapa menu di antaranya;  Nama Berkas, Baris Menu,
Baris Perintah, Alat Kontrol, Kanvas, Kotak Alat, Palet Warna, Baris Status, dan lain-lain. 
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8.5.2.1. Nama Berkas
Nama Berkas, merupakan nama dan jenis halaman kerja yang sedang aktif, pada saat pertama
kali inkscape dijalankan bertuliskan Dokumen baru 1 -Inkscape, Nama Berkas kadang disebut
Title Bar.

8.5.2.2. Baris Menu
Baris Menu atau dalam bahasa Inggris sering disebut Menu Bar, berisi daftar perintah yang bisa
digunakan berupa menu, jika salah satu menu diklik maka akan  muncul submenu lainnya.

8.5.2.3. Baris Perintah
Baris Perintah menampilkan ikon-ikon yang merupakan perintah utama pada program inkscape,
seperti  ikon  membuat  halaman  baru,  membuka  gambar  yang  sudah  dibuat  sebelumnya,
menyimpan gambar, dan lain-lain, pada Inkscape yang menggunakan Antarmuka Bahasa Inggris
Baris Perintah sering disebut Command Bar.
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8.5.2.4. Alat Kontrol
Alat  Kontrol  menampilkan  ikon-ikon ketika membuat  atau  mengolah  obyek,  misalnya  untuk
mengatur jarak object dari penggir halaman, mengatur tinggi dan lebar object, memutar object,
dan lain-lain. Ikon pada Alat Kontrol secara otomatis  berubah ketika salah satu ikon pada Kotak
Alat diklik.

8.5.2.5. Penggaris
Penggaris merupakan alat bantu untuk mengukur panjang dan lebar suatu kanvas atau halaman
kerja. Pada program inkscape terdapat dua penggaris yaitu penggaris mendatar dan tegak, ruler
mendatar berada di sisi atas kanvas, sedangkan penggaris tegak berada di sisi kiri kanvas. 

8.5.2.6. Kotak Alat
Kotak Alat, berisi berbagai ikon untuk memudahkan dalam menggambar, pada saat salah satu
ikon diklik maka secara otomatis ikon pada Alat Kontrol ikut berubah, secara umum ikon Kotak
Alat letaknya di pinggir sebelah kiri dengan posisi tegak.

8.5.2.7. Kanvas 
Kanvas, merupakan area kerja untuk menempatkan obyek yang dibuat, pada saat melakukan
pencetakan  (printing)  obyek  yang  berada  di  kanvas  namun  diluar  halaman  kerja  tidak  ikut
tercetak.

8.5.2.8. Halaman
Halaman atau kadang disebut lembar  kerja merupakan area kerja di  dalam kanvas,  area ini
dapat   memanjang  keluar  dari  area  pandang,  kita  dapat  menyorot  halaman  ini  sesuai
kebutuhan, dengan mengeser Penggulung Layar ke kiri-kanan atau ke atas-bawah. Pada saat
melakukan pencetakan obyek yang berada di halaman kerja inilah yang akan tercetak.

8.5.2.9. Penggulung Layar
Penggulung Layar fungsinya untuk menggulung tampilan kanvas agar turun atau naik dan ke kiri
atau ke kanan, terdapat dua buah penggulung layar di Inkscape yaitu penggulung layar tegak
dan mendatar, penggulung layar tegak berada di sisi kanan kanvas sedangkan penggulung layar
mendatar  berada  di  sisi  bawah  kanvas.  Penggunaan  Penggulung  Lyar  juga  dapat  dilakukan
dengan menekan tombol  pada  Papan Tik,  caranya tekan Ctrl kemudian tekan tombol  Arah,
Ctrl+Arah kanan/kiri  untuk menggulung layar ke kiri/kanan (mendatar),  sedangkan  Ctrl+Arah
atas/bawah untuk menggulung layar ke atas/bawah (tegak)

8.5.2.10. Alat Pengancing
Berisi beberapa ikon yang digunakan untuk membantu penempatan obyek secara tepat pada
kanvas atau halaman dengan mendekatkan obyek pada terget tertentu sesuai parameter yang
dilakukan.
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8.5.2.11. Palet Warna
Palet Warna berisi ikon warna untuk memberi warna obyek atau gambar sesuai pilihan, untuk
memilih warna lain yang tidak terlihat geser Penggulung Layar yang disertakan di bawah palet
warna.  Untuk  memberi  warna pada  Isi,  pilih  object  kemudian  klik  ikon  warna yang sesuai,
sedangkan untuk memberi warna pada Garis lakukan sambil menekan tombol Shift pada Papan
Tik.

8.5.2.12. Baris Status
Baris  Status,  berisi  beberapa  kolom yang menampilkan  berbagai  status  dari  area  kerja  dan
obyek yang sedang dikerjakan.

8.5.3.  Membuka Berkas
Untuk membuka berkas yang sudah tersimpan lakukan cara berikut, klik  Berkas => Buka atau
tekan Ctrl+O, cara berkas yang akan dibuka di direktori komputer Anda, jika sudah ketemu klik
sekali berkas tersebut, kemudian tekan tombol Buka.

8.5.4.  Bekerja dengan Inkscape 
Pertama kali bekerja dengan Inkscape, Anda perlu mengatur besar dari ukuran halaman yang
akan digunakan. Untuk melakukannya lakukan cara berikut, klik  Berkas => Properti Dokumen
atau tekan tombol Shift+Ctrl+D. 
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Pada jendela yang tampil Kemudian, tentukan
ukuran  dari  halaman  serta  orientasinya  yang
diinginkan.  Jika  ingin  menggunakan  ukuran
yang tidak  disediakan secara  baku,  Anda bisa
melakukan  pengaturan  pada  Custom  Size.
Sekarang, Anda bisa menggambar obyek yang
diinginkan  dengan  memanfaatkan  Kotak  Alat
yang berada di sisi kiri jendela Inkscape. Anda
bisa mengatur bentuk-bentuk pada obyek yang
Anda  buat  sedemikian  rupa  sesuai  dengan
keinginan.

Untuk mengatur bentuk garis pada obyek, Anda
bisa klik kanan pada obyek dan memilih menu
Isi  dan  Sapuan.  Maka  akan  muncul  sebuah
jendela yang dapat digunakan untuk mengatur
warna dan ukuran garis.

Untuk menyimpan hasil kerja anda, klik Berkas
=> Simpan  atau tekan  Ctrl+S pada papan tik.
Kemudian,  tentukan  nama  dan  letak  berkas
serta  format  berkas  yang  akan  digunakan.
Format  berkas  baku  yang  digunakan  adalah
SVG yang merupakan format universal untuk grafis berbasis vektor. 

8.5.5.  Mempelajari Inkscape lebih lanjut 
Untuk  menggunakan  Inkscape  lebih  lanjut,  Anda  bisa  membuka  tutorial-tutorial  sederhana
sudah disediakan dengan cara klik Bantuan => Tutorial => pilih Judul Tutorial. Tutorial tersebut
sangat cocok bagi para pemula baik yang baru menggunakan Inkscape atau sama sekali belum
pernah melakukan editing grafis. 

Jika menginginkan yang lebih referensif, Anda bisa klik  Bantuan => Petunjuk Inkscape.  Anda
memerlukan koneksi internet untuk membuka Petunjuk Inkscape.

8.6. Libre office Draw 
Libre office Draw adalah aplikasi menggambar yang disertakan dalam paket aplikasi libre office,
jika Anda kurang mahir menggunakan aplikasi Penyunting bitmap/raster GIMP atau Penyunting
vektor  Inkscape,  maka  aplikasi  ini  bisa  menjadi  alternatif  untuk  menciptakan  sebuah  karya
gambar sederhana. Pada dasarnya aplikasi Libre Office Draw adalah turunan dari aplikasi Open
Office Drawing karena menggunakan sumber kode yang sama sehingga tampilan, penggunaan
menu dan kurang lebih sama seperti pada Open Office Drawing.

Untuk menjalankan LibreOffice Draw lakukan cara berikut; klik Menu Utama  BlankOn => Grafik
=> LibreOffice Draw
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Untuk memulai menggambar cukup sederhana yaitu dengan cara melakukan klik menu-menu
jenis alat pada Baris Alat Gambar di atas Baris Status. 

Terdapat berbagai pilihan alat yang dapat digunakan, dari alat untuk menggambar garis, elips,
oval,  teks, kurva, konektor, garis,  panah, dan beberapa menu lainnya. Setelah memilih salah
satu menu tersebut (misal:  oval),  klik dan tahan tombol kiri  tetikus  pada lembar kerja dan
gerakkan sampai ukuran yang dirasa cukup dan lepaskan tekanan pada tombol tetikus. Anda
dapat  menyimpan  hasil  karya  dengan  format  bawaan  LibreOffice  Draw  yaitu  *.odg,  atau
langsung mencetak menjadi dokumen pdf dengan memilih menu ekspor sebagai pdf. 
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BAB 9 APLIKASI MULTIMEDIA DAN HIBURAN

lankOn menyediakan berbagai  aplikasi  multimedia  dan hiburan  yang bisa  menghibur
Anda di  saat sibuk bekerja  untuk berproduktivitas.  Selain itu,  tersedia juga beberapa
aplikasi  multimedia yang memang didedikasikan untuk mereka yang bekerja di studio

musik  atau  video.  Tidak  seperti  distribusi  Linux  lainnya,  BlankOn  secara  default  sudah
menyertakan codec atau pustaka pemutar format multimedia yang tertutup seperti MP3, DVD,
WMA,  dll.  Jadi,  Anda  tidak  perlu  lagi  memasang  codec  tambahan untuk  memutar  format
tersebut. 

B

9.1. Pengatur Suara
Pengatur  volume suara  digunakan untuk  mengatur  volume suara  secara
umum, Anda bisa klik  ikon speaker yang ada di area notifikasi, kemudian
mengatur seberapa besar volume suara pada slider yang disediakan. Cara
lain  untuk  mengatur  volume  suara  dapat  dilakukan  dengan  klik  Menu
Utama  BlankOn => Pengaturan, kemudian pada jendela Pengaturan yang
tampil, klik  ikon Sound, maka segera tampil jendela Sound, pada jendela
inilah Anda dapat mengatur volume suara. 

9.1.1.  Pengatur Suara Tingkat Lanjut
Untuk  mengatur  suara  dalam  moda  tingkat  lanjut  dapat  dilakukan  melalui  Menu  Utama
BlanKon => Preferensi => Pengaturan.

Setelah jendela Semua Pengaturan terbuka, klik  Sound  pada kelompok Perankat Keras. Pada
jendela Sound ada empat tab; Keluaran, Masukan, Efek Suara, dan Aplikasi.
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9.1.1.1. Pengaturan Tab Keluaran
Pada tab  Keluaran, Anda bisa mengatur  besar kecilnya suara yang akan dikeluarkan,  memilih
kartu  suara  yang  terpasang  pada  komputer,  dan  menguji  speaker/Headphones  yang
tersambung ke keluaran (output) Kartu Suara.

9.1.1.2. Pengaturan Tab Masukan
Tab ini digunakan untuk mengatur volume masukan (input), melihat tingkat suara masukan, dan
memilih perangkat keras untuk masukan suara.
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9.1.1.3. Pengaturan tab Efek Suara
Tab ini digunakan untuk mengatur volume waspada/nada untuk peringatan, dan memilih suara
waspada.

9.1.1.4. Pengaturan tab Aplikasi
Tab ini digunakan untuk melihat daftar aplikasi yang sedang memutar suara, mengatur suara
yang akan direkam,  dan mengatur volume suara aplikasi tersebut.
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9.2. Pembakar Diska CD/DVD 
Aplikasi ini mendukung pembakaran  CD/DVD dengan berbagai format, yaitu  Data, Audio dan
Video. Untuk membuka aplikasi ini, klik Aplikasi => Suara & Video => Brasero Pembakar Diska
segera keluar Buat Proyek baru => Brasero pembakar cakram. 

Pada jendela utama aplikasi Brasero Anda dapat memilih salah satu proyek yang ingin dibuat,
berikut beberapa menu yang dapat dipilih:  Proyek Audio, Proyek Data, Proyek Video, Salin
Diska, dan Bakar Salinan.  Masukkan CD/DVD kosong ke Pembakar CD/DVD yang Anda miliki,
bila keluar tampilan Buka Pembuat CD/DVD klik Batal (Cancel).

9.2.1.  Proyek Audio
Menu pertama atau paling atas adalah Proyek audio, menu ini digunakan untuk membuat CD
Audio/Musik tradisional  (menggunakan batas  waktu  79  menit)  yang  bisa  diputar  di  semua
pemutar  CD/DVD.  Anda membuat  CD Audio dengan memanfaatkan koleksi  lagu Mp3 yang
telah tersimpan di komputer Anda. Berikut cara membuat CD Audio menggunakan Brasero, klik
Proyek Audio untuk memasukkan lagu yang akan Anda buat, selanjutnya klik Tambah (Ikon +),
kemudian tambahkan berkas kedalam Proyek, cari dimana Anda meletakkan koleksi lagu Anda. 
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Pilih lagu apa saja yang ingin Anda masukan ke dalam CD, jika sudah sesuai dengan keinginan,
klik  Tambah (Add),  jangan lupa tulis  Nama atau  judul CD yang akan dibuat,  setelah itu klik
Bakar atau Burn (mulai membakar isi seleksi), tunggu hingga Selesai 

9.2.2.  Proyek Data
Proyek  data,  membuat  data  CD/DVD,  Klik  Proyek  data =>  klik  Tambah  (Ikon  +) untuk
menambahkan berkas kedalam Proyek Data, cari dilokasi Anda meletakkan data yang ingin di
jadikan  Proyek data, jika sudah klik  Add.  Tulis nama Proyek Data yang ingin Anda buat, jika
sudah selesai tinggal klik Bakar, apabila keluar tulisan Haruskah berkas diganti nama menjadi
sepenuhnya kompatible Windows, pilih saja sesuai pilihan Anda, tunggu sampai selesai.
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9.2.3.  Proyek video 
Untuk membuat CD/DVD Video, klik pada tombol Proyek Video pada Menu Utama . Atau klik
menu  Proyek =>  Proyek Baru => Proyek Video Baru.  Sebelum menambahkan berkas video,
Anda perlu memilih jenis media pembakaran. Untuk melakukan hal ini, klik ikon ... yang berada
di sebelah kiri indikator penunjuk kapasitas. Pilih jenis media sesuai dengan media yang akan
digunakan  untuk  pembakaran.  Setiap  jenis  media  memiliki  kapasitas  video  yang  berbeda.
Setelah menentukan jenis media, klik ikon Tambah pada Baris Alat dan pilih berkas video yang
ingin Anda tambahkan. Anda bisa menambahkan lebih dari  satu berkas video. Ingat,  karena
kapasitas CD/DVD terbatas, jumlah video yang ditampung pun juga terbatas. Jika semua sudah
siap, Anda bisa masukkan media pembakaran sesuai dengan jenis yang Anda pilih sebelumnya,
lalu  klik  tombol  Bakar.... Aturlah  opsi  pembakaran,  dan  terakhir  klik  tombol  Bakar untuk
melakukan pembakaran CD/DVD Video.
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9.2.4.  Salin Diska
Brasero  menyediakan  fitur  untuk  menyalin  atau  menggandakan  keping  CD/DVD.  Untuk
melakukan hal ini, klik tombol Salin Diska pada Menu Utama , atau klik Proyek => Proyek Baru
=>  Salin  Diska pada  Menu  Bar.  Pada  jendela  Opsi  Penyalinan,  tentukan  media  yang  akan
dijadikan  sumber  untuk  menggandakan,  pada  opsi  Pilih  keping  untuk  disalin.  Kemudian,
tentukan  tujuan  media  untuk  penggandaan  pada  Pilihan  keping untuk  ditulis.  Anda  bisa
membuka opsi penyalinan dengan mengklik tombol Properti. Setelah semua selesai, klik tombol
Salin untuk mulai melakukan penyalinan.

9.2.5.  Bakar Salinan
Cetakan/Image merupakan sebuah berkas yang berisikan informasi dan isi dari suatu CD/DVD.
Umumnya, format berkas ini berekstensi  ISO. Berkas jenis ini digunakan oleh pembuat  Distro
Linux untuk mendistribusikan distronya melalui jalur  Internet.  Untuk membakar  berkas citra
tersebut, klik tombol  Salinan pada  Menu Utama  , atau klik  Proyek => Proyek Baru => Bakar
Salinan, pada tab Pilih suatu image disk untuk ditulis silahkan klik saja disitu, cari di Folder mana
Anda meletakkan berkas ISO yang ingin dibakar, jika sudah ditemu klik Buka /Open. Agar hasil
proyek  CD/DVD yang  Anda  buat  hasilnya  memuaskan  pilih  saja  kecepatan  paling  rendah,
caranya klik  Properti,  pada tab  Kecepatan membakar, pilih yang paling rendah, misalnya  12
atau 16x (CD), setelah itu klik  Bakar, tunggu hingga selesai, jika Anda ingin membuat  Salinan
CD/DVD lebih dari satu pilih Bakar Beberapa Salinan.
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9.3. Pemutar Musik Audacious 
Untuk  keperluan  mengelola  musik  yang  ada  di  komputer  serta  memutarnya,  Anda  bisa
menggunakan  aplikasi  bernama  Audacious.  Aplikasi  ini  bisa  dibuka  melalui  Menu  Utama
BlankOn => Aplikasi Suara & Video => Pemutar Musik Audacious. 

Antarmuka  Audacious  tergolong  sederhana,  berikut  penjelasan  singkat  dari  anatrmuka
Audacious:

1. Baris  Nama  Aplikasi.  Pada  baris  ini,  terdapat  nama  aplikasi  yang  sedang  dipakai,
disebelah kanan terdapat 3 (tiga) Ikon yaitu Perkecil, Kembalikan, dan Tutup. 

2. Baris Menu, menampilkan daftar perintah yang bisa digunakan berupa menu.

3. Baris Alat Standar,  menampilkan ikon-ikon yang fungsinya untuk melakukan perintah
utama diantaranya; memutar, mempercepat lagu, menghentikan lagu, dll. 

4. Baris Putar, yaitu baris untuk membuat dan mengatur daftar album yang dibuat.

5. Daftar Lagu, merupakan tampilan daftar lagu atau album yang sedang diputar. 

Walaupun  tergolong  sederhana,  namun  Audacious  memiliki  beberapa  fitur  yang  lumayan
lengkap, diantaranya:

• Terdapat tray icon, sehingga ketika aplikasi ini dijalankan tidak memenuhi jendela yang
sedang terbuka.

• Memiliki pengatur Equalizer, visualization dll.

• Dilengkapi dengan OSD atau notification di setiap aktifitas menggunakan Audacious. 
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9.3.1.  Cara Memasukkan Berkas Lagu ke Daftar Main 
Cara  favorit  penulis  memasukkan  lagu  ke  dalam  daftar  main  adalah  menggunakan  tombol
Berkas di panel sebelah kiri. Setelah di klik tombol  Buka Berkas..., muncul peramban berkas
media tinggal di cari folder berkas media sampai daftar berkas muncul. 

Setelah  berkas  muncul,  tinggal  pilih  berkas  (atau  kalau  semua  berkas  dimasukkan  tinggal
menggunakan  Ctrl+A untuk  memblok  semua  berkas),  setelah  itu  klik  Buka.  Anda  dapat
membuat daftar main sebanyak yang Anda inginkan.

Untuk membuat daftar main baru, klik  ikon + (tambah) di sebelah kanan tab Sedang Diputar.
Langkah selanjutnya seperti yang dijelaskan pada bagian sebelum ini. Untuk berpindah daftar
main Anda tinggal mengklik tab Daftar putar baru.

9.4. Pemutar Film 
Untuk  memutar  video,  BlankOn  menyediakan  aplikasi  bernama  VLC  media  player.  Untuk
membuka aplikasi ini, klik  Menu Utama  BlankOn => Suara & Video VLC media player. Untuk
membuka berkas video dengan  VLC, klik menu Media => Buka File..., pilih berkas video yang
ingin diputar, kemudian klik tombol Open. 

Jika Anda ingin membuka video dari kepingan CD/DVD, klik menu Media => Buka Disk…, pilih
jenis media yang akan dibuka.

Untuk memulai memutar berkas video yang dibuka, klik tombol Putar.
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BAB 10 APLIKASI AKSESORIS

agi sebagian orang, memiliki komputer yang mempunyai semua aplikasi yang dibutuhkan
dalam kegiatannya setiap hari  mungkin  menjadi  kebutuhan tersendiri.  Misalnya  saja,
seorang siswa yang memiliki  kewajiban dalam mengerjakan tugas-tugas  dari  sekolah,

akan sangat terbantu bila memiliki kalkulator yang lengkap di dalam komputer atau laptopnya.
Pada distro BlankOn Linux, sudah tersedia beberapa aplikasi aksesoris atau aplikasi tambahan
yang sangat berguna dan siap dipakai oleh pengguna, dalam subbab ini akan dibahas beberapa
diantaranya. 

B
10.1. Cari Berkas
Cari berkas merupakan suatu aplikasi yang dibuat khusus untuk mempermudah para pengguna
BlankOn dalam mencari berkas yang di perlukan. Dengan menggunakan aplikasi pencari berkas
ini, berkas yang ingin digunakan atau dibuka akan lebih mudah untuk ditemukan. Dalam subbab
ini, akan dijelaskan mengenai pengenalan Cari Berkas.
Untuk membuka aplikasi ini , klik menu Aplikasi => Aksesoris => Cari Berkas. Pada saat pertama
kali dibuka, Anda akan melihat sebuah kotak pencarian kosong yang siap Anda gunakan untuk
keperluan pencarian berkas.
Jika Anda ingin mencari  berkas  yang diperlukan,  Anda bisa  Tulis  kata kunci  berkas => Pilih
folder tempat berkas disimpan => klik Cari.
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10.2. Kalkulator 
Seperti namanya, fungsi aplikasi ini untuk melakukan perhitungan dengan bantuan komputer.
Aplikasi  ini  dapat  dijalankan melalui  menu Aplikasi  >  Aksesoris  >  Kalkulator.  Secara  default,
aplikasi ini akan menampilkan kalkulator sederhana untuk melakukan perhitungan sederhana.
Untuk  mengubahnya  menjadi  kalkulator  yang  lebih  rumit,  anda  bisa  pilih  salah  satu  jenis
kalkulator pada menu “ Basic Mode”. 

10.3. Ambil Cuplikan 
Walaupun  tidak  sering,  mungkin  saja  Anda
membutuhkan tangkapan layar atau gambar dari
tampilan desktop atau aplikasi yang sedang aktif.
Untuk  melakukannya  itu  semua  BlankOn
menyediakan  aplikasi  bernama  Ambil  Cuplikan
Layar,  aplikasi  ini  dapat  dijalankan  dengan  klik
Menu Utama  BlankOn => Aksesoris => Cuplikan
Layar. 

Dengan  menggunakan  aplikasi  ini,  pekerjaan
untuk  mengambil  gambar  dari  desktop  atau
aplikasi  yang  aktif  dapat  dilakukan  dengan
mudah,  langkah-langkahnya  adalah  sebagai
berikut: 

Pertama,  siapkan  terlebih  dahulu  desktop  atau
aplikasi yang akan diambil gambarnya, kemudian buka aplikasi ini dan gambar pun siap untuk
diambil. Selain cara diatas, Anda juga bisa mengambil tangkapan layar dengan menekan tombol
Prtscr pada papan tik.
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10.4. Diska
Diska  menyediakan  cara  mudah  untuk  memeriksa,  memformat,  mempartisi,  dan  mengatur
diska  dan  media  penyimpanan  lain.  Dengan  Diska,  Anda  dapat  melihat  hasil  SMART  (Self-
Monitoring, Analysis, and Reporting Technology), dan mem-benchmark fisik diska. Perintah atau
tugas tersebut dapat dijalankan pada background, bahkan ketika aplikasi sudah ditutup.

10.4.1.  Fungsi
Diska dapat digunakan untuk melihat dan mengatur volume dan partisi media penyimpanan
seperti hardisk, USB Flash Disk, hard disk eksternal, CD/DVD, dan kartu memori.

10.4.2.  Memulai
Diska dapat dibuka dengan cara mengeklik Menu Utama  BlankOn => Aksesoris => Diska

Catatan
• Diska dapat juga dibuka dengan cara mengeklik ikon Diska pada panel bawah.

10.4.3.  Kotak Dialog Diska
Kotak dialog Diska terdiri dari beberapa bagian, yaitu Tajuk, Panel Kiri, dan Panel Kanan, masing-
masing bagian memiliki menu dan submenu.
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10.4.3.1. Tajuk
Pada tajuk terdapat nama media penyimpanan yang dipilih beserta lokasinya, ikon tombol dan
menu perintah, dan ikon-ikon untuk mengatur kotak dialog.

Tombol perintah yang ditampilkan pada tajuk menyesuaikan dengan media penyimpanan yang
dipilih. Tombol-tombol tersebut antara lain; Eject this disk dan power off this disk.

Bila ikon menu diklik, maka akan muncul daftar perintah;

• Format Disk
• Create Disk Image...
• Restore Disk Image...
• Benchmark Disk ...
• SMART Data &Self-Test
• Drive Setting...
• Standby Now

10.4.3.2. Panel Kiri
Panel  kiri  menampilkan  daftar  media  penyimpanan  yang
terpasang  dan  terhubung  dengan  komputer.  Pada  gambar  di
atas  terlihat  ada  lima  media  penyimpanan;  250  GB  Har  Disk
(hard  disk  yang  terpasang),  CD/DVD  Drive,  320  GB  Har  Disk
(Hardisk eksternal),  4,0 GB Drive (kartu memori  di dalam USB
card reader), 8,1 GB Drive (USB Flash Disk).
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10.4.3.3. Panel Kanan
Pada  bagian  atas,  panel  kanan  menampilkan  informasi  rinci  tentang  media  penyimpanan
meliputi  Model,  Size (ukuran),  Patitioning  (partisi),  Serial  Number  (nomor  seri) dan
Assessment (penilaian kondisi).

Pada bagian tengah dengan judul Volumes, panel kanan menampilkan informasi dalam bentuk
gambar  (info  grafis)  beserta teks  keterangan,  serta tombol-tombol  perintah.  Tombol-tombol
perintah pengaturan volume yang ditampikan di bawah info grafis ini juga menyesuaikan bagian
partisi yang dipilih. Tombol-tombol perintah tersebut antara lain;

• Mount selected partition (mengaitkan partisi)

• Delete selected partition (menghapus partisi)

• Additional partition options. Bila tombol ini diklik, akan muncul daftar opsi-opsi partisi
tambahan;

1. Format Partition

2. Edit Partition

3. Edit File System

4. Change Passprashe
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5. Edit Mount Options

6. Edit Encryption Options

Pada bagian bawah, panel kanan menampilkan informasi rinci tentang masing-masing bagian
dari  media penyimpanan yang dipilih meliputi  Size (ukuran),  Device (lokasi),  Partition Type
(jenis partisi) dan Contents (isi).

Peringatan:
• Dengan Diska, Anda dapat benar-benar menghapus data pada media penyimpanan.

10.4.4.  Mengenal partisi
Komputer Anda biasanya setidaknya memiliki 1 partisi utama (primary partition) dan 1 partisi
swap (swap partition). Partisi swap digunakan sistem operasi sebagai pengaturan memori,dan
jarang dikaitkan /di-mount.  Partisi  utama berisi  berkas-berkas (files) sistem operasi,  aplikasi,
pengaturan dan personal. Demi keamanan dan kenyamanan berkas-berkas tersebut dapat juga
dibagi-bagi pada beberapa partisi.

1 partisi utama harus berisi informasi yang digunakan oleh komputer untuk mulai atau booting.
Karena alasan inilah, partisi utama kadang disebut boot partition, atau boot volume.

10.4.4.1. Mengubah Volume menjadi Bootable
1. Klik menu BlankOn => Aksesoris => Diska

2. Pilih hardisk

3. Pilih partisi

4. Pada panel kanan, bagian tengah, klik tombol
Additional Partition Options (gambar gear)

5. Klik Edit Partition… 

6. Pastikan ada tanda  centang di kotak sebelah
kanan tulisan bootable.

10.4.5.  Memeriksa Kondisi Hard Disk
Hard  disk  mempunyai  perangkat  pemeriksa  kesehatan  bawaan  yang  disebut  SMART  (Self-
Monitoring, Analysis, and Reporting Technology) yang secara terus-menerus memeriksa diska.
SMART juga memperingatkan Anda jika diska hampir rusak, sehingga Anda dapat terhindar dari
kehilangan data. Walapun SMART berjalan secara otomatis, tetapi Anda dapat juga memeriksa
kesehatan diska dengan menjalankan aplikasi Diska;

1. Klik menu BlankOn => Aksesoris => Diska

2. Pilih hardisk pada panel kiri
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3. Pada tajuk, klik tombol menu sehingga muncul daftar perintah

4. Klik SMART Data & Self Test ... 

5. Pada bagian overall assessment seharusnya tertulis Disk is OK

6. Klik tombol start Self Test pada bagian kanan bawah kotak dialog

7. Pilih salah satu pilihan ( Short, Extended, Convenyance).

Ketika Diska Tidak Sehat
• Ketika keterangan pada Overall Assessment menunjukkan bahwa diska tidak sehat, maka

lebih baik  Anda menyiapkan cadangan/backup untuk mencegah kehilangan data.  Jika
status diska tertulis “Pre-fail”, berarti diska masih sehat tetapi ada kemungkinan akan
hampir rusak. Sehingga Anda perlu membuat cadangan/backup data-data penting dan
memeriksa diska secara berkala.

10.5.  Penyunting Teks 
Walaupun kelihatan sepele, aplikasi Teks Editor merupakan sesuatu  yang tidak dapat dipisahkan
dari penggunaan sehari-hari. BlankOn  menyediakan aplikasi teks editor bernama Gedit. Aplikasi
ini berada  di Menu Utama  BlankOn   Aplikasi   Aksesoris   Text Editor, atau  Anda juga bisa
dengan mengklik ikon Penyunting Teks pada menu  favorit blankon panel.  Aplikasi ini berada di
menu Aplikasi => Aksesoris => Text Editor. 
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Dengan menggunakan aplikasi ini kita dapat dengan mudah untuk membuat ataupun membaca
berkas teks yang diinginkan. Dengan kemampuan yang lebih tinggi, teks editor ini pun dapat
digunakan untuk menulis bahasa pemrograman karena penggunaan fitur penanda warna pada
sintaks kode yang membuat penulisan kode program menjadi lebih enak.

10.6. Sandi dan Kunci
Aplikasi Sandi dan Kunci dapat digunakan untuk membuat dan menyimpan tanda pengamanan
sehingga  dapat  membantu   dalam menjaga  informasi  dalam komputer  tetap  aman  bahkan
ketika Anda mengirim informasi melalui suatu jaringan.

Dengan menggunakan aplikasi Sandi dan Kunci, Anda dapat;

• Menyalin dan menyimpan sandi yang sulit diingat.

• Mengelompokkan sandi dan membuat ring kunci/keyring

• Membuat dan mengelola kunci PGP.

• Membuat dan mengelola kunci SSH.

Langkah-langkah Menjalankan Aplikasi Sandi dan Kunci

Klik Menu Utama  Blankon => Aksesoris => Sandi Dan Kunci

 Aplikasi Aksesoris



147

Maka segera tampil jendela yang berisi berbagai menu seperti pada gambar di abwah ini

10.6.1.  Kunci SSH
Sebuah kunci SSH akan membantu Anda untuk membuat koneksi antar komputer yang terjamin
aman.  Kunci SSH (Secure Shell) dapat membantu Anda dalam membuat koneksi yang aman
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melalui jaringan yang tidak aman. Membuat sebuah kunci SSH berarti membuat sepasang kunci;
Kunci Publik dan Kunci Pribadi.

Langkah-langkah membuat Kunci SSH Baru

• Klik ikon tanda + (tambah) atau klik menu Berkas => Baru, cara lainnya dapat dilakukan
dengan klik tombol Ctrl + N.

• Pilih salah satu kunci yang akan dibuat, dalam contoh; Kunci Secure Shell, kemudian klik
tombol Lanjutkan.

• Masukkan  keterangan  untuk  kunci.  Keterangan  ini  akan  membantu  Anda  untuk
mengenali  kunci  pada  lain  waktu.  Contoh,  Anda  dapat  menuliskan  tanggal,  sesuatu
tentang bagaimana kunci tersebut digunakan, atau nama server tempat Anda memasang
kunci  tersebut.  Bagian  keterangan  sebenarnya  bersifat  opsional  dan  cara  memberi
keterangan pada kunci-kunci, benar-benar terserah Anda. Contoh, kita tulis  Coba buat
Kunci.
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• Anda dapat mengubah pengaturan awal/default untuk jenis enkripsi atau kekuatan kunci
dengan membuka panel opsi kunci tingkat lanjut.

• Terdapat 3 (tiga) tombol yang dapat Anda pilih; Buat kunci, Batal, dan Buat dan Siapkan

• Jika sudah ada komputer lain yang ingin Anda akses menggunakan kunci ini, Anda dapat
memilih  tombol  Buat  dan  Siapkan. Jika  Anda  hanya  ingin  membuat  kunci  saja,  klik
tombol Hanya Buat kunci.

• Ketik kata sandi yang akan dibuat

• Ketik  ulang  kata  sandi   sesuai  dengan  kata
sandi yang diketik sebelumnya.

• Kunci SSH yang Anda buat akan muncul pada
daftar Kunci OpenSSH.
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10.6.2.  Konsep dan Istilah Kunci
Untuk  lebih  memahami  cara  kerja  aplikasi  Sandi  dan  Kunci,  Anda  perlu  terlebih  dahulu
memahami konsep dan istilah-istilah yang digunakan.

Glosarium
• Sandi  dan  Kunci  membantu  Anda  membuat  dan  mengelola  kode-kode  yang  dapat

digunakan  untuk  melindungi  berkas/file  dan  komunikasi  Anda.  Ada  beberapa  istilah
dasar yang sering digunakan dalam aplikasi Sandi dan Kunci.

Enkripsi
• Enkripsi adalah proses pembuatan berkas dan data yang tidak dapat dibaca tetapi akan

dibaca oleh penerima. Ketika Anda mengenkripsi data, data tersebut menjadi rangkaian
angka  dan  huruf  acak.  Enkripsi  biasa  dilakukan  ketika  pengiriman  berkas  yang
terlindungi/diprotek, atau pengiriman pesan pada percakapan yang terlindungi.

Algoritma
• Algoritma adalah serangkaian langkah-langkah untuk mengenkripsi dan mendekripsi.

Dekripsi
• Dekripsi  adalah  proses  mengambil  kembali  teks  asli  dari  pesan  atau  berkas  yang

terenkripsi.
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Plainteks
• Palinteks adalah data atau berkas yang tidak dienkripsi sehingga tidak dapat dibaca oleh

pengakses.

Kunci
• Kunci  digunakan untuk  mengenkripsi  dan  mendekripsi  berkas  dan komunikasi.  Kunci

juga mungkin digunakan untuk masuk/login ke komputer remot. Jenis-jenis kunci antara
lain PGP dan SSH.

Ring Kunci/Keyring
• Keyring adalah kumpulan sandi dan kunci.

10.6.3.  Mengenal Kunci Publik dan Kunci Pribadi
Kunci  Publik  dan  Kunci  Pribadi,  keduanya  mengacu  pada  istilah  kunci.  Kunci  publik  dapat
diibaratkan  seperti  sebuah  gembok,  sedangkan  Kunci  Pribadi  seperti  kunci  yang  dapat
membuka gembok.

10.6.3.1. Contoh: Pengiriman Pesan Rahasia di dalam Kotak
Mari kita gunakan sebuah contoh untuk melihat bagaimana kerja Kunci Publik dan Kunci Pribadi.
Misalkan Anda ingin agar  teman Anda mengirim pesan rahasia di  dalam kotak.  Anda dapat
memberi  teman Anda kotak dan gemboknya tetapi  kunci  untuk membuka gembok tersebut
hanya Anda yang memilki.

Teman  Anda  dapat  menyimpan  pesan  rahasia,  menguncinya  dengan  gembok,  kemudian
mengirimnya  melalui  pos/jasa  pengiriman.  Ketika  menerimanya,  Anda  dapat  menggunakan
kunci untuk membuka kotak tersebut.

Hal ini  mirip dengan cara kerja Kunci  Publik  dan Kunci  Pribadi.  Sama seperti gembok,  Anda
bebas  membagikan  Kunci  Publik  sehingga  siapa  saja  dapat  dengan  mudah  dan  aman
mengenkripsi atau mengunci pesan yang ingin dikirim kepada Anda.

Pada sisi  lain,  Kunci Pribadi  seperti kunci yang dapat Anda gunakan untuk mendekripsi atau
membuka  gembok.  Karena  Kunci  Pribadi  digunakan  untuk  mendekripsi  pesan,  maka  sudah
semestinya Anda ingin Kunci Pribadi tetap terjaga dengan aman.

10.6.3.2. Mengenal Kunci PGP
PGP merupakan kunci ekripsi publik. PGP dapat digunakan untuk menandai dan mengenkripsi
email/surat elektronik dan file/berkas. Ketika Anda membuat kunci PGP, berarti Anda membuat
sepasang kunci; Kunci Publik dan Kunci Pribadi. Anda dapat membagikan Kunci Publik kepada
siapa saja yang ingin mengirim pesan atau berkas yang terenkripsi kepada Anda. Akan tetapi
hanya Anda yang boleh mengetahui Kunci Pribadinya yang digunakan untuk mendekripsi pesan.
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10.6.3.3. Mengkripsi dan Menandai Data Menggunakan Kunci PGP
Aplikasi  Sandi  dan Kunci  merupakan aplikasi  pengelola kunci  sehinga tidak dapat  digunakan
untuk mengenkripsi atau menandai berkad atau pesan. Akan tetapi Anda dapat menggunakan
aplikasi Sandi dan Kunci untuk menandai kunci-kunci yang terpercaya.

Untuk mengamankan komunikasi, Anda dapat menggunakan email client seperti Evolution yang
menyediakan layanan enkripsi dan penandaan encryption and signing.

10.6.3.4. Mengenal Kunci SSH
Kunci SSH (Secure Shell) dapat membantu Anda dalam membuat koneksi yang aman melalui
jaringan yang tidak aman.

Kunci SSH berisi 2 bagian;
• Kunci Publik yang terbuka luas

• Kunci Pribadi yang dijaga secara rahasia. Kunci Pribadi ini digunakan untuk membuka
pesan yang terenkripsi dengan Kunci Publik.

Dengan Kunci SSH, untuk membuat koneksi antar komputer hanya membutuhkan Kunci Publik
yang  dikirim  melalui  jaringan.  Transmisi  yang  terenkripsi  dengan  Kunci  Publik  hanya  dapat
dibaca  dengan  membukan  kunciannya  dengan  Kunci  Pribadi  yang  cocok  dan  sebuah  sandi.
Hanya Kunci Publik yang dikirim melalu jaringan sehingga sandi dari kunci tersebut tetap terjaga
kerahasiannya.

10.6.3.5. Mengenal Kunci Fingerprint
Kunci  Fingerprint merupakan serangkaian huruf dan angka yang digunakan untuk mengenali
suatu kunci. Hampir sama dengan sidik jari dari dua orang yang berbeda, fingerprint dari dua
kunci  yang  berbeda  juga  tidak  akan  pernah  serupa.  Fingerprint  adalah  cara  terbaik  untuk
mengenali sebuah kunci partikular.

Sebuah kunci mempunyai beberapa properti seperti nama dan email/surel pemilik kunci, jenis
kunci,  dan  tanggal  kedaluarsa.  Jika  Anda  sedang  mencari  suatu  Kunci  Publik  dan  Anda
menemukan beberapa Kunci Publik dengan properti yang sama, maka satu-satunya cara untuk
mengenali  kunci  yang  Anda  cari  adalah  dengan  membandingkan  fingerprint  dari  dua  kunci
dengan fingerprint dari kunci yang Anda butuhkan.

Fingerprint dari suatu kuncilah yang diverifikasi ketika anda mencoba login ke komputer remot
menggunakan SSH. Saat menandai  Kunci PGP,  Anda harus selalu memeriksa fingerprint dari
kunci  tersebut  dan memverifikasi  identitas  pemilik  pemilik  sehingga menjamin bahwa Anda
menandaikunci yang benar, tidak keliru.

Fingerprint pada Sandi dan Kunci
Anda  dapat  melihat  fingerprint  dari  suatu  kunci  pada  aplikasi  Sandi  dan  Kunci  dengan
memeriksa properti dari kunci tersebut.
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Cara memeriksa fingerprint suatu kunci;

1. Pilih Kunci GnuPG dari panel sisi kiri

2. Pilih Kunci PGP dari daftar

3. Klik kanan kunci tersebut dan pilih Properti

4. Pada kotak dialog baru, pilih tab Detail

5. Anda dapat melihat fingerprint dari kunci tersebut pada sisi sebelah kiri.

10.6.3.6. Mengenal Keyring/Ring Kunci/Cincin Kunci
Dengan Keyring pada aplikasi Sandi dan Kunci Anda dapat menyimpan sandi-sandi dan kunci-
kunci pada kelompok-kelompok.

Ketika pertama kali  membuka aplikasi  Sandi  dan Kunci,  Anda akan melihat  kunci  dan sandi
berada dalam satu kelompok. Pada ring kunci Login, Anda mungkin menemukan sandi-sandi
yang tersimpan untuk aplikasi-aplikasi  GNOME seperti  Web,  Akun,  dan lain-lain.  Ring Kunci
Login merupakan Ring Kunci default/awal pada aplikasi Sandi dan Kunci.

Rujukan:
• Berkas Bantuan Passwords and Keys pada BlankOn Linux Tambora
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BAB 11 PENGENALAN ANTAR MUKA TEKS

ntarmuka  dasar  untuk  pengoperasian  sistem  operasi  Linux  sebenarnya  adalah
antarmuka berbasis  teks,  atau sering disebut Command Line.  Antarmuka grafis atau
desktop yang ada di dalam Linux sebenarnya hanyalah alat bantu untuk pengoperasian

bagi mereka yang sudah biasa bekerja dengan Graphical User Interface (GUI) yang terdapat di
beberapa sistem operasi modern. Ini mirip dengan piranti lunak Microsoft Windows sebelum
versi 95 yang hanya merupakan alat bantu pengoprasian berbasis grafis untuk DOS. 

A
Untuk  memberikan  suatu  perintah  pada  antarmuka  teks,  pengguna  harus  mengetik  nama
perintah yang akan dijalankan beserta opsi-opsi  atau  parameter  yang diperlukan,  kemudian
menekan  tombol  Enter  untuk  mengeksekusi  perintah  tersebut.  Berbeda  dengan  antarmuka
grafis, penggunaan mouse secara umum tidak diperlukan karena semua kontrol hanya dilakukan
melalui papan ketik. 

Tidak benar jika penggunaan antarmuka teks tidak bisa melakukan produktivitas. Anda masih
bisa  berproduktivitas  dengan  berbagai  aplikasi  berbasis  teks  yang  tersedia  dan  siap  Anda
gunakan.  Bahkan  untuk  para  administrator,  penggunaan  antarmuka  teks  sangat  disarankan
ketimbang  antarmuka  grafis  karena  memakan  sumberdaya  CPU  dan  RAM  yang  lebih  kecil,
sehingga tidak menganggu kinerja komputer pada saat melakukan suatu tugas administrasi. 

Pada bab ini, dijelaskan mengenai dasar pengoperasian antarmuka teks yang ada pada BlankOn
Linux.  Sasaran  pembaca tidak  hanya bagi  Anda yang pengguna lanjut,  melainkan juga  para
pemula/newbie yang ingin mempelajari Linux lebih lanjut. 

11.1. Membuka Antarmuka Teks 
Ada  dua  jenis  antarmuka  teks  yang  bisa  Anda  buka,  yaitu  Terminal dan  Virtual  Console.
Terminal merupakan  antarmuka  teks  yang  berjalan  di  dalam  desktop  dan  berupa  jendela
aplikasi, sedangkan Virtual Console merupakan antarmuka teks yang berjalan secara mandiri di
luar desktop. 

11.1.1.  Membuka Terminal Console 
Untuk  membuka  terminal,  terdapat  icon  di  bagian  bawah  dari  desktop,  atau  anda  dapat
melakukannya dari menu Aplikasi => Aksesoris => Root Terminal pada BlankOn, kemudian isikan
katakunci yang anda miliki. 
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Jendela terminal akan muncul di dalam desktop. 

11.1.2.  Terminal 
Jika Anda ingin membuka sesi kerja yang baru, Anda bisa membuat tab baru seperti layaknya
fitur tabbed browsing pada peramban web dengan mengklik menu File => Buka Tab, atau Anda
bisa tekan tombol Ctrl+Shift+T pada keyboard. 

Anda bisa mengkostumisasi penampilan terminal sesuai dengan keinginan Anda melalui jendela
pengaturan yang bisa Anda buka melalui menu Edit > Preferensi. Jika ingin membuat terminal
dalam mode layar penuh, Anda bisa klik menu Lihat > Layar Penuh atau Anda bisa tekan tombol
F11 pada keyboard. 

11.1.2.1. Membuka Virtual Console 
Linux telah menyediakan enam sesi antarmuka teks yang bisa Anda buka dengan cara menekan
tombol Ctrl+Alt+F1, Ctrl+Alt+F2 sampai Ctrl+Alt+F6.  Berbeda dengan menggunakan terminal,
Anda harus melakukan login terlebih dahulu sebelum bekerja dengan antarmuka teks. Ketik id
pengguna kemudian tekan enter lalu masukkan sandi (password tidak akan ditampilkan pada
layar) Anda dan tekan enter sekali lagi. Berbeda dengan terminal, Anda tidak bisa melakukan
kustomisasi  penampilan  agar  lebih  menarik.  Bekerja  disini  layaknya  bekerja  dengan  sistem
operasi DOS (Disk Operating Systems). 

Untuk kembali ke desktop, Anda bisa tekan tombol Ctrl+Alt+F7 sampai Ctrl+Alt+F12. Bergantung
dari  sesi  desktop yang digunakan (Secara  default  menggunakan Ctrl+Alt+F7  jika  Anda tidak
memanfaatkan fitur pindah pengguna untuk mengaktifkan lebih dari satu sesi desktop). 
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11.1.2.2. Pengenalan Antarmuka Teks 
Setelah Anda membuka terminal atau login di dalam virtual console, Anda akan diminta untuk
memasukkan  perintah  yang  ingin  Anda  jalankan.  Tempat  Anda  mengetik  berada  pada
kursor/penanda yang berkedip-kedip. Pada bagian kiri kursor tersebut, Anda akan melihat teks
seperti berikut :

• Teks tersebut memiliki berbagai informasi sebagai berikut : 

• Teks  tambora sebelum  tanda  at  (@)  merupakan  nama  id  login  pengguna  yang
menggunakan antarmuka teks, 

• Teks  blankon  setelah tanda at (@) merupakan nama komputer yang digunakan pada
saat bekerja, 

• Teks  ~ setelah tanda titik dua (:) menunjukan lokasi direktori tempat bekerja. Folder  ~
secara  umum  berada  pada  lokasi  home/user  yaitu  pada  contoh  diatas  adalah
home/tambora. 

• Tanda $ pada bagian akhir menunjukkan posisi bekerja pada tingkatan pengguna umum.
Apabila bekerja dalam mode administratif, maka tanda tersebut akan berubah menjadi
#. 

• Untuk  menjalankan  suatu  perintah,  dimulai  dengan  mengetikkan  baris  perintah  lalu
diikuti dengan menekan tombol  Enter (  ¿  ).  Sebagai  contoh,  untuk menampilkan isi
suatu folder/direktori, dimulai dengan mengetikkan ketik perintah ls lalu diikuti dengan
tombol Enter ( ¿ ). Hasil yang didapat akan tampak seperti berikut. 
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Untuk menjalankan perintah yang bersifat administratif, dapat dilakukan dengan menggunakan
perintah  sudo  sebelum perintah yang ingin dijalankan. Untuk menjalankan perintah tersebut
pengguna harus memiliki  wewenang berupa password  root.  Misalnya,  jika ingin menghapus
berkas  blankon.txt pada  folder  /Document  (Dalam  hal  ini,  Anda  tidak  memiliki  hak  untuk
mengelola folder /opt), Anda bisa ketik perintah “sudo rm blankon.txt”.

PERHATIAN: 
• Meskipun pengguna memiliki hak akses untuk menjalankan bersifat administratif (yaitu

root),  secara  default  pengguna  tidak  dapat  menggunakan  hak  akses  tersebut  untuk
login. Anda bisa login ke root dengan cara mengetik perintah sudo su -.

• Dengan  perintah  tersebut  tanda  $  untuk  suatu  user  akan  berganti  dengan  tanda  #
sebagai penanda pengguna hak akses root
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11.1.2.3. Perintah-perintah dalam Antarmuka Teks 
Berikut  adalah berbagai  penjelasan  dari  perintah-perintah dalam pengelolaan berkas  secara
sederhana menggunakan antarmuka teks. 

11.1.2.4. Berpindah Folder/Direktori (cd) 
Perintah  cd  (change  directory)  dapat  dipergunakan  untuk  berpindah  dari  satu  direktori  ke
direktori lainnya.  Secara umum perintah yang digunakan adalah  cd lalu diikuti dengan nama
direktori  yang  akan  dibuka.  Sebagai  contoh,  apabila  hendak  berpindah  menuju  direktori
Document  pada folder  home, gunakan perintah  cd Documents/. Namun apabila sedang tidak
berada di direktori home dapat mengunakan perintah cd ~/Documents/. 

Apabila akan berpindah ke direktori  satu tingkat diatas direktori  saat ini  dapat mengunakan
perintah cd ..
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11.1.2.5. Melihat Isi Folder/Direktori (ls) 
Untuk melihat isi dari suatu direktori yang aktif, gunakan perintah ls (list).

Perintah ls  juga dapat digunakan untuk menampilkan lokasi  folder tertentu.  Sebagai  contoh
untuk menampilkan isi direktori usr pada hirarki tertinggi, gunakan perintah ls /usr. 

Untuk  menampilkan  informasi  lebih  detail  mengenai  suatu  direktori,  dapat  ditambahkan
perintah  tambahan  -l,  sehingga  perintah  lengkap  untuk  menampilkan  keterangan  dari
direktori /usr adalah ls -l /usr.
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11.1.2.6. Membuka Berkas 
Selain  menggunakan  Menu  untuk  membuka suatu  berkas  dengan aplikasi  tertentu,  dengan
menjalankan  perintah  di  terminal  juga  dapaat  membuka  berkas  tersebut.   Sebagai  contoh
apabila hendak membuka berkas dokumentasi_tambora.odt dengan aplikasi LibreOffice, dapat
menggunakan perintah soffice dokumentasi_tambora.odt.

CATATAN:
• Apabila  hendak  menjalankan aplikasi  berbasis  grafis,  maka diharuskan menggunakan

antarmuka teks  yang berada di  pada mode grafis  alias  terminal  emulator.  Jika tidak,
maka akan muncul pesan kesalahan. 

• Pada saat aplikasi sedang dijalankan, Jangan menutup atau mengakhiri sesi antarmuka
teks,  karena  akan  menyebabkan  aplikasi  yang  dibuka  tertutup  secara  paksa  dan
menyebabkan kehilangan berkas. 
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11.1.2.7. Membuat Direktori (mkdir) 
Untuk membuat direktori, Anda bisa menggunakan perintah  mkdir (make directories)  dengan
format  mkdir <nama_direktori>.  Sebagai  contoh akan dibuat sebuah direktori  dengan nama
latihan. Maka perintah yang digunakan adalah mkdir latihan.

11.1.2.8. Menghapus Direktori (rmdir) 
Untuk menghapus suatu direktori,  digunakan perintah  rmdir  <nama_direktori>.  Syarat  yang
harus dipenuhi untuk menghapus suatu direktori adalah direktori tersebut harus kosong tidak
berisi direktori maupun berkas.

11.1.2.9. Membuat berkas baru (cat)
Perintah  cat  (concatenate) berfungsi  untuk  menampilkan isi  suatu berkas  dilayar.  Selain  itu
perintah  cat  dapat  digunakan  untuk  membuat  berkas  baru  berbasis  teks.  Untuk  membuat
berkas  baru  digunakan  perintah  cat  >  <nama_berkas>  sebagai  contoh  cat  >  blankon.txt.
Sedangkan  untuk  menampilkan  isi  dari  berkas  tersebut  dapat  digunakan  perintah  cat
blankon.txt.
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11.1.2.10. Menghapus Berkas (rm) 
Untuk menghapus suatu berkas, gunakan perintah rm (remove files or directories)  lalu diikuti
dengan nama berkas atau dilengkapi dengan path (alamat lengkapnya) jika diperlukan. 

Peringatan:
• Setelah  Anda  menjalankan  perintah  ini,  berkas  akan  dihilangkan  begitu  saja  tanpa

konfirmasi. Jadi, hati-hati dalam menggunakannya.

Jika ingin menghapus suatu isi  folder sampai  isinya secara rekursif,  Anda juga bisa gunakan
perintah ini dengan menambahkan opsi “-R”. Sekali lagi, hati-hati dalam menggunakan perintah
ini.
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11.1.2.11. Menggandakan Berkas (cp) 
Untuk  menggandakan  berkas,  dapat  menggunakan  perintah  cp  (copy)  dengan  format  cp
<berkas-sumber>  <nama-berkas-baru>”.  Apabila  diperlukan  dapat  ditambahkan  lokasi  dari
<berkas  -sumber> dan  lokasi  <nama-berkas-baru>.  Contoh  yang  diberikan  apabila  ingin
menggandakan  berkas  blankon.txt  ke  berkas  blankon_jadi_dua.txt  dengan  perintah  cp
blankon.txt blankon_jadi_dua.txt.  

Sama dengan perintah  rm, Anda bisa manfaatkan opsi  -R apabila ingin menggandakan suatu
folder  secara  rekursif.  Dalam  contoh  ditampilkan  user  menggandakan  semua  berkas  dalam
direktori blankon ke direktori baru bernama tambora
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11.1.2.12. Memindahkan Berkas/Folder (mv) 
Ada kalanya pengguna perlu untuk memindahkan suatu berkas atau direktori. Untuk melakukan
hal tersebut dapat menggunakan perintah mv (move).  Format penulisan hampir sama dengan
perintah cp memindahkan berkas/folder. Pada contoh ditunjukkan pengguna memindah berkas
blankon_rote.txt  pada direktori  blankon  menuju ke direktori  tambora dengan nama berkas
yang sama

11.1.2.13. Mengubah Nama Berkas/Folder (mv) 
Selain untuk memindahkan suatu berkas atau direktori.  Perintah mv dapat digunakan untuk
mengubah  nama  berkas  atau  direktori.  Cara  penggunaan  sama dengan  cara  memindahkan
berkas  atau  direktori.  Contoh:  apabila  ingin  mengubah  nama  blankon_jadi_dua.txt  menjadi
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blankon_tambora.txt,  maka  penulisan  baris  perintah  yaitu  mv  blankon_jadi_dua.txt
blankon_tambora.txt.

11.1.2.14. Mengubah Hak Akses Berkas/Folder (chmod) 
chmod  (change  file  mode  bits) digunakan  untuk  mengubah  hak  akses  berkas/direktori.
Penggunaan perintah ini mengikuti format  chmod <***> <nama_berkas>. <***> Merupakan
hak akses yang terdiri dari tiga angka oktal (angka 0 hingga angka 7). Angka ke-1 merupakan hak
untuk pemilik, angka ke-2 merupakan hak untuk grup dan angka ke-3 merupakan hak untuk
selain pemilik dan grup. Masing-masing bagian diisi  dengan angka basis 8, dimana hak baca
bernilai 4, hak tulis bernilai 2, hak eksekusi bernilai 1. 

Sebagai  contoh,  untuk  mengubah berkas  blankon_tambora.txt  agar  mendapat  hak baca (4)
,tulis (2)   dan eksekusi  (1)  untuk pemilik (total  7),  sedangkan yang untuk grup serta lainnya
hanya  memiliki  hak  baca(2)  dan  eksekusi(1)  ,  perintah  yang  digunakan  adalah  chmod  755
blankon_tambora.txt.

Untuk memberikan suatu hak akses secara rekursif pada suatu folder, Anda bisa menambahkan
opsi  “-R”.  Misalnya,  jika ingin memberikan hak mutlak (hak  baca,tulis,eksekusi  untuk semua
aspek) pada direktori tambora, Anda bisa ketik perintah chmod 777 -R tambora/. 
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Untuk  menampilkan  hak  akses  suatu  berkas/folder,  Anda  bisa  manfaatkan  perintah  “ls  -l”.
Kemudian, Anda akan melihat seperti karakter yang dicetak tebal yang merupakan hak akses
dari berkas tersebut. Keenam karakter itu dibagi menjadi tiga, bagian pertama merupakan hak
akses pemilik,  bagian kedua  merupakan hak akses grup dan  bagian terakhir  merupakan hak
akses selain pemilik dan grup.

Keterangan:
• r : Hak Baca, w : Hak tulis, x : Hak eksekusi 

11.1.2.15. Mengubah ID Pemilik atau Grup pada Berkas/Folder (chown) 
Untuk mengubah id pemilik atau grup pada berkas/folder, gunakan perintah chown (change file
owner and group) dengan format chown <id-pengguna>:<id-grup> <nama_berkas> . 

Sebagai  contoh,  apabila  ingin  mengubah  kepemilikan  pengguna  dan  grup  dari  berkas
blankon_tambora.txt  menjadi  kepemilikan  www-data  baik  pengguna  maupun  grup,  maka
perintah yang digunakan adalah sudo chown www-data:www-data blankon_tambora.txt.
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Catatan : 
• www-data adalah standar hak akses untuk berkas web publik yang sering digunakan

oleh web server.

11.1.2.16. Membuat Berkas Tar (tar) 
Tar  (tape or  disc  archive)  merupakan program yang berfungsi  untuk  menyatakan beberapa
berkas atau direktori   ke dalam satu berkas yang disebut dengan  tarfile/tarball.  Perintah ini
sangat berguna untuk melakukan backup. 

Untuk membuat berkas tar, selain melalui aplikasi pengelola arsip pada desktop, Anda juga bisa
gunakan perintah tar dengan format “tar -f <nama_berkas.tar> <nama_berkas_1/direktori_1>
<nama_berkas_2/direktori_2>  ......  Format  yang  sering  digunakan  adalah  perintah  tar  -czf
<nama_berkas.tar.gz> <nama_berkas> 

Sedangkan untuk membongkar kembali dan melakukan dekompresi, dapat digunakan perintah
dengan format tar zxf <nama_berkas.tar.gz> -C <direktori tujuan>. 

11.1.2.17. Pencarian Berkas (find) 
Untuk  mencari  berkas,  gunakan  perintah  find  dengan  format  find  <direktori>  -name
<nama_berkas>. Sebagai contoh, apabila diinginkan untuk melakukan pencarian berkas dengan
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nama  blankon,  maka dapat dilakukan dengan perintah  find ~ -name blankon.  Ingat tanda ~
menunjukkan posisi berkas berada di home.

Pencarian juga dapat dilakukan apabila mengetahui ekstensi dari berkas yang diinginkan, misal
ekstensi txt untuk berkas file teks. Maka perintah yang dapat dilakukan adalah find ~ -name *txt

Catatan:
• Jika  ingin  menuliskan  nama  berkas/direktori  lebih  cepat,  dapat  dilakukan  dengan

mengetik  satu/beberapa  huruf  awal  dari  nama  berkas/direktori  tersebut,  kemudian
diikuti dengan tombol Tab pada papan ketik. Sebagai contoh, jika ingin mengetik nama
berkas “blankon.txt” lebih cepat,  pengguna dapat  mengetik huruf “b” saja atau “bl”,
kemudian  diikuti  dengan  menekan  tombol  Tab.  Secara  otomatis,  nama  berkas  akan
dilengkapi (auto complete). 

Sebenarnya, masih banyak lagi perintah-perintah untuk antarmuka teks yang bisa Anda gunakan
untuk  bekerja.  Untuk  melakukan  otomatisasi  kerja,  pengguna  juga  dapat  membuat  sebuah
berkas yang berisi baris perintah dengan hak akses eksekusi. Berkas tersebut dinamakan dengan
shell script. Otomatisasi pekerjaan sangat penting bagi administrator untuk memperingan dan
mempercepat pekerjaannya dalam jaringan. Untuk mempelajari shell script lebih lanjut, dapat
membaca buku tentang Bash Scripting atau mencari referensi melalui internet.
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BAB 12 PENGATURAN PERANGKAT KERAS

engaturan perangkat keras yang terpasang di komputer menggunakan BlankOn sangat
mudah sekali. Anda hampir tidak perlu melakukan pemasangan driver perangkat keras,
karena BlankOn sudah menyediakan hampir semua driver perangkat keras esensial yang

ada saat ini. Sehingga, setelah pemasangan BlankOn, hampir semua perangkat keras esensial
seperti kartu video, kartu suara, dsb bisa berjalan dengan baik. 

P
Namun  untuk  memantapkan  perangkat  keras  tersebut,  Anda  perlu  mengetahui  bagaimana
melakukan  pengaturan  perangkat  keras  yang  ada.  Semua  hal  menyangkut  perangkat  keras
dibahas dalam bab ini. 

Walaupun hampir semua perangkat keras esensial mampu digunakan di BlankOn dengan baik
dan  out-of-the-box  (tanpa  perlu  pengaturan  mendetail),  sampai  saat  ini  masalah  driver
perangkat  keras  masih  merupakan  masalah  dominan  dan  mengganggu  dunia  Linux.  Tidak
semua  produsen  perangkat  keras  merilis  driver-nya  untuk  platform  Linux.  Walaupun  ada
beberapa, itupun tidak Open Source dan masih dikembangkan secara tertutup. Hampir semua
driver yang saat ini ada di Linux merupakan hasil jerih payah para komunitas tanpa bantuan dari
produsen  perangkat  keras.  Namun,  hal  ini  akan  menjadi  masalah  waktu  saja.  Beberapa
produsen perangkat keras mulai maju untuk mengembangkan driver-nya untuk Linux mengingat
Linux semakin populer saat ini sebagai sistem operasi untuk Desktop. 

12.1. Konfigurasi Monitor
Konfigurasi monitor di BlankOn sudah diatur sedemikian rupa, sehingga resolusi layar monitor
sesuai dengan kemampuan monitor yang Anda miliki.  Namun jika Anda ingin mengatur resolusi
monitor agar lebih optimal, atau memanfaatkan beberapa monitor yang terpasang di komputer,
Anda bisa melakukannya dengan fitur pengaturan Monitor dengan langkah sebagai berikut, 

Klik Menu Utama  BlankOn => Preferensi => Perangkat Keras => Tampilan, jendela pengaturan
yang tampil,  klik gambar layar, maka segera tampil jendela baru dengan beberapa menu, yaitu:
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• Ukuran: menunjukkan ukuran layar pada komputer/laptop yang sedang digunakan.

• Rasio Aspek: menunjukkan perbadingan pajang dan lebar dari layar yang digunakan

• Resolusi: menunjukkan resolusi pada layar yang sedang digunakan

12.1.1.  Mengatur Resolusi
Untuk mengatur resolusi lakukan langkah berikut;

• Klik tanda segitiga kecil pada kotak resolusi, pilih resolusi yang diinginkan, kemudian klik
tombol  Terapkan,  maka  segera  muncul  jendela  konfirmasi  untuk  menerapkan
perubahan, klik tombol Keep This Configuration untuk menerpakan perubahan resolusi
pada layar.

Catatan:
• Anda juga  dapat  menentukan ukuran  Refresh Rate yang otomatis  muncul  di  bawah

menu Resolusi ketika mengubah ukuran resolusi menjadi paling kecil (misal: 800 x 600)

12.2. Konfigurasi Mesin Pencetak
Manajemen mesin pencetak atau printer yang ada di BlankOn diatur oleh sebuah perangkat
lunak server bernama CUPS (Common Unix Printing System). CUPS bertanggung jawab untuk
menerima  permintaan  pencetakan  baik  dari  lokal  maupun  dari  jaringan,  melakukan  job
pencetakan dan mengirim informasi ke printer untuk melakukan pencetakan. 

Secara default, driver mesin pencetak akan langsung terpasang di BlankOn jika mesin pencetak
tersebut sudah tersedia di sistem pada saat printer pertama kalinya dipasang ke komputer. Anda
akan  melihat  pesan  notifikasi  bahwa  printer  baru  telah  ditambahkan.  Namun,  jika  mesin
pencetak Anda tidak terdeteksi sama sekali atau printer terbagi di jaringan, Anda bisa membuka
alat konfigurasi mesin pencetak yang Anda bisa buka melalui Menu Utama  BlankOn => Menu
Utama  BlankOn => Administrasi => Print Setting. 
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12.2.1.  Menambahkan Pencetak
Berikut  adalah  langkah-langkah  penambahan  mesin  pencetak  melalui  menu  pengaturan
printer : 

Klik tombol Add atau  tombol + (tambah),  Maka segera tampil  jendela untuk menambahkan
printer  disertai  dengan  konfirmasi  untuk  memasukkan  sandi,  ketik  sandi  Administrator
komputer Anda, kemudian klik tombol Authenticate.

Langkah  selanjutnya  adalah  memilih  jenis  printer  yang  tersabung  ke  komputer,  apakah
menggunakan  Port  USB,  LPT,  nirkabel,  atau  melalui  Jaringan, klik  Forward untuk
menambahkan printer sesungguhnya.

Sesaat setelah Anda menekan tombol Forward, maka muncul jendela Deskripsi Pencetak yang
akan Anda tambahkan disertai  jendela konfirmasi  bahwa penggerak (driver) untuk pencetak
yang akan Anda tambahkan sudah sesuai,  jika sudah sesuai  klik  tombol  Cancel,  namun jika
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belum sesuai klik tombol  Find in Software atau OK untuk mencari penggerak secara langsung
lewat Internet.

Klik tombol  Apply pada jendela  Deskripsi Pencetak untuk melanjutkan ke proses berikutnya,
ketika  tampil  jendela  konfirmasi  untuk  memasukkan  sandi,  ketik  sandi  Administrator  Anda,
kemudian tekan tombol  Authenticate.

Sekarang Pencetak sudah berhasil ditambahkan, jika muncul jendela konfirmasi Cetak halaman
uji?, Anda dapat langsung menguji pencetak yang terhubung dengan komputer Anda degnan
klik tombol Cetak Halaman Uji. 
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Catatan:
• Selain cara di atas Anda juga dapat menambahkan Pencentak dengan cara klik  Menu

Utama  BlankOn => Preferensi => Pengaturan => Perangkat Keras => Pencetak

12.2.2.  Pengaturan Mesin Cetak 
Untuk melakukan pengaturan mesin cetak agar  hasilnya sesuai  dengan keinginan Anda,  klik
Menu Utama  BlankOn => Administrasi => Print Setting, klik kanan mesin cetak yang terpasang
pilih  Properti,  maka akan segera muncul beberapa menu untuk melakukan pengaturan pada
mesin cetak yang terpasang.

Lakukan  pengaturan  sesuai  keinginan  Anda,  sebagai  contoh  untuk  melakukan  pengaturan
kualitas warna klik Opsi Pencetak => Print Quality, pilih sesuai hasil warna dan kualitas hasil
pencetak yang di kehendaki, setelah sesuai dengan keinginan, klik tombol Terapkan (Apply) =>
Oke, baru lakukan pencetakan. 
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12.3.  Warna
Manjemen  warna  adalah  suatu  proses  pengambilan  warna  menggunakan  perangkat  input,
kemudian  ditampilkan  pada  layar  yang  terhubung  dengan  mesin  cetak  (printer),  tujuannya
adalah mengelola warna agar hasilnya ketika dicetak pada berbagai media akan tetap baik.

Di  bawah  ini  adalah  contoh  penerapan  manajemen  warna  dengan  menggunakan  gambar
burung pada hari yang dingin ketika musim salju.

Ketika  gambar  burung  tersebut  dibuka  secara  langsung  dengan  penampil  gambar  pada
komputer, maka tampilannya terlihat lebih biru dan sedikit redup.
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Dan  ketika  dicetak  secara  langsung  tanpa  manajemen  warna  hasilnya  tidak  sesuai,  coba
perhatikan dengan teliti gambar di bawah ini, bagian warna putih tidak bisa sempurna atau
tidak benar-benar putih, selain itu warna hitam pada mata terlihat coklat tua.

Printer standar kantoran  tidak mempunyai tinta warna putih,  sehingga kualitas warna putih
pada  gambar  hasil  cetak  kurang  baik,  atau  dengan  kata  lain  warna  putihnya  sesuai  warna
kertas. Dengan Pengaturan Warna kita dapat mengatur profil warna untuk layar dan pencetak
sehingga warna yang dihasilkan sesuai dengan yang direncanakan.

12.3.1.  Mengatur Warna
Berikut ini adalah langkah-langkah untuk mengatur Warna;

Klik  Menu Utama  BlankOn => Preferensi  => Pengaturan,  atau bisa juga dengan klik  Menu
Utama  BlankOn => Pengaturan,  pada jendela yang tampil  pilih kelompok Perangakt  Keras,
kemudian klik Warna sehingga muncul panel Pengaturan Warna

Maka  segera  muncul  jendela  untuk  mengatur  warna,  jendela  tersebut  berisi  beberapa
keterangan perangkat keras yang sedang digunakan maupun mesin pencentak (printer) yang
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terhubung  dengan  komputer/laptop,  misalnya  Jenis  Layar  Laptop  dan  seri  printer  yang
terhubung dengan Laptop. 

Catatan
• Kita dapat membaca keterangan lebih detail tentang pengaturan warna pada  Bantuan

GNOME yang dapat diakses dengan mengeklik tulisan Pelajari lebih jauh.

12.3.1.1. Menambah Profil Warna
Profil  warna  adalah  kumpulan  data  yang  mencirikan  suatu  perangkat  atau  ruang  warna.
Sebagian besar profil warna berupa berkas kecil dengan ekstensi  .ICC atau  .ICM. Profil warna
berfungsi  untuk  memastikan  bahwa  pengguna  melihat  warna  yang  sama  pada  perangkat
berbeda. Berikut ini langkah-langkah menambah profil warna;

Pada panel Pengaturan Warna, pilih perangkat yang akan diatur (Layar Laptop atau Pencetak)

Pada gambar di atas, terlihat Layar Laptop menggunakan profil warna Otomatis-Inspiron 1420
(bawaan laptop).
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Untuk menambahkan profil warna, klik tombol Add profile di bagian bawah-kanan panel, maka
segera muncul jendela  Tambah Profil.  Pilih profil  warna (misalnya Best RGB)  pada jendela
Tambah Profil. Klik tombol Tambah, jika ingin menggunakan berkas profil warna di luar daftar
yang tersedia, kita dapat mengeklik tombol Import File...

12.3.2.  Ganti Profil Warna
1. Pada jendela Pengaturan Warna, pilih perangkat yang akan diatur (Layar Laptop atau

Pencetak) sehingga muncul daftar profil yang sudah ditambahkan.

2. Pilih profi warna yang ingin dipakai,  klik tombol Enable pada pojok kiri-bawah jendela

12.3.3.  Hapus Profil Warna
1. Pada jendela  Pengaturan Warna,  pilih perangkat yang akan diatur (Layar Laptop atau

Pencetak) sehingga muncul daftar profil yang sudah ditambahkan.

2. Pilih profi warna yang ingin dihapus, kemudian klik tombol  Remove Profile pada pojok
kanan-bawah jendela.
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12.4. Penganalisa Penggunaan Disk 
Untuk menganalisa penggunaan disk dalam komputer, Anda bisa menggunakan bantuan aplikasi
Penganalisa Penggunaan Disk. Aplikasi ini berbasis grafis untuk menganalisa penggunaan disk
pada lingkungan GNOME,  aplikasi  ini  akan dengan mudah memindai  semua struktur pohon
filesistem, atau direktori khusus sesuai dengan pilihan Anda. Aplikasi ini bisa diakses melalui
Menu Utama  BlankOn => Perkakas Sistem => Penganalisa Penggunaan Disk. 
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BAB 13  KEMANA SELANJUTNYA? 

13.1. Umpan Balik 
Tim Pengembang BlankOn menerima kritik dan saran serta masukan yang membangun untuk
kesuksesan  BlankOn.  Jika  Anda  memiliki  masalah  dalam  penggunaan  BlankOn,  Anda  dapat
melaporkannya melalui beragam cara, baik melalui surel maupun melalui diskusi di Internet .

Berikut adalah berbagai tautan/link situs untuk informasi lebih lanjut mengenai BlankOn: 

• http://www.blankonlinux.or.id, situs resmi BlankOn Linux 

• http://forum.blankonlinux.or.id,  situs  forum  untuk  berdiskusi  tentang  penggunaan
BlankOn 

• http://serambi.blankonlinux.or.id,  situs  blog  tempat  para  pengembang  BlankOn
mengungkapkan isi hati 

• http://cdimage.blankonlinux.or.id, halaman web untuk mengunduh BlankOn

• http://dev.blankonlinux.or.id, situs WIKI untuk informasi pengembangan BlankOn

• http://webchat.freenode.net, situs untuk berbincang dengan pengembang BlankOn, isi
nama Anda dan ketik ”#blankon” pada kolom Channels. 

13.2. Pengembangan BlankOn Linux 
Seperti  yang  dijelaskan  sebelumnya,  BlankOn  Linux  dikembangkan  oleh  Yayasan  Penggerak
Linux Indonesia (YPLI) bersama para komunitas pengembang Linux yang tergabung menjadi Tim
Pengembang BlankOn Linux. Proyek BlankOn Linux terbuka untuk siapa saja yang terlibat dan
berperan aktif dalam pengembangan BlankOn Linux ini.

Setelah menggunakan BlankOn, tentu Anda akan merasakan kekurangannya di sana-sini. Anda
memiliki suara dan kesempatan untuk berkontribusi mengatasi segala kekurangan yang perlu
diperbaiki BlankOn pada rilis berikutnya. 

Caranya mudah, cukup kunjungi halaman: 

http://dev.blankonlinux.or.id/wiki/Memulai   Jika  Anda  berminat  untuk  menjadi  pengemban
BlankOn  Linux,  silahkan  membuat  akun  baru  di  situs  pengembangan  BlankOn  Linux  yaitu
http://dev.blankonlinux.or.id dan bergabung di  milis  pengembang BlankOn Linux di  blankon-
dev@googlegroups.com. Anda bisa memilih menjandi salah satu dari tim yang disebutkan di
atas. Kontribusi dari Anda  sangat diperlukan agar BlankOn Linux bisa menjadi lebih baik. 

Tidak perlu menjadi seorang yang ahli  pemrograman untuk dapat  berkontribusi di BlankOn.
Beragam kalangan dari  beragam latar  belakang keahlian dibutuhkan di  proyek BlankOn. Ada
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beragam bidang yang masih harus  dikerjakan di  BlankOn, mulai  dari  karya-karya seni   yang
masuk di BlankOn hingga strategi dan implementasi pemasaran  BlankOn di masyarakat. 

Tim Pengembang BlankOn percaya bahwa masih banyak masyarakat  Indonesia yang memiliki
keinginan untuk dapat menjadi bangsa yang  berdikari, mampu berdiri di atas kaki sendiri, tanpa
harus membajak  hasil karya orang lain. Tim Pengembang BlankOn percaya bahwa Anda adalah
salah satu di antaranya. 

13.3. Tim Pengembang BlankOn X Tambora

Menejer Proyek
• Mohammad Anwari (MDAMT)     

Menejer Rilis 
• Ahmad Haris

Tim Pemaket 
• Mahyuddin (Koordinator)
• Rahman Yusri Aftian (MahaDEV)
• Azis W Katamsi (Bayan Desa)
• Anto Samalona
• Muhammad Miftakhul Syaikhuddin

Tim Riset dan Aplikasi
• Herpiko Dwi Aguno (Koordinator)
• Cahaya Maulidan
• Aris Winardi

• Hikmah Gumelar
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Tim Infrastruktur. 
• Syah Dwi Prihatmoko (Koordinator)
• Budi Wijaya
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• Rahman Yusri Aftian
• M. Nasrul Alawy
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BAB 14 KAMUS ISTILAH BAHASA KOMPUTER

abort gugurkan

access akses

account akun

action button tombol aksi

action setting penataan aksi

add-ons pengaya

address alamat

algorithm algoritma

align left rata kiri

align right rata kanan

alignment perataan

alternate silih

animation animasi

anonymous anonim

append bubuh

application aplikasi

apply terapkan

arrange susun

array larik

ascending menanjak,urut naik
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attribute atribut

autoformat otoformat

back slash garis miring kiri

back up cadangan

back balik

background latar belakang

backtracking lacak balik

bandwidth lebar pita

bar batang,bilah

base basis,pangkalan

batch tumpak

binary biner

block cekal,blokir

blur kabur

bold tebal

bookmark markah,penanda

braces kurung kurawal

browse ramban

browser peramban

bug kutu

bullet bulet
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button tombol

byte bita

cache tembolok,singgahan

cancel batal

capacity kapasitas

capslock kacing kapital

caption takarir

cartridge katrid,selongsong

cascade riam

cell sel

channel kanal

chart bagan

chatting rumpi

chip cip

click klik

client klien

clone klon

cluster gugus,rumpun

coding pengodean

collapse ciutkan

commit komit,komitmen,melakukan

compile kompil
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cookie kuki

copyleft hak tiru

copyright hak cipta

count cacah

crack rengkah

cracker perengah

crash mogok

crop pangkas

cursor kursor

daemon jurik

database basis data

datasheet lembar data

debug awakutu

debugging pengawakutuan

decoding pengawasandian

decrease kurang,susut

default asali,baku,bawaan

delete hapus

dependency dependensi,ketergantungan

descending menurun,urut turun

device peranti

directory direktori
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disc cakram,diska

disclaimer penafian

domain ranah

download unduh

draft konsep

drag seret

drive kandar

driver pamacu

drop lepaskan

dropdown pilihan menurun

edit sunting

email surel (surat elektronik)

embed semat

encryption enkripsi

error galat

ethernet eternet

expand bentangkan

extension ekstensi

fetch jemput,ambil

field bidang,isian

file berkas

filter penyaring
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find temukan

firmware peranti tegar

folder pelipat

font huruf,fonta

gadget gawai

gateway gerbang

gigabyte gigabita

hack retas

hacker peretas

hang macet

harddisk cakram keras,diska keras

hastag tagar (tanda pagar)

header tajuk

heading penajukan

highlight sorot

history riwayat

home beranda

hotspot area bersinyal

hyperlink hipertaut

image citra

import impor

inbox kotak masuk
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input masukan

insert sisip,sisipan

install pasang,instal

installer pemasang

installing pemasangan

interface antarmuka

istilah asing arti

italic italik,miring

keyboard papan ketik

keypad bantalan tombol

keyword kata kunci

kilobyte kilobita

lanscape lanskap

laptop komputer jinjing

launch luncur

link tautan

list senarai

load muat

loading memuat

lock kancing

macro makro

mailing list daftar surel
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maximized dimaksimalkan

megabyte megabita

menubar bilah menu

merge gabung

minimized diminimalkan

mount kait

mouse tetikus

network jaringan

networking jejaring

numlock kancing angka

offline luring (luar jaringan)

online daring (dalam jaringan)

option opsi

parentheses kurung lengkung

password sandi,kata sandi

paste tempel

path jalan

path jalur

pause jeda

penetration penetrasi,penerobosan

permission hak akses

picture gambar
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popup sembulan

port pangkalan

post kirim

posting kiriman

potrait potret

power daya

preference preferensi

preview pratinjau,pratayang,pratampil

printer pencetak

privacy privasi

prompt siap ketik

prototype purwarupa,prototipe

proxy proksi,pewali

pull tarik

push dorong

query kueri

record utas,rekam

redo ulangi

refresh segarkan

reload muat ulang

repeat ulang

replace ganti
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replay memainkan kembali

repository lumbung

request permintaan

reset tata ulang

response balasan

restart mulai ulang

restore mengembalikan

restored dikembalikan

review ulasan

save as simpan sebagai

save simpan

scan pindai

scanner pemindai

scroll menggulung

search cari

selfie swafoto

server peladen

setting setelan,pengaturan

setup setel

setup siapkan

sharing berbagi

shift alih
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site situs

slash garis miring

slide salindia

software perangkat lunak

sound card kartu suara

split belah

square brackets kurung siku

state keadaan

submit kirim

subscriber penika bawah

swipe gesek

sync sinkron

synchronize menyelaraskan

tap ketuk

taskbar batang tugas

template templat

terms & condition syarat dan ketentuan

thread utas,ulir

timeline kronologi,linimasa

tool perkakas,alat

toolbar bilah alat

touch sentuh
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trace runut

transliteration transliterasi,alih aksara

undo urungkan

uninstal hapus pemasangan 

unmount putus kait

update perbarui

updater pembaru

upgrade tingkatkan

upload unggah

user pengguna

username nama pengguna

view tampilkan

vulnerable rentan

web jaringan

website laman

window jendela

wizard penuntut

zoom perbesar
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